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getting started
Before we dive right into the world of recording, here are some helpful tips about getting your Line 6 
gear setup, as well as links to other related resources for you...

Installing Line 6 Audio Drivers and GearBox Software

To use your Line 6 TonePort®, GuitarPort®, POD® X3 or POD®xt with your computer, you’ll need to 
install the Line 6 USB audio driver for your device. A “driver” is a software component that installs on 
a Mac® or Windows® computer that allows a hardware device to work with the computer’s operating 
system. For TonePort, GuitarPort or PODxt, just pop in the GearBox® software CD that came with 
your Line 6 device and you can simply install GearBox and it will automatically install the Line 6 
drivers for you. For POD X3 (as well as for any Line 6 device), you can go to the Line 6 web site and 
download the GearBox installer, or just the driver installer for your specific hardware:

www.line6.com/software/

Since this document covers GearBox version 3.5, you’ll of course want to be sure you’ve updated to 
this version of GearBox (or a later version, if available) - no worries, it’s a free update! You can grab the 
GearBox installer from the Line 6 site link above, or, if you already have Line 6 Monkey installed you 
can launch it with your Line 6 USB hardware connected and it will sniff out your current version and 
offer to walk you through an update if needed (see the following Line 6 Monkey section).

 

POD X3 owners... GearBox 3.5 does not yet include support for POD X3 devices. But you can download 
the Line 6 USB audio driver for your Mac or Windows PC - please visit the GearBox Online Help site 
for the latest news and developments for GearBox and driver support.

GuitarPort owners... You’ll need to use Line 6 Monkey to update the USB Firmware of your GuitarPort 
device to version 2.07 (or later) to allow full compatibility with GearBox 3.5.  You’ll benefit from several 
new models and additional GearBox features too! See the following Line 6 Monkey section for more about 
running Monkey to check for updates.

About GearBox

Line 6 GearBox is the free Mac and Windows software companion or all Line 6 TonePort, GuitarPort, 
and PODxt devices. You can think of GearBox as an elaborate “user interface” for your Line 6 device, 
where you can load, customize and save presets of your Tones, fiddle about with amp & effects knobs 
and switches on your computer, and access the optional GuitarPort Online membership service. With 
TonePort and GuitarPort USB devices, GearBox is of course a necessary “front-end” since all the Tone 
models and processing run on your computer. 

For POD X3 & PODxt devices, GearBox is really optional, since POD units perform their processing 
internally and already include all their own knobs, switches and LCD display. If you install only the 
Line 6 audio device driver on your computer, then you can certainly use POD X3 or PODxt as your 
USB audio device and tweak all your settings strictly on the POD unit itself.  But you’ll likely find that 
using GearBox along with your POD is very convenient, since it makes it quite easy to tweak, save and 
recall Tones and settings... and just looks pretty darn cool too! If you want to take things further and 
invest in the GearBox Plug-in Add-On or subscribe to the GuitarPort Online service, then you will 
need to install GearBox. 

http://line6.com/software/
http://line6.com/support/knowledgebase/toneporthelp/
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GearBox Plug-in 

The GearBox Plug-in is an optional Add-on software component you can purchase for TonePort, 
GuitarPort and PODxt devices that additionally allows GearBox to function as a Mac AU, Windows 
VST or Pro Tools RTAS audio effect plug-in. This of course offers some very nice advantages for use 
of your tones with your recording software. We go into more detail about using the GearBox Plug-in 
in the chapter aptly titled Using the GearBox Plug-in. You can launch Line 6 Monkey and purchase 
it directly from the Add-Ons page, or head to the Line 6 site now if you want to see about how to get 
your hands on it:

Line 6 GearBox Plug-in  

Updating & Registering with Line 6 Monkey

OK, so maybe you already read about doing this updating & registration stuff for your Line 6 hardware, 
but in case you were too excited with your new gear to get to that yet, now is the time to do it! This is 
all very easy using Line 6 Monkey on your computer with an Internet connection...

Line 6 Monkey is the intelligent updater software utility that is installed automatically along with 
the Line 6 GearBox software. Alternatively, you can also get Line 6 Monkey free from the Line 6 web 
site:

www.line6.com/monkey/

Go ahead and connect your Line 6 USB device to your computer’s USB port, power it on, and then 
launch Line 6 Monkey (on Mac, go to Applications > Line6, on Windows, go to Start > Program 
Files > Line 6). 

Login Account

You’ll need to Login so that Line 6 Monkey can communicate with the online Line 6 Server to provide 
the specific product updates for your gear. It’s just a few clicks, and it’s free!

If you have a Line 6 account, type in your User Name and Password at the top of the Monkey 
dialog. 

If you have not yet created an account, click the New User button and you’ll be walked right 
through the steps.

Register Your Hardware

Registering your Line 6 hardware is important because it insures that you’re dialed in for warranty 
service and makes it possible for us to contact you if new software versions or other cool enhancements 
are offered - cutting edge technology and such! 

If you have not already done so, you’ll be prompted to Register your connected Line 6 hardware. It’s a 

•

•

http://www.line6.com/gearbox_plugin/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=AddOns+GearBoxPlugIn+DropDown
http://line6.com/software/?submit=Show&name=Line+6+Monkey
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painless process really, so click that Register button and fill in the blanks on the web page. This page 
will list all your registered Line 6 gear in one place. 

Once you’ve logged into your account, Monkey will automatically check to see if you have all the 
latest updates to allow you to get the most out of your Line 6 hardware, and check to make sure you 
have the latest versions of the audio device driver, as well as the GearBox software itself. Be sure to 
choose any recommended updates and choose the Install/Reinstall Latest button at the right to allow 
Monkey to update these items for you. It’s also a great idea to do this every so often to keep things up 
to date. 

About This Guide…

This guide is intended to provide basic setup information for Line 6 USB hardware and GearBox software 
with most popular audio recording applications. The following sections provide setup information for 
both Mac® and Windows® systems. Use the Table of Contents or the Acrobat® Reader® Bookmarks to 
jump directly to the chapter and sections relevant to your setup. Remember, more GearBox info can 
be found by going to Help > Open Help within the GearBox application, and just read on for more 
resources... 
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Additional Online Resources

Hungry for more info? We’ve got plenty of helpful resources just a click away...

-Several more Help documents covering the latest GearBox news and support info, MIDI Control, 
product Release Notes and more are available here:  

GearBox Online Help 

-For technical support, choose from the many options listed on the Line 6 Support page:

Line 6 Support

-Official Line 6 hardware Product Manuals can be downloaded here:

Line 6 Product Manuals

http://line6.com/support/knowledgebase/toneporthelp/
http://line6.com/support/
http://line6.com/support/manuals/
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audio driVer & gearbox settings
Now that you have your Line 6 USB audio device driver and GearBox software installed, its time to  
get take a look at the settings and options for using your Line 6 gear in a computer recording setup!

 Note that there are some different options available in GearBox depending on which Line 6 USB 
hardware you are using. Be sure to refer to the details covering your specific Line 6 device in the following 
sections. 

Line 6 Audio Driver Configuration

In the world of computer recording, the audio driver is the key element of your audio hardware that you 
will see referred to by software applications, control panels and know-it-all computer audio geeks, so it’s 
a good idea that you learn a few things about your Line 6 device’s audio driver and its options! Things 
are a bit different on Mac® versus Windows® systems, and there are some feature differences between 
the specific Line 6 devices, so it is recommended that you refer to the GearBox Help documentation, as 
well as the product manual for your specific device for the full info. To get you going, we’ll run through 
the main points here regarding the audio driver and its settings.

 

Attention POD X3 owners... As of GearBox version 3.50, POD X3 devices are not yet supported by the 
GearBox software. But, like PODxt devices, POD X3 processes all its tones onboard and includes a USB 
audio device driver, so you can certainly connect to your Mac or Windows computer and record with all 
the same audio applications! Please refer to the POD X3-specific steps in the following sections. Please 
also check out the GearBox Online Help site for the latest breaking news regarding GearBox and POD 
X3 support!

Mac® Driver Settings 

Driver settings for your Line 6 hardware are configured within the Mac OS X Audio-MIDI Setup 
dialog and the Line 6 Audio-MIDI Settings dialog.

Note - GearBox version 3.5 is not officially supported to run on Apple’s OS X version 10.5 (Leopard) - 
please check the GearBox Online Help site for the latest news regarding GearBox and OS X support.

OS X® Audio-MIDI Setup Dialog

Once you’ve installed the Line 6 audio driver on your Mac and have your Line 6 hardware connected to 
your computer’s USB port (a USB 2.0 port is required for TonePort UX8 and POD X3 devices, all other 
Line 6 devices can use a USB 1.1 or USB 2.0 port), go to the Audio-MIDI Setup Dialog. To launch 
this dialog, go into the Mac System Preferences, select the Line 6 Audio-MIDI Devices (in the Other 
category), and in the Driver tab of the Line 6 dialog, click on the Run Audio MIDI Setup button.

Note: For TonePort UX8, please see the following UX8 Audio-MIDI Settings section.

http://line6.com/support/knowledgebase/toneporthelp/
http://line6.com/support/knowledgebase/toneporthelp/
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1

2

3

4

5

6

1 – System Settings: 

The Default Input and Default Output options allow you to choose the sound card you want 
ALL audio applications to use by default. If you want this to be your Line 6 device, select it 
here.

The System Output option allows you to choose which sound card the Mac System Settings are 
played through. You may NOT want to choose this to be your Line 6 device, since it can be rather 
annoying to hear those dings, beeps or frogs croaking at blaring volumes in your headphones 
or monitors when working in your audio application! Even better, you can turn these system 
settings off completely in the System Preferences > Sounds dialog.

2 – Properties For: Choose your Line 6 device here to allow the Audio Input and Audio Output 
options display its settings.

3 – Audio Input:

In the top selector, you will be able to choose a Record Send for your Line 6 device to configure 
its Format options below. 

TonePort & GuitarPort devices show Record Send 1-2 and Record Send 3-4 here. 

TonePort UX8 shows several Sends and more options - please see next section. 

PODxt devices show a “fixed” Master Stream here as the only option. 

POD X3 devices show four stereo Record Sends here.

The Format selectors show you the Sample Rate* and Bit Depth that the Line 6 device will is 
operating at for recording.  The Bit Depth for all Line 6 devices is fixed at 24 bit.

•

•

•

•

•

•

•

•
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*It is recommended that you do not use the Sample Rate selector here in the Mac Audio-MIDI Setup 
dialog to set your sample rate when your recording software is running. Typically, your recording 
software will offer a Sample Rate option per project within its own “Preferences” or “Audio Setup” 
settings. It is best to configure the Sample Rate within the recording software, and you will see the 
device’s sample rate switch automatically to match it.  

4 – Volume sliders (audio input): These sliders 1 - 12 are not functional with UX8 - use the GearBox 
Record Send knob and/or Tone volume instead of using these sliders to set your Record Send levels 
for Line 6 devices. 

5 – Audio Output:

The Format selectors show you the Sample Rate* and Bit Depth that the Line 6 device will is 
operating at for playback.  The Bit Depth for all Line 6 devices is fixed at 24 bit.

6 – Volume sliders (audio output): These sliders are not functional for Line 6 hardware - use the 
GearBox Out To Monitor controls (or the Volume knobs on your Line 6 hardware) instead of these 
sliders to adjust output levels.

•
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Mac OS X Audio-MIDI Setup Dialog - TonePort UX8

To launch this dialog, go into the Mac System Preferences, select the Line 6 Audio-MIDI Devices (in 
the Other category), and in the Driver tab of the Line 6 dialog, click on the Run Audio MIDI Setup 
button.

5

6

1

2

3

4

1 – System Settings: 

The Default Input and Default Output options allow you to choose the sound card you want 
ALL your audio applications to use by default. If you want this to be your Line 6 device, select 
your UX8 here. 

The System Output option allows you to choose which sound card the Mac System Settings 
are played through. You may NOT want to choose this to be your UX8, since it can be rather 
annoying to hear those dings, beeps or frogs croaking at blaring volumes in your headphones 
or monitors when working in your audio application! Even better, you can turn these system 
settings off completely in the System Preferences > Sounds dialog.

2 – Properties For: Choose your TonePort UX8 here to allow the Audio Input and Audio Output 
options display its settings.

•

•
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3 – Audio Input:

In the top selector, you will be able to choose your Record Send for the TonePort UX8 to 
configure its Format options below. 

The Format selectors show you the Sample Rate* and Bit Depth that the Line 6 device will is 
operating at for recording.  The Bit Depth is fixed at 24 bit.

*It is recommended that you do not use the Sample Rate selector here in the Mac Audio-MIDI Setup 
dialog to set your sample rate when your recording software is running. Typically, your recording 
software will offer a Sample Rate option within its own “Preferences” or “Audio Setup” settings. It is 
best to configure the Sample Rate within the recording software, and you will see the device’s sample 
rate switch automatically to match it.  

4 – Volume sliders (audio input):

These sliders 1 - 12 are not functional with UX8 - use the GearBox Record Send knob and/or Tone 
volume instead of using these sliders to set your Record Send levels for Line 6 devices. 

5 – Audio Output:

The Format selectors show you the Sample Rate* and Bit Depth that the TonePort UX8 is 
operating at for playback.  The Bit Depth for all Line 6 devices is fixed at 24 bit.

6 – Volume sliders (audio output):

These sliders are not functional for Line 6 hardware - use the GearBox Out To Monitor controls (or 
the Volume knobs on your Line 6 hardware) instead of these sliders to adjust output levels.

•

•

•
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Line 6 Audio MIDI Settings Dialog - Inputs & Recording Tab

To launch this dialog, go into the Mac System Preferences, select the Line 6 Audio-MIDI Devices (in 
the Other category).

Note: For TonePort UX8, please see the following UX8 Inputs & Recording Tab section.

1

2

1 – Input Source Select: This is a mirrored control for the Source Select within the GearBox application 
where it allows you to select which physical input is used on the device. Note that this control is ONLY 
selectable when the GearBox software is not in use by the current device. When GearBox is in use, this 
selector remains grayed out, but displays the current Source that is selected within GearBox.

When GearBox is not launched, this Input Source Select, like the Source Select in the GearBox 
application, offers a list of input options. The list of options will match those offered by your specific 
Line 6 device. TonePort UX2 displays the following:
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When GearBox is not in use, the 
Input Select menu is available. As 
shown here, TonePort devices offer 
several input Sources to choose 
from. The selected Source is what 
gets routed to the Device Sends

TonePort GX, DI and GuitarPort devices offer only an “instrument” 1 /4 input, therefore, this 
Input Select list shows only “Instrument” as the source. 

PODxt & POD X3 devices do not offer an Input Source menu in this dialog.

TonePort UX8 has a larger set of options - see the next section for its Inputs & Recording tab. 

2 – Device Sends info box: One line for each GearBox Record Send appears here along with a 
description for exactly what signal each Send is carrying.

The Record Sends description shows the 
input Source, and informs you if that signal 
is “processed” or not. Shown here, since 
GearBox is not running, the Send 1-2 
signal is unprocessed.

TonePort & GuitarPort devices display Sends information as follows (for TonePort UX8 please see 
the following TonePort UX8 Inputs & Recording Tab section):

Single Tone Source (Mono/Stereo): When the GearBox application is not running, Record 1-2 
and 3-4 both carry a raw, unprocessed signal. When GearBox is running, Record Send 1-2 will 
carry the fully GearBox-processed signal. For Record Send 3-4, you can choose between a “semi-
processed” signal with no post-effects, and a fully unprocessed signal. These options are available 
in the GearBox software.

Dual-Tone Source: If you’ve selected one of the dual input configurations from the input menu, 
Record 3-4 will always carry the signal from the second audio source. When GearBox is running, 
these sends will carry the Tone 2 signal of a Dual-Tone configuration. Please see the GearBox 
Help documentation for more about Dual-Tone operation. (TonePort GX, D.I. and GuitarPort 
devices do not support Dual-Tone operation and run only in Single-Tone configuration).

•

•
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PODxt devices show only one Record Send (Record 1-2). The type of signal that is routed to the 
Record Send 1-2 is determined by the PODxt Signal Routing menu option. Note that this Audio 
Signal Routing determines this signal routing regardless if GearBox is running or not for PODxt 
devices. Please refer to your PODxt Pilot’s Handbook for the information regarding the PODxt Signal 
Routing options and “Re-amping”.  Note that PODxt also offers a Monitor Level slider in this tab as 
well - this slider only affects the monitor volume and not the level fed to the Record Sends so you can 
use this to independently adjust your monitor signal while recording.

POD X3 devices show a list of 5 Record Sends, which are configured on the POD X3’s on-board 
Outputs settings screen. Please refer to your POD X3 Pilot’s Handbook for details on how to configure 
the signal routed out each Send. Note that POD X3 also offers a Monitor Level slider in this tab as 
well - this slider only affects the monitor volume and not the level fed to the Record Sends so you can 
use this to independently adjust your monitor signal while recording.

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
http://line6.com/support/manuals/
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Inputs & Recording Tab - TonePort UX8

2

3

4

5

1

1 – Input Source Select: TonePort UX8 offers 8 individual input sources, each with its own selector 
where you can choose which physical input is to be used for each. Input source options are as follows:

Input 1: Instrument 1 or XLR 1 or Line 1 or S/PDIF (L) 
Input 2: Instrument 2 or XLR 2 or Line 2 or S/PDIF (R)
Input 3: XLR 3 or Line 3
Input 4: XLR 4 or Line 4
Input 5: XLR 5 or Line 5
Input 6: XLR 6 or Line 6
Input 7: XLR 7 or Line 7
Input 8: XLR 8 or Line 8

Using Inputs 1 & 2 with GearBox
The GearBox application works with the TonePort UX8 driver to provide ultra-low latency via 
ToneDirect™ monitoring for Inputs 1 & 2 of the UX8, which includes two high-Z Instrument inputs, 
two XLR inputs, two Line level inputs and stereo S/PDIF input. GearBox’s ToneDirect Monitoring is 
ideally suited for recording guitar and bass with amp and effects processing, providing the instantaneous 
feel necessary for competent performance while tracking.
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When GearBox is not in use, the Input 1 & input 
2 selectors are available. As shown here, TonePort 
UX8 offers several input Sources to choose from. 
The selected Source is what gets routed to the 
Device Send. 

Stereo Paired Inputs

You can also link inputs into stereo pairs. This affects 
hardware monitoring controls in the Outputs & 
Monitoring tab (see below).

2 – Device Sends info box: One line for each GearBox Record Send appears here along with a general  
description for each Send.

On UX8, Send 9-10 carries the GearBox -processed 
signal, so you can select this Send as the track input 
in your audio software to record the full GearBox 
Tone. Send 11-12 carries the “semi-processed” 
Tone, which can vary depending on what GearBox 
effects you select as either “Pre” or “Post” the Send 
11-12. All other Sends carry an unprocessed signal 
of whatever is plugged into the respective Input jack 
on the UX8 hardware.

3 - Restore Defaults - click this button to restore all this tabs settings to their original default values.

4 - Clock Source - Set your preferred TonePort UX8 clock source with this menu. Select S/PDIF to 
sync the UX8 to an external S/PDIF clock source from another device’s digital output. If you are not 
connecting anything into UX8’s digital S/PDIF input, then keep this set to Internal to use the UX8’s 
own clock.

5 - Hardware Meters Show - This selector allows you to choose what the VU meters on the front of 
the UX8 are measuring. Note that these hardware meters function even if the GearBox software is not 
currently running.
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Mac® OS X® System Preferences Settings

There are a few System Preferences that you should configure when using your Mac for audio recording. 
Launch the Mac OS X System Preferences dialog to make the following settings.

System Sounds and Alerts

When using your Line 6 USB hardware as your audio device, you likely will not want to hear these 
system sounds, and you certainly don’t want to end up recording them by mistake! You can adjust the 
volume independently for these system sounds and alerts by going to the Sound page.

In the Sound Effects page, adjust 
the Alert volume slider down, 
and uncheck the Play user 
interface sound effects and Play 
user interface sound effects 
checkboxes

Choose Sound in your Mac’s 
System Preferences dialog
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Energy Settings

It is also a good idea to configure your Energy settings so that critical computer components do not go 
to “sleep” or run at less than full.

Choose Energy Saver in the 
System Preferences dialog

Choose Power Adapter  
You can also select Battery if you 
have a laptop and repeat all the steps 
in this section, but you may want 
your settings to conserve battery 
power - just keep these settings in 
mind if recording when running on 
battery power.

Set the top slider all the way to 
Never so that the computer is not 
allowed to enter “sleep” mode

Uncheck the box so that your 
hard disk does not go to sleep
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Configuration as an Aggregate Device (Mac® only)

Combine your Line 6 TonePort, GuitarPort, POD X3 or PODxt with other Core Audio devices using 
the Mac® OS X® Aggregate Device feature.

Note - The OS X Aggregate Devices functionality is not fully supported by Line 6 or most audio hardware 
manufacturers since of course it is not feasible to test the great number of combinations of devices possible. 
However, it is possible to combine one Line 6 USB device with another (non-Line 6) audio device for the 
combined functionality as described here - your exact performance may vary with different hardware. 

Mac® OS X® version 10.4.x (Tiger) allows you to configure two or more Core Audio sound card 
devices into one Aggregate Device. As the name suggests, this makes it possible to combine multiple 
connected audio devices allowing audio applications to utilize all inputs and outputs as one virtual 
Core Audio device. The Aggregate Device feature also provides the ability to sync the devices, and 
resample if needed to allow them to work together with your audio applications. This can be quite 
useful if you have another Core Audio sound card and want to use your Line 6 hardware along with 
it to provide additional inputs for recording, or additional outputs for sending multiple playback or 
monitoring mixes.

In this section, we’ll be showing you how to create a simple Aggregate Device using your Line 6 
hardware and your Mac’s Built-in Audio device Inputs and Outputs. The steps are similar for combining 
Line 6 hardware with other models of audio devices, as long as they offer a Core Audio driver that 
supports this OS X feature. 

Be sure to connect the USB cable from your Line 6 hardware into your computer’s USB port, and then 
proceed with the following steps… 

   

Creating an Aggregate Device

First, connect and your Line 6 hardware to your Mac USB port (a USB 2.0 port is required for TonePort 
UX8 and POD X3 devices, all other Line 6 devices can use a USB 1.1 or USB 2.0 port). All the 
required settings you need to make to create an “Aggregate” device are made within the Aggregate 
Device Editor window, which is found in the Mac Audio MIDI Setup dialog. 

Go into the Mac System Preferences, select the Line 6 Audio-MIDI Devices (in the Other category), 
and in the Driver tab of the Line 6 dialog, click on the Run Audio MIDI Setup button.
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Click on the “+” button to create a 
new Aggregate Device - it will then 
appear in the above pane

All detected Core Audio devices are 
then listed in the Structure pane

Select Open Aggregate Device 
Editor from the Audio menu

Click on the Use boxes for all Audio 
Devices to activate them. (Click your 
Line 6 device’s Use box first to make it 
the first device in the list).  Check the 
boxes for both the Built-in Input and 
Output so they can be used for both 
recording and playback.

IMPORTANT! Always set your Line 
6 hardware to be the assigned Clock 
device Keep the Resample checkboxes 

unchecked unless necessary *

When creating an Aggregate Device, only one audio device can be designated as the “Clock”. This 
means that this device acts as the “master” and all other devices follow its digital clock, thus keeping 
all your audio in sync. Even though the Aggregate Device dialog allows you to set any individual 
Audio Device as the Clock, be sure that your Line 6 hardware is set as the clock as shown above to 
ensure proper sync. 

*The Aggregate Device Resample function - When combining audio devices, the sample rates must 
match to allow them to be used together. But if you run into sync problems when using some devices 
together, or in the case where you need to choose a sample rate not commonly supported by all audio 
devices, you can check the Resample checkbox for the device. This instructs the Aggregator to 
automatically perform a sample rate conversion to allow the audio devices to sync.

Once above settings are made, click the Done button to return to the Audio MIDI Setup dialog…
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You are now able to choose this new “Aggregate Device” in the menus of the System 
Settings. Choose your new Aggregate Device as the Properties For device

Now you will be able 
to access settings for 
all combined inputs 
and outputs! 

For the device we 
created, this totals 6 
Audio Inputs and 4 
Audio Outputs.

The Audio Input and Audio Output sections each have a selector to allow you to choose each Stereo 
device, and then make settings for each with the set of controls below.

You will now see all devices’ inputs 
in the Audio Input selector. 
Likewise, you will see all outputs in 
the Audio Output selector

Note of the order of how all these Inputs and Outputs appear in the Audio-MIDI Setup dialog. In our 
example, Line 6 device “Record Send” inputs are listed first because we made it the first device in the 
Aggregate Device Editor dialog. The “Stream 3” input is from the Built-in Audio device, and appears 
last. These input and output ports will also appear in this same order within your audio recording 
software, but likely will not have any other identifying name other than their order number.
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Using an Aggregate Device with Audio Recording Software

Once an Aggregate Device is created on your Mac, you should then be able to access it in your 
recording software. As an example, we’ll be showing you how it appears in the included Ableton Live 
software…

Launch the Ableton Live software and open the Preferences dialog to configure the audio device.

Go to the Live menu and 
choose Preferences

Just as with most Multitrack recording software, in Live you also need to 
configure the individual inputs and outputs once a Multi-in/out device is 
selected. Click on the Input Config button to access the Inputs.

Go to the Audio tab

Choose CoreAudio as the driver type…

Then choose the Aggregate Device that 
was just created for both the Input and 
Output Audio Device. Note that this 
appears along with the individual audio 
devices in these menus as an additional 
selectable device.

Set a Sample Rate – preferably this 
should be one supported by all the audio 
devices that make up your Aggregate 
Device. Once all other settings are 
complete, click the Input Config button 

By default, Live will usually have only the first 
device enabled. Activate the desired devices 
here to allow them be available as recording 
inputs in the Live software. Note that each 
additional active devices utilizes more CPU, so 
only activate the ones you need!

Click OK when done

As noted earlier, you’ll need to refer to the order of the devices in the Audio MIDI Setup dialog to 
know which are Line 6 hardware ins, and which are from the other device since Live does not show the 
individual device names.

Next, click the Output Config button in the Live Preferences dialog to similarly activate multiple 
outputs…
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Click on additional output devices to make 
them available as playback outputs in Live if 
desired.* Here again, activate only the ones you 
need to avoid excess CPU usage.

Click OK when done

Note - The Ableton Live Lite 5, Line 6 version has a restriction that allows only one stereo output to be 
used at a time. To be able to choose two or more different output devices in a Live Set, you must switch 
into Demo mode, or upgrade to a full version of Ableton Live

You can now continue to use Ableton Live and all inputs and outputs will appear within the audio 
track menus, just as if all exist on one sound card!

All inputs appear in the Live 
audio track input menu

For more information regarding the Aggregate Device feature, check your Mac® OS X documentation.
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Windows® Driver Settings 

Be sure to first connect your Line 6 hardware directly to your computer’s USB port (a USB 2.0 port is 
required for TonePort UX8 and POD X3 devices, all other Line 6 devices can use a USB 1.1 or USB 
2.0 port). You can launch the Line 6 Audio-MIDI Devices dialog from within the Windows® Control 
Panel (Start button > Settings > Control Panel). This is the place where you can access the audio 
driver settings for your connected device to see and configure things such as the current Sample Rate, 
Bit Depth, Buffer settings, Record Sends, etc. For the Windows recording software applications covered 
in this document, it is always recommended that you use the ASIO audio driver. When prompted for 
ASIO driver settings, this is where you will make them. This dialog offers controls specifically for your 
connected Line 6 hardware. 

Driver Tab
TonePort & GuitarPort: This following screenshot shows TonePort UX2 as the connected device 
- the options  in this tab are the same for all TonePort and GuitarPort devices.

PODxt & POD X3: Options for PODxt & POD X3 family devices are called out where they differ 
in this section.

5

 6

7

1

2

3

4

1 – ASIO Client indicator: If you are running audio software that is using this Line 6 device as its 
ASIO sound card, the name of the software will appear here. If not in use by an ASIO software, “none” 
is displayed here as shown.
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2 – Buffer Size: The ASIO buffer size in use. As your Windows audio software documentation will 
likely tell you, the ASIO Buffer Size will affect the “responsiveness” and “latency” of the audio. The 
lower the setting, the faster the response, but with the trade-off of higher processor usage and the risk 
of audio dropouts. Raise the value if you are getting inconsistent playback or recording in the audio 
software. 512 is a good starting value, and you can try a lower value if your computer is snappy enough  
to support it.

3 – Bit Depth: The ASIO bit depth in use. It is recommended that you always use the 24 Bit option 
and configure your audio software to record at 24 Bit (or 32 Bit if your audio software offers the option).  
If you NEED to set your audio software to record at 16 bit (such as to reserve hard disk space) then it 
is recommended that you also set this Line 6 driver bit setting to 16 Bit to match.

4 – Sample Rate Converter: For all Line 6 USB devices, for recording you can simply choose any 
one of the supported sample rates (44,100, 48,000, 88,100 or 96,000 Hz) within your audio recording 
software, and your Line 6 gear will switch automatically. (Note that the Lock Format option changes 
this behavior - see #6 below). A little info for you on what this light means...

TonePort & GuitarPort devices support 44,100 Hz and 48,000 Hz sample rates natively. However, 
they will also support 88,200 and 96,000 Hz sample rates by way of an internal sample rate converter. 
This indicator lights up to show you when this converter is active, which can be any time your ASIO 
software is requesting a different sample rate you’re your device “natively” supports or is “fixed” at. 

PODxt & POD X3 devices operate at their own internal sample rates. They will automatically use 
an internal converter when needed, and you’ll see this little light on when that is happening. 

5 – Driver Operation Indicator: 

TonePort & GuitarPort devices display the sample rate and bit depth the current device is operating 
at (or with no text if not in use). 

PODxt devices do not utilize this feature and therefore no text will appear here when a PODxt is 
the selected device.

6 - Lock Format & Default options: When checked, the Lock Format forces the Line 6 audio driver to 
operate at the Sample and Bit rate settings entered in the two default settings fields above (as opposed 
to following the sample rate requested by a host audio application). In most cases you’ll want to leave 
the Lock box unchecked and choose the Sample Rate in your audio software - the Line 6 ASIO driver 
will follow the application’s sample rate.

  

 

Note – These default options and Lock checkbox will remain grayed-out while the current Line 6 device 
is in use by the GearBox application and/or any 3rd party audio application. To access the Lock Driver 
Format feature, you will need to exit GearBox as well as any audio software that might be using the 
currently selected Line 6 device as its audio device. This checkbox will then be selectable. This can be 
useful for using S/PDIF digital connections.

7 - ToneDirect™ Monitoring/USB Audio Streaming Buffer Slider:

TonePort & GuitarPort devices offer the Line 6 exclusive ToneDirect™ Monitoring feature, which  
provides an ultra low latency audio signal path for you to hear your GearBox tone, even while 
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recording. ToneDirect Monitoring has its own buffer to allow you to keep your ASIO Buffer Size at a 
high value, for more solid performance and more efficiency with your ASIO-based audio software. The 
initial default is one tick to the right of “Extra Small” as shown. Raise this slider if you are getting any 
dropouts in your monitor signal. 

PODxt & POD X3 devices utilize a USB audio buffer (similar to ToneDirect™ Monitoring) which 
provides an independent, direct monitor signal with its own buffer adjustment. When a PODxt or 
POD X3 device is selected as the Line 6 device in this dialog, the “USB Audio Streaming” buffer slider 
is displayed. The initial default is just a few ticks to the right of “Extra Small” as shown. Raise this slider 
if you are getting any dropouts in your monitor signal. 

Inputs & Recording Tab

Input Source Select menu: This is a mirrored control for the Source Select within the GearBox 
application where it allows the user to select which physical input is used on the device. Note that 
this control is ONLY selectable when the GearBox software is not open. When GearBox is in use, it 
remains grayed out, but displays the current Source that is selected within GearBox as shown here: 

When GearBox is not in use by the selected Line 6 device, this Input Source Select, like the Source 
Select in the GearBox application, shows the list of input options offered by the connected Line 6 
hardware.

TonePort GX, DI and GuitarPort devices offer only an “instrument” 1 /4 input, therefore, this 
Input Source Select list offers only “Instrument” as the source. 

PODxt & POD X3 devices do not offer an Input Source menu in this dialog.

TonePort UX8 has a larger set of options - see the next section for its Inputs & Recording tab.

Record Sends info box: One line for each Record Send appears here along with a description for 
exactly what signal each Send is carrying. This information is useful in that it tells you what will 
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actually be recorded in your audio application when you select one of these Record Sends as your 
track input.

TonePort & GuitarPort devices display Sends information as follows (for TonePort UX8 please see 
the following TonePort UX8 Inputs & Recording Tab section):

Single Tone Source (Mono/Stereo): When the GearBox application is not running, Record 1-2 
and 3-4 both carry a raw, unprocessed signal. When GearBox is running, Record Send 1-2 will 
carry the fully GearBox-processed signal. For Record Send 3-4, you can choose between a “semi-
processed” signal with no post-effects, and a fully unprocessed signal. These options are available 
in the GearBox software.

Dual-Tone Source: If you’ve selected one of the dual input configurations from the input menu, 
Record 3-4 will always carry the signal from the second audio source. When GearBox is running, 
these sends will carry the Tone 2 signal of a Dual-Tone configuration. Please see the GearBox 
Help documentation for more about Dual-Tone operation. (TonePort GX, D.I. and GuitarPort 
devices do not support Dual-Tone operation and run only in Single-Tone configuration).

 NOTE: If using TonePort or GuitarPort with an audio recording software that is configured to use the 
device’s WDM or DirectSound drivers, then only one Send will be available in the recording software (Send 
1-2). You must access TonePort via its ASIO driver on Windows to utilize the additional Send 3-4.

PODxt devices show only one Record Send (Record 1-2). The type of signal that is routed to the 
Record Send 1-2 is determined by the PODxt Signal Routing menu option. Note that this Audio 
Signal Routing determines this signal routing regardless if GearBox is running or not for PODxt 
devices. Please refer to your PODxt Pilot’s Handbook for the information regarding the PODxt Signal 
Routing options and “Re-amping”.  Note that PODxt also offers a Monitor Level slider in this tab as 
well - this slider only affects the monitor volume and not the level fed to Send 1-2 so you can use this 
to independently adjust your monitor signal while recording.

•

•

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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POD X3 devices show a list of 5 Record Sends, which are configured on the POD X3’s on-board 
Outputs settings screen. Please refer to your POD X3 Pilot’s Handbook for details on how to configure 
the signal routed out each Send. Note that POD X3 also offers a Monitor Level slider in this tab as well 
- this slider only affects the monitor volume and not the level fed to the Record Sends so you can use 
this to independently adjust your monitor signal while recording.

 
NOTE: If using POD X3 with an audio recording software that is configured to use the device’s WDM or 
DirectSound drivers, then only one Send will be available in the recording software (Send 1-2, which will 
carry the combined Tone 1 and Tone 2 processed signals). You must access TonePort via its ASIO driver 
on Windows to utilize the additional, individual Record Sends.

http://line6.com/support/manuals/
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Inputs & Recording Tab (TonePort UX8 only)

TonePort UX8 offers many additional options to control it’s multiple inputs and Sends. The Inputs & 
Recording tab lets you select specific inputs for recording. To follow is a brief description - for more 
information please see the TonePort UX8 sections in the GearBox Help documentation. 

Input Source Select drop-downs

Here is where you choose specifically which type of physical input you are plugging into for each input 
channel on the UX8:

Input 1: Instrument 1 or XLR 1 or Line 1 or S/PDIF (L) 
Input 2: Instrument 2 or XLR 2 or Line 2 or S/PDIF (R)
Input 3: XLR 3 or Line 3
Input 4: XLR 4 or Line 4
Input 5: XLR 5 or Line 5
Input 6: XLR 6 or Line 6
Input 7: XLR 7 or Line 7
Input 8: XLR 8 or Line 8

http://line6.com/support/knowledgebase/toneporthelp/
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You can also link inputs into stereo pairs. This affects 
hardware monitoring controls in the Outputs & 
Monitoring tab (see below).

Using Inputs 1 & 2 with the GearBox standalone application

The GearBox standalone application works with the TonePort UX8 driver to provide ultra-low latency 
via ToneDirect™ monitoring for Inputs 1 & 2 of the UX8, which includes two high-Z Instrument 
inputs, two XLR inputs, two Line level inputs and stereo S/PDIF input. GearBox’s ToneDirect 
Monitoring is ideally suited for recording guitar and bass with amp and effects processing, providing 
the instantaneous feel necessary for competent performance while tracking.

ASIO Record Sends

This box displays the ASIO names of the UX8’s input sources as they appear in recording applications 
utilizing the UX8’s audio drivers.

On UX8, Send 9-10 carries the GearBox -processed 
signal, so you can select this Send as the track input in 
your audio software to record the full GearBox Tone. 
Send 11-12 carries the “semi-processed” Tone, which 
can vary depending on what GearBox effects you 
select as either “Pre” or “Post” the Send 11-12. All 
other Sends carry an unprocessed signal of whatever 
is plugged into the respective Input jack on the UX8 
hardware.

Hardware Meters Show

Use this menu to select the input and output levels 
you want the UX8’s hardware meters to display. 

Clock Source

Set your preferred TonePort UX8 clock source with this 
menu - typically this should be set to Internal. Select 
SPDIF to sync the UX8 to S/PDIF clock source from 
another device’s digital output.
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Outputs & Monitoring Tab

Important: Note that the Outputs & Monitoring tab provides control over monitoring levels, 
specifically, monitor level controls for what you plug into UX8. These controls do not affect Send 
levels, the audio that streams into your recording software. In other words, volume and pan levels here 
are purely analog, intended for monitoring live input levels (from instruments, mics, etc), in order to 
facilitate the recording process. Note that the level of audio coming from your computer (e.g. - the 
playback of your audio software session) is not controlled by these sliders.

The Outputs & Monitoring tab provides control over hardware monitoring settings, including input 
source volume, pan and mute states. You can specify different mix settings for each pair of UX8 outputs 
if you like. 

By default, the only sounds that come out of the UX8 are the computer’s output and GearBox 9-
10 signal (fully processed), all through Main Outs 1-2. You can directly monitor other UX8 inputs 
by unmuting the corresponding input source in this tab. The UX8 provides monitoring through the 
hardware with zero latency, which is ideal for tracking with multiple sources simultaneously.

Use the drop-down menu at the top to select 
the output pair for which you want to mix. 
Each output pair can have different mix 
settings.
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Mix Controls

All Sources offer the following controls:

Mute (On/Off)       Monitor Volume (-100dB to +6dB)     

Monitor Pan (100% Left - 100% Right)      Stereo Monitor Meters    

Main Monitor Volume

This slider controls the overall monitoring volume for the current output pair. What you hear is 
displayed in the adjacent level meter and includes the combination of input sources and computer-
generated signals, such as those assigned to the current output from within your recording software. 
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Windows® XP® Sound Device Settings

Note - GearBox version 3.5 will also install and run on Windows® Vista®. Please go to the GearBox 
Online Help site for and reference the Gearbox Release Notes documentation known issues related to 
Windows® Vista®, as well as the Windows Optimization Guide which offers more settings tweaks for 
Windows® XP® and Vista® !

Windows® Default Sound Device

Windows XP itself also makes use of a sound card device to be able to play all those dings, beeps 
and other system alerts. Additionally, many multimedia programs such as Windows® Media Player® 
WinAmp®, iTunes® etc., will automatically set themselves to use the Windows default device for audio 
playback as well. Your Line 6 device can be set to be this default device if you want to utilize its high 
quality audio for playing your CD’s or DVD’s, for example.

Click on your Windows Start button and go to Settings > Control Panel > Sounds and Audio Devices 
> Audio tab. In the Sound playback section, choose your Line 6 device as the Default device.

 

TonePort set as the Windows 
Default device for playback

Considerations when setting your line 6 device as the Windows® default device:

Surround playback – TonePort, GuitarPort, PODxt and POD X3’s playback capabilities are designed 
for stereo. If you already have a sound card that provides surround sound via multiple speakers, this 
would also be a feature that you would lose by making your Line 6 device your preferred audio device.

Note that TonePort UX8 offers multiple physical outputs and can actually be configured for multi-channel 
surround output playback! Please see the documentation for your audio application and configuring a 
multi-channel sound card for Surround output.

On-board synth sounds - Some sound cards also have synthesizer chips onboard that will receive 
MIDI content and play audio directly out of the card. These sounds might also not be available to you 
if using your Line 6 device as the Windows default device, since your speakers will be connected to 
your Line 6 device. If your sound card has one of these synthesizer chips, one solution is to connect the 
audio output from your other sound card to the Monitor In jack on the back of your Line 6 device.

Windows System Alert sounds - It can actually be quite annoying to have all those Windows system 
alert sounds blaring at high volume through your Line 6 device when you are trying to focus on more 
musical endeavors. Fortunately you can independently turn off these system sounds and still keep your 
Line 6 device as your Windows default playback device. Click on your Start button and go to Settings 
> Control Panel > Sounds and Audio Devices > Sounds tab. For the Sounds Scheme setting, choose 

http://line6.com/support/knowledgebase/toneporthelp/
http://line6.com/support/knowledgebase/toneporthelp/
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No Sounds. Click OK to exit the dialog.

Accelerated 3D audio – Computer games may also set themselves to use the Windows default device, 
and some can have multi-channel or specific accelerated 3D audio playback requirements. Your Line 6 
device does not support this and may not perform properly with these types of applications. 

The Windows® Mixer 

The Windows Mixer utility also defaults to controlling the Windows default device. This is not 
necessarily a problem, but it is important to be aware of the fact that this means all the controls in the 
Windows Mixer’s Wave and main Volume sections (Pan, vertical Level slider and Mute checkbox) 
will affect your Line 6 device’s monitor output. Likewise, the Windows Mixer also controls the default 
device’s Recording Pan/Level/Mute settings as well. You may want to just keep all these Windows 
Mixer settings at “unity” settings so that they do not affect your Line 6 device’s monitor signal – that 
is, keep the Pan set to center, the Level sliders to all the way up, and the Mute checkboxes off. Then 
you can just use the Line 6 Audio-MIDI Settings dialog or GearBox software controls  to adjust these 
Monitor functions.

Note - if you have one of the fancier computer keyboards or a laptop that include volume and mute buttons, 
then they likely will adjust these same Windows Mixer controls.

To Launch the Windows Mixer, click on your Start button and go to Settings > Control Panel > 
Sounds and Audio Devices > Volume tab. From the previous step, your Line 6 device should already 
be set as the Default device (if not, set it in the Sounds tab). Click the Advanced button to launch 
the Mixer...

These Windows Mixer Volume and Wave controls 
affect the Windows default device’s playback output
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To access the Windows Mixer Recording controls, go to the Options menu > Properties and choose 
the Recording option…

These Windows Mixer Volume and 
Pan controls affect the Windows 
default device’s Recording input
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S/PDIF Digital Output from Line 6 Hardware to an External Device

TonePort UX2, UX8, KB37, POD X3 and PODxt Pro devices all include a S/PDIF digital output, 
which allows you to connect to digital devices such as a DAT recorder, Minidisk, sound card, or most 
any device that offers a S/PDIF format digital input. PODxt Pro also includes an AES/EBU digital out, 
which can be used to connect to hardware that offers this type of digital input as well. Connecting 
digitally is the preferred method to connect to external devices that support it since this does not 
require the added digital-to-analog-to-digital signal conversion process as required with using analog 
outs. 

One type of recording setup where you might use the S/PDIF output of your Line 6 hardware is with 
a Digidesign® Pro Tools® or Pro Tools LE™ system. With any Pro Tools setup, your Line 6 hardware 
would not be the assigned sound card for the Pro Tools software (since Digidesign requires proprietary 
hardware), but you can still utilize it by connecting the Line 6 S/PDIF output into the S/PDIF input 
of the Pro Tools hardware. Likewise, if you prefer to use a different sound card with other audio 
applications and the unit includes a S/PDIF input, then you can still utilize GearBox and your Line 
6 device connected digitally. This way you are simply routing the digital audio from your Line 6 gear 
right into Pro Tools or other software with no signal degradation! 

We’ve provided detailed steps specifically for connecting a Line 6 device’s S/PDIF output to a Digidesign 
Mbox® 2 device in the Recording with DigiDesign Pro Tools chapters - try the links below to jump 
to these chapters. The steps are very similar if you are connecting to the S/PDIF inputs of other 
manufacturer’ sound card devices as well.

Mac - Digidesign Pro Tools LE chapter

Windows - Digidesign Pro Tool LE chapter

Considerations When Using S/PDIF or AES/EBU Output

Some digital devices may only support one sample rate (some DAT and video machines are fixed 
at 48 kHz, for example), so you will want to be sure to choose a sample rate supported by both 
units.

When TonePort UX2/UX8/KB37 and PODxt Pro are operating at their 96 kHz “compatible” 
sample rate mode with GearBox, they send data out the S/PDIF outputs at 48 kHz. The S/PDIF 
output is always sent as 24 bit.

Remember that if you are connecting your TonePort, POD X3 or PODxt Pro digital output to 
another sound card, you are not limited to the other sound card being on the same computer. 
You can use your TonePort + GearBox on one computer as your “Tone Machine” - or POD X3/
PODxt by itself - and then send the fully baked Tone digitally to a completely different setup for 
recording!

For more specifics on digital input and output operation for TonePort, POD X3 or PODxt Pro 
please see the device’s User Manual.

•

•

•

•
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GearBox Recording Settings

The GearBox 3.5 software application is available for all TonePort, GuitarPort and PODxt devices 
and is another great tool for your Mac or Windows computer recording setup! To follow is information 
covering the features of GearBox you’ll find most useful for use with audio recording software. 

Choosing Your GearBox Source 

In GearBox speak, your “Source” is the instrument or mic you are connecting to your Line 6 hardware, 
and the physical input path it is plugged into. 

For Line 6 devices that offer a single input and single tone capability (GuitarPort, TonePort 
GX & D.I., GuitarPort and PODxt devices) your Source is of course fixed to whatever you have 
plugged into the device’s Instrument Input. 

For all other TonePort UX1/UX2/KB37/UX8 devices, there are multiple inputs and dual tone 
capabilities and, therefore, selectable Sources. Once you have your mic, instrument or line level 
item(s) plugged into your device, click on the Source Select menu to choose which of these 
“sources” you want to create a tone for. 

GearBox Source Select Menu 

TonePort UX1/UX2/KB37: Options within the Source Select menu provide the ability to create a 
tone for the Mic, Line or Instrument inputs separately, as well as the ability to choose a “Stereo” or 
“Dual-Tone” Source. 

Stereo sources include “Stereo” in their names

Dual-Tone sources include the “&” symbol in 
their names 

The TonePort UX1/UX2/KB37 Source Select menu

TonePort UX8: Options within the Source Select menu provide the ability to create a tone for 
the Mic 1/2, Line, Instrument 1/2 and Digital 1/2 inputs separately, as well as the ability to choose a 
“Stereo” or “Dual-Tone” Source. 

•

•
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Dual-Tone sources include the “&” symbol in 
their names 

Stereo sources include “Stereo” in their names

Digital sources include “Dig” in their names

The TonePort UX8 Source Select menu

Source Select and Choosing Tones in GearBox

Since there are different types of Input Sources, to follow are a few guidelines for setting up your tones 
for these types of Sources.

Single Input Source: When a Single Input Source is selected, the GearBox displays the last tone 
preset that was in use for this Source. You can of course choose any preset from the Tone menu, 
or customize the tone by selecting your desired amp, preamp and effects models. 

Stereo Input Source: A Stereo source accepts the inputs from the selected “Stereo” TonePort 
ins and processes them as one Stereo signal. This means that you still choose and edit one tone 
setting, just as you do for a single source, but the tone is applied to both channels, providing a 
stereo output.   

Dual-Tone Input Source: If you select one of the Dual-Tone sources, then you are able to 
choose a tone independently for each. For example, if you want to record a performance using 
an instrument and a mic that are plugged into TonePort’s Guitar/Bass and Mic inputs, you likely 
want to use separate Guitar Amp and Mic Preamp tones. To edit the separate tone settings, use 
two buttons that appear at the left of the Tones menu – both tones remain audible regardless 
which tone is displayed

Two tone buttons appear when a 
Dual-Tone Input Source is in use

Digital Input Source (TonePort UX8 only): A Digital source accepts the inputs from the 
selected S/PDIF TonePort ins. As shown in the above screenshot of the UX8 Source Select 
menu, there is a stereo pair of Digital inputs, which means they can be selected each as a Single 
Source, as a Stereo Source, or as a Dual-Tone Source. 

•

•

•

•
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Record Send Controls in GearBox

About Sends...

All Line 6 TonePort, GuitarPort and PODxt devices utilize “Sends” - you can think of Sends as the 
virtual “plumbing” for the different audio channels your device provides and makes available to audio 
software on your computer for recording and playback. The Record Sends carry  the output signals, 
which include the audio signals that run to the device’s physical outputs as well as those that run out 
the USB connection to your computer. Once you’ve installed the Line 6 USB audio device driver and 
connect the USB cable, these Sends are established on your computer and accessible within the Line 
6 Audio-MIDI Control Panel dialog. Note that these Sends carry audio back and forth regardless if 
you are using GearBox software or not, and for PODxt devices (which do not require GearBox, but 
optionally can use it) you can still access these Sends within audio software on your computer to utilize 
your device as a sound card for high quality audio recording and playback. For all TonePort devices 
and GuitarPort, the Record Sends  carry “unprocessed” signals at all times, but of course if you launch 
GearBox you can process whatever signal you are inputting into your Line 6 device with all those 
luscious Tones! 

The Line 6 TonePort, GuitarPort and PODxt devices differ as to the number of input options offered, 
and some also offer a different number of Record Sends that will appear as discrete audio channels for 
your audio software to record from. When using GearBox, you’ll have access to Record Send controls 
right inside GearBox - we’ll cover these first in this section. In the section that follows, we’ll cover the 
Send and additional audio controls that are also available for all Line 6 USB devices within the Line 
6 Audio-MIDI Control Panel on your computer. Please see the Mac Driver Settings and Windows 
Driver Settings sections at the start of this chapter for details.

GearBox Record Send 1-2

GearBox displays controls for the primary Record Sends offered by your connected Line 6 device. Your 
GearBox-processed Tones are automatically routed to these Sends and you use these Send pan and 
level controls to configure the stereo placement and recording level sent to your audio software and 
monitoring outputs. 

The functionality of the Record Send 1-2 controls are the same for TonePort, GuitarPort and PODxt 
devices, with a few differences as called out in the following descriptions. 
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Monitor Volume knob

Pan slider

Send 1-2:
+18 dB Boost switch

Mono switch

Record Level knob

Record Volume knob & +18 Boost switch: The Record knob adjusts the level of the signal 
routed out to Send 1-2, and directly affects the amplitude of your recorded audio into any software 
that is set to receive input from Send 1-2. Additionally, the Boost switch can be activated if 
the signal needs an additional 18 dB of gain. The rule for recording levels and digital audio is 
to always avoid clipping, yet keep the level at least above half to capture a nice strong signal. 
Use these controls and reference the meters above to adjust this level accordingly. Your audio 
software likely has meters that will reflect this level as well.

Mono switch: The Mono button will sum the GearBox stereo Tone to Mono (actually, a “dual-
mono” signal since it is the same mono signal fed to both the Left and Right audio channels of 
the stereo Send). Note that PODxt devices do not include this Mono switch and the Send 1-2 
signal is always routed as Stereo.

Pan slider: The Pan slider adjusts the left/right balance of the signal before it is routed to the 
Send, and therefore will affect what levels your recording software receives on the left and right 
channels.

Monitor level: The Monitor knob adjusts the level of the Tone Direct Monitoring signal fed to 
TonePort’s outs. You can activate the Mute switch to mute the Tone Direct monitoring signal 
completely. These controls do not affect the Record level that is sent to your recording software. 
This allows you to balance the listening volume of your GearBox tone signal and the playback of 
tracks coming from your recording software. 

Gearbox Record Send 3-4 (TonePort GX/D.I./UX1/UX2/KB37 & GuitarPort)

These Line 6 devices offer an additional Record Send 3-4, therefore, GearBox displays an additional 
set of controls for them when a TonePort or GuitarPort device is in use. (See the following section 
regarding TonePort UX8 and it’s multiple Sends).

When using GearBox with one of these devices, you can access a set of controls for Send 3-4 by 
clicking on the Send 3-4 icon in the row above the effects panel display. When GearBox is set to a 
single input Source (such as “Instrument”) you can set your recording software to receive the Send 3-4 

•

•

•

•
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signal, while you are monitoring the Send 1-2 signal. In this configuration, it allows you to record a 
dry or semi-processed signal into its own, independent audio track while monitoring a fully GearBox-
processed tone*.

The Effects Panel with Send 3-4 selected

 

*TIP - Configuring Send 3-4 this way is a great feature if you own the optional GearBox Plug-in! This 
allows you to monitor yourself recording with whatever GearBox Tone and effects you want for inspiration, 
but without “committing” the Tone to your recorded track. You can then load the GearBox Plug-in on the 
track in your recording software and choose whatever amp, cab & effects you like, as well as change the 
settings at any time to best suit the mix.

This set of Record Send 3-4 controls are independent of the Record Send 1-2 controls. Note that 
by default the Send 3-4 Mute button is engaged – you probably want this Send muted when using 
TonePort in a single input source configuration, since Send 3-4 then carries the tone without the Post 
effects and you likely want to hear the only the Send 1-2 signal as your monitor signal, with the Post 
effects active only on the Send 1-2 monitor signal you are hearing.

Send 3-4 is also very useful when you are using a Dual-Tone Input Source in GearBox (available with 
TonePort UX1, UX2 & KB37 devices), since each Tone is routed to a separate Record Send – Tone 
1 goes to Send 1-2, and Tone 2 to Send 3-4. This then allows your recording software to access these 
two Tones as separate, discrete signals and record those on separate tracks within the same recording 
take. 

TonePort & GuitarPort devices offer a set of mixer controls in the Line 6 Audio Control Panel, 
and that is where you can further control signal routing monitoring volume & pan levels, as well as 
independently mute/un-mute Sends. Please see the Mac Driver Settings and Windows Driver Settings 
sections at the start of this chapter for details.

TonePort UX8 - Multiple Record Sends

Unique to TonePort UX8 is it’s set of multiple physical inputs & outputs and multiple Sends. For UX8, 
each physical input 1-8 has its own dedicated Send that carries the signal of whatever is plugged into 
it’s (Mic or Line) input jack. TonePort UX8 allows you to assign physical input channels 1 & 2 (these 
two inputs are selectable for Mic, Line or Instrument) to be processed by GearBox, and this GearBox-
processed signal is carried on Record Send 9-10. You can choose to audibly monitor Send 9-10 and 
choose Send channels 9 and/or 10 within your recording software’s audio tracks to record the signal. 

GearBox also offers an additional two-channel Record Send 11-12. You can access a set of controls 
for this Send in GearBox by clicking on the Send 11-12 icon in the row above the effects panel 
display. By setting Send 11-12 to “Pre”, it will grab the signal of your connected instrument before it 
is processed by the GearBox amp and effects models, thus carrying an “un-processed” signal. Or, you 
can alternatively set Send 11-12 to “Post” and then choose to individually place your Mod, Delay or 
Reverb effects models to be Pre or Post themselves to apply each or not on the Send 11-12 signal. It is 
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possible to configure your recording software to record the Send 11-12 signal, while you are monitoring 
the (GearBox-processed) Send 1-2 signal. In this configuration, it allows you to record an unprocessed  
or semi-processed signal into its own, independent audio track while monitoring a fully GearBox-
processed tone*. Note that UX8’s Send 1-2 also carries the unprocessed signal of whatever is plugged 
into the selected physical inputs 1-2 (Mic, Line or Instrument), therefore, it is also possible to choose  
Send 1-2 in your recording software tracks if you wish to record a signal unprocessed by GearBox, 
independent of what you are actually hearing as your monitor signal coming out of GearBox!

The Effects Panel with Send 11-12 selected

Note that by default the Send 11-12 Mute button is engaged – you probably want this Send muted 
when using TonePort if you prefer to hear only the (Send 9-10) GearBox-processed signal.

 

*TIP - Configuring Send 11-12 this way is ideal for using the GearBox Plug-in! This allows you to 
monitor yourself recording with whatever GearBox Tone and effects you want for inspiration, but without 
“committing” the Tone to your recorded track. You can then load the GearBox Plug-in on the track in 
your recording software and choose whatever amp, cab & effects you like, as well as change the settings at 
any time to best suit the mix.

Send 11-12 is also very useful when you are using a Dual-Tone Input Source in GearBox, since each  of 
the two GearBox Tones is routed to a separate Send – Tone 1 goes to Send 9-10, and Tone 2 to Send 
11-12. This then allows your recording software to access these two Tones as separate, discrete signals 
and record them on separate tracks within the same recording take.

TonePort UX8 offers a complete set of mixer controls in the Line 6 Audio Control Panel, and that is 
where you can further control  monitoring volume & pan levels, as well as independently mute/un-
mute all the UX8 Sends. You can look back at the start of this chapter for the Mac Driver Settings and 
Windows Driver Settings sections that cover the UX8 options.

ToneDirect™ Monitoring

A unique feature of Line 6 TonePort & GuitarPort devices with GearBox is ToneDirect™ Monitoring. 
The ToneDirect Monitoring signal is a separate audio path that allows you to monitor your Mic/
Line/Instrument signal fully GearBox processed with the lowest possible latency for uncompromised 
feel and responsiveness when recording or jamming. The ToneDirect Monitoring feature also allows 
you to set the audio buffer size in your recording application at a large value for efficient use of your 
computer, yet still enjoy extreme low latency monitoring while recording. POD X3 and PODxt devices 
of course utilize their own on-board processing to create those lush Tones, so they do not require the 
same ToneDirect Monitoring feature, however, the benefits on these devices are much the same - the 
signal you use to monitor yourself while recording does not suffer from long latency delays and you can 
optimize the computer’s buffer settings for stable performance with your recording application!
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ToneDirect™  Monitoring  Buffer Slider (Windows®)

For TonePort & GuitarPort devices, the Line 6 ToneDirect™ Monitoring audio path has its own buffer 
to allow you to keep your ASIO Buffer Size at a high value, for more solid performance and more 
efficiency with your ASIO-based audio software. The initial default is one tick to the right of “Extra 
Small” as shown. Raise this slider if you are getting any dropouts in your monitor signal. 

 
PODxt devices utilize a USB audio buffer (rather than ToneDirect™ Monitoring) which provides an 
independent, direct monitor signal with its own buffer adjustment. When a PODxt/Live/Pro is selected 
as the Line 6 device in this dialog, the ToneDirect™ Monitoring section of the dialog is replaced by a 
PODxt-specific “USB Audio Streaming” buffer slider:

 
Attn. Mac Users... No ToneDirect Monitoring or USB Audio Streaming buffer settings are required on 
Mac systems - this is handled automatically for you!
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using the line 6 gearbox™ plug-in
The GearBox™ Plug-In is really an amazing tool for computer recording since it allows you to non-
destructively apply entire GearBox Tones on any of your recorded tracks, without needing to commit 
the settings until your final mixdown! The GearBox Plug-In is available as an Add-On purchase to your 
Line 6 hardware (or, already comes included if you own a TonePort D.I. or UX8). The GearBox Plug-
In supports three formats, making it compatible with just about any Mac®  or Windows®  recording 
software “host” - AU®, VST®, and RTAS® for Digidesign Pro Tools™/Pro Tools LE™. You can grab it 
now without even getting out of your chair! Just run Line 6 Monkey with your Line 6 USB device 
connected and go to the Optional Add-Ons tab. Or, you can read all about it here:

Line 6 GearBox Plug-In

Using the GearBox Plug-in with your favorite recording software gives you the freedom to change 
your tone as often as needed and automate amp and effects settings with surgical precision. If you 
have experience with host applications like Steinberg Cubase®, Ableton Live™, or Digidesign Pro 
Tools LE™, then you probably have used effects plug-ins. Using the GearBox Plug-In in your host 
is no different from using any other. Unlike most other plug-ins however, the GearBox Plug-In is 
not just a one-trick pony! It is really a full suite of amp, cab, mic and effects models that you can 
apply as a complete GearBox Tone on guitar, bass or vocals - or you can apply individual GearBox 
models or effects on any types of instruments, as many tracks as you like, and even fully automate the 
parameters!

If you’re new to the world of recording software and plug-ins, read the following examples of using the 
GearBox Plug-In in Ableton Live (AU or VST) and Digidesign Pro Tools LE (RTAS). 

 

Note: TonePort KB37 and other products come included with Ableton Live Lite - Line 6 Edition software 
for Mac or Windows, and the GearBox Plug-In is of course supported by this application.  If you have Live 
Lite version 4, Ableton offers a Live Lite version 5, Line 6 Edition as a free update for your version. To 
get it, launch your Live Lite 5 Line 6 Edition version and choose Check for Updates from the Help menu.  
In the following example, we’ll be showing the Ableton Live 7 version, but the steps are very similar for 
using the GearBox Plug-In with the Live Lite 5 - Line 6 version.

Activation & USB Hardware

The Help document included with GearBox and available from the ? button at the top of the GearBox 
Plug-In window provides information on activation. You must activate on each computer that you will 
use GearBox Plug-In with. GearBox and the GearBox Plug-In do not utilize iLok® or other, similar 
“dongle” devices for copy protection. When you purchase the GearBox Plug-In, it is established as an 
“Add-On” for the specific Line 6 USB device you purchased it for and this Line 6 USB hardware must 
be connected to your computer for the GearBox Plug-In to operate. 

 
Note: You do not necessarily need to use your Line 6 USB hardware as the assigned sound card for your 
audio software to allow use of the GearBox Plug-In, but your Line 6 device MUST be connected directly 
to your computer’s USB port. You should always connect directly to one of your computer’s USB port and 
not to a USB hub. 

 If your other audio recording software or hardware requires the use of an iLok® or other USB dongle 

http://www.line6.com/gearbox_plugin/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=AddOns+GearBoxPlugIn+DropDown
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then it is no problem to have it connected to your computer at the same time. If possible, you might 
try moving any USB dongle, mouse or keyboard to a USB hub to free up a direct computer USB port 
for your Line 6 hardware.

Using the GearBox  VST or AU Plug-In - Ableton Live 7

Once you have the GearBox Plug-In Add-On activated for your Line 6 hardware, you are ready to 
jump right into a whole new level of GearBox possibilities right within your Mac or Windows audio 
software!  If you are using a Mac, then the GearBox Plug-In is supported by any audio software that 
hosts the Mac Audio Units (AU) plug-in format. If you are using a Windows PC, then the GearBox 
Plug-In is supported by any audio software that supports the VST plug-in format. The use of the 
GearBox Plug-In with a Mac AU and Windows VST host application is much the same. There are 
of course some differences as to how each host application works with 3rd party plug-ins specifically, 
so you should consult your host’s documentation for all the fine points. To follow we’ve provided a 
step-by-step guide for the GearBox Plug-In within Ableton Live 7.01 on both Windows XP and Mac 
10.4 (Tiger) systems. This should provide a great example for how to insert, configure and automate 
parameters for the  GearBox Plug-In on most any Windows VST or Mac AU host!

 
Note - This documentation is for Windows® XP® and Apple OS X® 10.4 (Tiger).  GearBox 3.5 and the 
GearBox Plug-In will also install and run on Windows® Vista® and Apple OS X® 10.5 (Leopard) but with 
some known issues. See the GearBox Online Help page for the latest news regarding the support for these 
operating systems. 

Info View

First a handy tip... if you are new to Ableton Live then you might want to turn on the Info View panel. 
This displays a brief description of the user interface element within Live that your mouse is currently 
over. You can show/hide this panel by choosing it from Live’s View menu:

The Ableton Live interactive Info View panel

Activating the GearBox Plug-In in Live

Launch Ableton Live and make the following settings:

http://line6.com/support/knowledgebase/toneporthelp/
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Click the Activate button   

Click on the button to 
display the Plug-In Device 
Browser  

Clicking the Activate button will display the Preferences dialog with several options - we’ll be setting 
the Plug-In Sources options. Note there are some differences if you are using Live on Mac versus 
Windows here:

Mac - AU Plug-In Activation

Click the Use Audio Units 
button so that it becomes “On”

Once the Use Audio Units is enabled, Live will scan your Mac and display all found plug-ins in the 
Plug-In Devices browser panel like this:
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Live’s Plug-In Devices browser showing AU Plug-Ins (Mac)

Windows - VST Plug-In Activation
Click the Use VST Custom Folder 
button so that it becomes “On”, then 
click Browse to choose the folder where 
the GearBox Plug-In lives 

Choose the Program Files>Line 6>VST 
Plugins folder* and click OK  

 

*Note: The Program Files>Line 6>VST Plugins path is the default location where the GearBox Plug-In is 
installed if you have no other VST Plug-Ins. When you installed GearBox, you may have chosen another 
loacation where additional VST Plug-Ins were already installed. For example, if you have a Steinberg 
host application, it might be Program Files>Steinberg>VSTPlugins.  Browse to where your common VST 
Plugin folder is located if you want Live to find all your VSTs, otherwise you can use the deault Line 6 
location.

Once the appropriate folder is selected, Live will scan it and display all found plug-ins in the Plug-In 
Devices browser panel like this:
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Live’s Plug-In Devices browser showing VST Plug-Ins (Windows)

Inserting the GearBox Plug-In on an Audio Track

To apply the GearBox Plug-in to an audio track, follow these steps…

Click her to switch to 
Live’s Arrange View   

If your audio track is set up for stereo audio clips, click on the 
GearBox Stereo Plug-In and drag and drop it onto the track.  

If your audio track is set up for mono audio clips, click on the 
GearBox Mono Stereo Plug-In and drag and drop it onto the track*  
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*Note: This assumes the track is also set up to output to a stereo destination. If the track is set to a mono 
output, then you should insert the GearBox Mono Plug-In - please see the Live Help documentation about 
mono/stereo track configurations and signal routing for details.

Once inserted, you’ll see a GearBox Plug-In “Device” panel loaded in the lower pane of Live. 

Enable/Bypass the Plug-In

Click this button to show/hide 
the GearBox Plug-in parameter  
controls embedded in Live’s UI 
(although you’ll likely find it 
easier to use the GearBox Plug-In  
UI window to tweak parameters)

Click this button to show/hide 
the GearBox UI window

This “X-Y” graphic display 
allows you to control 2 plug-in 
parameters in real-time. The 
two parameters are selected 
in the menus below. Please 
refer to Ableton Live’s help 
documentation for more info

To remove the GearBox Plug-In from the Track, simply 
right click (Windows) or Ctrl + click (Mac) directly on 
the GearBox Plug-In’s title bar and choose Delete

Remember that it is a good idea to save your GearBox 
Plug-In settings as a Preset inside the GearBox Plug-IN UI 
window before removing the plug-in so that you can recall 
the settings another time!

Configuring the GearBox Plug-In 

Once loaded as an Insert, the GearBox Plug-In dialog is automatically launched. Here you can choose 
from any of your  saved GearBox Tone presets, or edit the individual amp, cab, mic and effects settings 
exactly as you would within the GearBox stand-alone application. Additionally there is a set of in/out 
level controls and meters specifically for the audio levels in and out of the Plug-In. 
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Call up saved GearBox Tones here Click here to Save a new Tone Preset

Launch the GearBox 
Plug-In Help 

 
Output meters - 
measure the signal 
level after all GearBox 
tone processing is 
applied

Output knob - con-
trols the level fed to 
the assigned  track 
output

Input knob - controls 
the level coming into 
the plug-in

The GearBox Plug-In UI Window

It is important to watch your levels in and out of the Plug-In. If the audio recorded in the audio track 
is already rather high, then adding some GearBox amp and effects models (especially distortion and 
compressor effects) can raise the gain further, resulting in clipping. Use the amp & effects’ volume 
and gain controls moderately, and then use the Input and Output knobs with in the GearBox Plug-In 
dialog to keep the levels at a nice hot level, but without clipping on the meters. For more details about 
the Plug-In UI, please click on the “?” button in the Plug-In window for the GearBox Plug-In Help 
documentation.

Inserting the GearBox Plug-In on a Send Return

Each instance of any Plug-In you add in your Live Set of course utilizes CPU power. Therefore, if you 
have the situation in your Live Set where you want to apply the same exact GearBox Plug-In settings 
to more than one audio track, it is a better practice to insert one instance of the GearBox Plug-In on a 
Send Return and route the desired audio tracks’ Send outputs to it. Here is how to set this up...

In Live’s Arrange View, drag and drop the GearBox Stereo Plug-In 
onto the A Return track
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Once the Plug-In is loaded as an insert on 
the Return track, you’ll see the track name is 
automatically changed to A GearBox Send

Configure the GearBox Plug-In with any combination of effects you like. For example, maybe you just 
want to use a Stereo Delay and Reverb effect so that it is applied to multiple tracks.

Next, switch Live’s Session View where you can easily see and adjust the Send A levels from multiple 
tracks. In this scenario, we’ve set the Send A controls for both audio tracks 1 and 2. The result is that 
each of these tracks will have part of their output routed to the return track, and therefore, through 
the inserted GearBox Plug-In. 

Adjust the Send A 
knob on each audio 
track to determine the 
level sent to the A 
GearBox Return track

Adjust the Track Vol-
ume for the amount of 
“dry” track signal

Adjust the Track Volume on the A GearBox Return track to 
determine how much “GearBox-effected” audio you will hear 

You can choose how much effect is applied for each audio track by how much you raise the Send A 
level. Additionally, the main output of each audio track is still routed to the main stereo Out 1-2, so 
you can adjust the vertical Track Volume slider for each audio track to also determine how much “dry” 
track signal is also heard at the main output. 

Note that it also possible to insert the GearBox Plug-In on the Master tack of your Live Set - just 
drag the GearBox Plug-in onto the Master track to do so. This allows you to run all your audio tracks 
through a common plug-in effect, such as the GearBox Compressor, Delay or Reverb! Ableton Live 
offers a great deal more signal routing options, allowing you to be even more creative with the use of 
the GearBox Plug-In and the mix of your Live Sets. Please go to the Live Help menu and choose Read 
the Live Manual for more info.
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Automating GearBox Plug-In Parameters

Ableton Live can automate any number of GearBox Plug-In parameters. As an example, let’s suppose 
you want to increase the GearBox Delay effect’s mix level in a particular section of a stereo guitar track 
you’ve recorded in Live, such Audio Track 1 from bar 13 through 20. You’ll need to create an envelope 
for the GearBox Delay-Mix parameter, following these steps…

In the Arrangement View, 
click on the track’s Device 
Chooser and select the inserted 
GearBox Stereo Plug-In

Once a parameter is selected, a red envelope line will appear 
across the track - you can click and drag this line up/down to 
adjust the selected parameter

Next,  click on the track’s 
Control Chooser and select 
the Delay-Mix parameter

Double click on the envelope line to create a 
“breakpoint”.  Here breakpoints are added where we 
want to start and end the parameter change. Note 
that when the mouse cursor is over a breakpoint, the 
parameter value at this position is displayed.

Now you can add additional breakpoints and drag 
them up/down to have the GearBox Delay Mix 
change over time. Here the result is no Delay effect is 
heard until bar 13, then it goes to a 50% Delay Mix, 
and gradually back to no Delay by the end of Bar 20

You can create any number of envelopes to control as many GearBox Plug-in parameters as desired. 
To show more parameters, click on the little “+ “ button at the bottom right of the track header. This 
places the parameter envelope you just created in its own “lane”, expanded below the waveform lane. 
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Now you can choose the GearBox Stereo Plug-in again in the Device Chooser, and desired parameter 
in the Control Chooser for a 2nd parameter envelope.

Ableton Live also features a Draw Mode tool, which literally allows you to draw the parameter 
envelope right over the track. You can select the Draw Mode tool if you right click (Windows) or Ctrl 
+ click (Mac) anywhere in the track’s waveform display area. For more information, please refer to your 
Ableton Live help documentation.

The Draw Mode tool in use

As discussed in the previous section, you can also utilize Live’s Sends to route a track signal to a return 
that has the GearBox Plug-In inserted on it. Note that you also have the option within the Control 
Chooser menu to show an envelope for each Send return. If you choose the Return track where the 
Plug-In is loaded, you can adjust it’s envelope to determine how much signal goes out the Send, thus 
determining how heavy the active GearBox Plug-In settings will be applied to this track’s signal.

The Send A volume parameter automation envelope adjusted on an Audio track

But wait... there’s more! If you take a look at the options for your Return track that has the GearBox 
Plug-In inserted, you’ll see that you also have all the same options as for an Audio track when the Plug-
In is inserted. Therefore, you can also use the Return track’s Control Chooser to show envelopes for 
individual GearBox Plug-In parameters and automate them too. Think of the possibilities!



Using the Line 6 GearBox Plug-in

3•11

Using the RTAS GearBox Plug-In - Digidesign Pro Tools LE 7

The GearBox Plug-In supports the Digidesign Real Time Audio Suite (RTAS) Plug-In format for Pro 
Tools and Pro Tools  LE software on both Mac and Windows. Once you have the GearBox Plug-In 
Add-On activated for your Line 6 hardware, you are ready to jump right into a whole new level of 
GearBox possibilities  right within your Pro Tools software! To follow we’ve provided a step-by-step 
guide for using the GearBox RTAS Plug-In within Digidesign Pro Tools LE 7.3.1 on Windows XP. This 
should provide a great example for how to insert, configure and automate parameters for the  GearBox 
Plug-In on any Windows or Mac Pro Tools RTAS host version. There are of course some differences 
for using RTAS plug-ins on different Pro Tools software versions, so you should also consult your 
Digidesign documentation for all the fine points. 

Inserting the Plug-In

The most common way to apply an RTAS effect plug-in within Pro Tools LE is to add it as an insert on 
the audio track where you are recording your guitar or other instrument. You can access the insert slots 
either directly on an audio track’s channel strip in the Mix window, or at the left of the track in the 
Edit window (you may need to enable the “insert” module to be visible from the Track View Menu). 

Mix window Insert slot Edit window Insert slot

When you click on a track’s Insert Selector, you’ll find the GearBox Plug-In selectable within the 
Other sub-menu. Note that the plug-in options will be different if your track is a stereo or mono 
track...

Stereo audio track

On a stereo track, you’ll 
have the option for the 
GearBox (stereo) Plug-In  
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Mono audio track

On a mono track, you’ll have two 
options: 

If your track’s output is set to a 
mono Interface or Bus, then it is 
best to choose GearBox (mono) 
retain a mono channel signal

If your track’s output is set to a 
stereo Interface or Bus, then it is 
best to choose GearBox (mono/
stereo) to feed to the stereo 
output 

You’ll then see the GearBox Plug-In loaded in the Insert slot in both the Mix & Edit windows...

Mix window Edit window

To remove the GearBox Plug-In, simply click on the Insert Selector where the plug-in is loaded and 
choose No Insert from the menu. 

 
TIP: You might want SAVE the settings of your GearBox Plug-In instance as preset before you remove it 
so you can recall the same settings again easily any time you load the plug-in again!  

You can load as many instances of the GearBox Plug-In as you like in your session. Note that each 
instance you load will utilize more of your computer’s resources since RTAS plug-ins are powered by 
you computer’s CPU. You are not limited to just using the plug-in for guitar, bass or vocal tones - you 
can load the GearBox Plug-In and just use individual models, such as just the great vintage sounding 
Delays, Stompbox or Reverbs, on any instrument! 

Presets and Saved Settings

When you save your Pro Tools session, the loaded GearBox Plug-In instances, as well as all Plug-In 
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settings, are saved as part of the session. However, note that adjustments made to GearBox Plug-In 
instances may not trigger Pro Tools to recognize that you have changed your Pro Tools session, and  
therefore Pro Tools may not prompt you to save changes when closing your the session if you haven’t 
made other changes since the last save. Manually saving before closing a Session file will ensure that 
the adjustments you’ve made to the GearBox Plug-In get saved with the Session. 

The Session saved by Pro Tools’ Save Session Copy function may not properly capture GearBox Plug-
In settings. After using Save Session Copy, also do a  Save As to that same destination so your copied 
Session has the parameter values for GearBox Plug-In instances in your Session.

Configuring the GearBox Plug-In 

Once loaded as an Insert, the GearBox Plug-In dialog is automatically launched. Here you can choose 
from any of your  saved GearBox Tone presets, or edit the individual amp, cab, mic and effects settings 
exactly as you would within the GearBox stand-alone application. Additionally there is a set of in/out 
level controls. You’ll see that the plug-in  dialog is contained within an RTAS plug-in window, and at 
the top are some Pro Tools LE specific controls. These are the same controls for all RTAS plug-ins and 
allow you to switch to other tracks, save session-related presets, and more. Please check your Pro Tools 
LE documentation for more on these controls. 

Use the Bypass button 
to bypass the entire 
GearBox plug-in

Launch the GearBox 
Plug-In Help 

 
Output meters - 
measure the signal 
level after all GearBox 
tone processing is 
applied.

Output knob - con-
trols the level fed to 
the assigned  track 
output

Input knob - contrls 
the level coming into 
the plug-in

It is important to watch your levels in and out of the Plug-In. If the audio recorded in the audio track 
is already rather high, then adding some GearBox amp and effects models (especially distortion and 
compressor effects) can raise the gain further, resulting in clipping. Use the amp & effects’ volume 
and gain controls moderately, and then use the Input and Output knobs with in the GearBox Plug-In 
dialog to keep the levels at a nice hot level, but without clipping on the meters.
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Monitoring with the GearBox Plug-In

As described in the Digidesign Pro Tools LE Setup chapters (Mac and Windows) of this document,  
there are some specifics to configuring your audio track and Mbox 2 (or other Digidesign hardware) 
to monitor your input signal while recording. Here are a few options for monitoring when using the 
GearBox Plug-In.

Pro Tools LE Software Monitoring
One practice is to plug your instrument or mic directly into your Mbox 2 and record it’s unprocessed 
signal into the audio track so that you can use a plug-in on the track to then non-destructively add 
amp, cab and effects to it. The GearBox Plug-In is of course the perfect type of plug-in for this task! 
For this setup you’ll need to load the GearBox Plug-In on the audio track Insert first, and then arm 
the track and keep it un-muted so that you can adjust the Mbox 2 Mix knob to hear your input signal 
running through the track. 

Pro Tools LE audio track - armed, with GearBox Plug-In loaded as an Insert 

You can of course use any GearBox settings you like since it is only acting upon the monitor signal so 
you can hear it live, while the raw, unprocessed signal gets recorded. 

The drawback with this setup is that it takes a fraction of a second for the input signal to pass through 
the software, through any insert plug-ins and then back out your speakers or headphones. This amount 
of delay is referred to as “latency” and what you hear all the computer recording geeks rant about on 
all the computer audio forums. You can minimize the latency by lowering your Pro Tools audio engine 
buffer size, but note that the lower the buffer setting the more CPU demands are placed on your 
computer. 

Using Line 6 Hardware for Monitoring Externally
Another option is to use an external hardware mixing console as follows to allow you to split the input 
of your instrument or Mic into two signals so that you can plug one into your Line 6 TonePort, POD 
X3 or PODxt, and the other input into your Digidesign interface:

Plug your Instrument or Mic into a channel on your mixing console.

From this mixer channel, route the signal out a Send so that you can then plug one into the 
Mic/Instrument input of your Line 6 hardware, and the other into the Mic/Line In of your Mbox 
or other Digidesign hardware. 

Connect the Analog Outs from your Line 6 hardware back into another channel of mixing 
console and route the channel to your monitor system. This channel will monitor only the 
output of your Line 6 device. 

Connect the Mon Outs from your Mbox into its own channel on the mixing console and route 
the channel to your monitor system. This channel will monitor the playback of your Pro Tools 
session.  

Launch the GearBox stand alone application and dial in whatever tone you want for your 
monitoring signal, which you’ll be able to hear with nearly zero latency. (Or, if you are using a 
PODxt or POD X3, you of course do not need the GearBox software, or even to connect your 

•

•

•

•

•
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POD to your computer’s USB port).

Configure your audio track in Pro Tools to record from the Mic/Line In you are connected to and 
Arm the track for recording. You should keep the track Muted while recording since you do not 
want to hear the unprocessed signal coming into the track. 

Once you are done recording, you can then un-mute the Pro Tools LE track and load the GearBox 
Plug-In as an insert on the track.  It is now up to you to either call up the same settings you used 
in the GearBox stand-alone application (or PODxt/POD X3) to monitor with, or tweak the 
plug-in to achieve any tone you want for the track.  

Using the GearBox Plug-In with Sends

Another method to using plug-ins in Pro Tools LE is to add one instance of a plug-in as an Insert on 
an Aux track, and then route a Send from multiple audio tracks to the feed into the Aux track so 
that  all the tracks can be processed with the same, single plug-in. This can be very useful if you want 
to do something like use the same Analog Delay effect on several different tracks - it would be a very 
inefficient use of CPU power to load several separate instances of the GearBox Plug-In as inserts on 
multiple audio tracks. The better practice is to load one GearBox Plug-In instance on an Aux track, 
and then route a Send - this can all be done in the Pro tools LE Mix window as shown here...

In this example, both Audio 
Track 1 and 2 each have a Send 
established, with the output 
set to Bus 1-2. This allows the 
playback signal of the tracks 
to be “tapped” and routed to a 
common desitnation track. 

Note that the Track Output is 
still set to the Mbox 2 Interface 
Out 1-2. 

The track slider will still control 
the playback level of the (non-ef-
fected) Audio track that is routed 
to the main output. 

The GearBox Plug-In is added as 
an Insert only on this stereo Aux 
1 track.

The Input for this Aux 1 track is 
set to Bus 1-2, therefore, the Send 
signals coming from Audio Tracks 
1 and 2 will now be fed into this 
Aux 1 track, and both effected by 
the GearBox Plug-In. 

Use the Aux 1 track’s volume 
slider to blend the GearBox-ef-
fected signal in with the (non-ef-
fected) Audio Track 1 and 2 signals 
at the main Mbox Out 1-2.

The Pro Tools LE 7 Mix window - Two Audio Tracks routed to a Send, returning into Aux 1 

•

•
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Click on the Send 
assignment to launch 
the Send Controls 

The Pan and Level 
knobs allow you to 
independently control 
the Audio Track 1 pan 
position and volume  
that is fed out to Bus 1-2 
(and thus, through the 
GearBox Plug-In that is 
inserted on Aux 1) 

The Send Controls for Send A routed from Audio Track 1

It is also possible to add the GearBox Plug-In as an Insert effect on a Master track in your session, 
which can then effect all the audio tracks in the session! Pro Tools LE offers quite a few more signal 
routing options that allow you to get very creative with the mix of your session - please check your 
Digidesign documentation for details. 

Automating GearBox Plug-In Parameters

Once the GearBox Plug-In is loaded on any type of track as an Insert, you can further configure the 
track to automate many of the GearBox parameters. Parameter automation can be done by manually 
shaping an envelope across the track, or even in real-time by recording parameter moves! Here is 
an example on how to configure a Pro Tools LE track to automate the GearBox Analog Delay - Mix 
parameter so that the amount of delay effect changes over time on the track...

With the GearBox Plug-In loaded as an Insert on the Audio 1 track, launch the Plug-In dialog and 
click on the auto button to launch the Plug-In Automation dialog. 
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You’ll see all the automatable GearBox parameters listed in the left column of the dialog. Select the 
Delay - Mix parameter in the left column and click the Add >> button to enable it. In the screenshot 
below, the GearBox Delay-Mix parameter has been “added” as an automatable parameter for the Audio 
1 track. You can add as many parameters as you like for the track and automate any of them, but for 
this example we’ll keep it simple. 

The Plug-In Automation dialog, showing all the available GearBox parameters that can be automated

Once the Delay-Mix parameter is added, click on the Track Selector button for Audio Track 1 and 
select it. This will display an editable envelope line across the audio track display.

Click on the Envelope line to create edit points, 
and then drag an point up/down to adjust the 
Delay-Mix level. Play the session to hear the 
changes

Or, you can set the track to “write” automation in real time. Click on the Automation Mode Selector   
for the Audio 1 track and choose one of the write modes (touch, latch or write - please see your Pro 
Tools LE documentation about the differences for these modes). 
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Launch the GearBox Plug-In dialog and select the Delay effect so that you can access the Delay - Mix 
knob. Now when you hit Play in your Pro Tools session, adjust the GearBox Plug-In Delay - Mix knob 
in real-time while listening to the session. The moves you make will be “written” to the envelope line 
in the track. Stop playback to stop writing automation. 

You can set the Automation Mode to read if you are done writing automation on the track. You can of 
course  manually click and drag the envelope edit points to further fine-tune things if you like.

 Note: The GearBox Plug-In dialog does not visually indicate what parameters are ‘armed’ for automation, 
and does not allow automation of some parameters, including model select and pre/post switches.  Please 
see the GearBox Online Help page for additional info on known issues and compatibility.

Using Control Surface Devices

GearBox Plug-In parameters can be controlled remotely from some control surface hardware units, but 
does not provide easily readable parameter names for hardware LCD displays, and does not support all 
control surface possibilities.  Please see the GearBox Online Help page for additional info on known 
issues and compatibility.

http://line6.com/support/knowledgebase/toneporthelp/
http://line6.com/support/knowledgebase/toneporthelp/
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Mac® audio applications 
The following chapters cover the setup of Line 6 GearBox software and TonePort, GuitarPort, POD 
X3 and PODxt devices with several popular Mac audio recording applications. The examples used in 
these Setup chapters all utilize Apple OS X version 10.4 (Tiger).  

Note that GearBox version 3.5 and the Line 6 audio device drivers do not officially support Apple OS 
X® version 10.5 (Leopard). For the latest news and developments on GearBox, audio drivers and OS X® 
support, please visit the GearBox Online Help site.

You can use the following links to jump to the chapter that covers your specific 
application...

Ableton Live® 

Apple GarageBand®

Apple Logic® Pro

Digidesign® Pro Tools® LE

MOTU Digital Performer®

Propellerhead Reason®

Sonoma Wire Works RiffWorks® 

Steinberg Cubase®

Windows audio applications

http://line6.com/support/knowledgebase/toneporthelp/
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ableton liVe® 7 setup
For this document, we’ll show how to configure Ableton Live® version 7.01 to work with Line 6 
TonePort, GuitarPort, POD X3 or PODxt as the USB audio device.  The steps are very similar for the 
setup of other Live versions as well, including the Ableton Live Lite 5, Line 6 Edition version that 
comes included with some Line 6 TonePort packages.

 Note that the features of Line 6 hardware models differ slightly, so we’ll call out where specific instructions 
apply per device type. If you are using a POD X3 device, it is not yet supported as of GearBox version 3.5 
- please check the Line 6 GearBox Online Help site for the latest news and developments.

Configure Your Mac® to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Mac System Preferences and select the 
Line 6 Audio-MIDI Devices dialog to access the Audio Driver settings. If needed, please reference 
the Mac Driver Settings section of the Audio Driver and GearBox Settings chapter. 

Configuring Live to Use the Line 6 Core Audio Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps...

Launch the Ableton Live Preferences dialog:

Go to the Live menu and 
choose Preferences

Just as with most Multitrack recording software, in Live you also need to 
configure the individual inputs and outputs once a Multi-in/out device is 
selected. Click on the Input Config button to access the Inputs.

Go to the Audio tab

Choose CoreAudio as the driver type…

Then choose your Line 6 device t for 
both the Input and Output Audio 
Device. In this example, we’ll choose our 
connected TonePort UX2

Set a Sample Rate – 44, 100 is a good 
choice here, or you can use 48,000, 
88,200 or 96,000 Hz if your Project 
requires a higher sample rate

http://line6.com/support/knowledgebase/toneporthelp/
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Activate Inputs:

Here you can “activate” all the inputs from your 
Line 6 hardware that you want to be accessible 
for any audio track as a track input for recording

Click OK when done

You’ll want at least the 1 (mono) & 2 (mono) and the 1/2 (stereo) inputs activated. Each additional 
activated input utilizes more CPU, so only activate the ones you need!

Note that you’ll see a different number of inputs listed in the Input Config dialog depending on 
the specific Line 6 device you are using. Typically these enumerated inputs correspond to the Line 6 
device’s Sends of the same number (i.e. - Live’s input “3/4 (stereo)” is the TonePort UX2/GearBox 
Send 3-4).  More about this when we get to the part about setting up your audio track.

TonePort GX, D.I. UX1, UX2 and KB37: You will see 4 Mono inputs and 2 Stereo inputs, as 
pictured above.

TonePort UX8: You’ll see 12 Mono inputs and 6 Stereo inputs.

 TonePort UX8’s driver offers multiple Inputs and Sends with many flexible options for routing and 
monitoring GearBox Tones. Please reference the Mac Driver Settings section of the Audio Driver and 
GearBox Settings chapter for more details

POD X3 devices: You’ll see 8 Mono inputs and 4 Stereo inputs.

 
POD X3 offers several onboard options for the type of signal that is assigned to each Send. Look in the 
Line 6 Audio-MIDI Settings dialog’s Inputs screen to see the current POD X3 Send descriptions.  For 
more info about POD X3 Sends,  please reference the Mac Driver Settings section of the Audio Driver 
and GearBox Settings chapter, and your POD X3 Pilot’s Handbook.

PODxt devices: You’ll see 2 Mono inputs and 1 Stereo input.

Activate Outputs:

To access the outputs, click the Output Config button back in the Live Preferences > Audio tab. This 
will show you all outputs available fo ryour selected Line 6 Output Device. 

For all Line 6 devices (except TonePort UX8), the CoreAudio driver offers is only Output 1/2, 
therefore the dialog will show its two mono and 1 stereo output options, and they will automatically 
be selected. 
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TonePort UX8: You’ll see 8 mono and 4 stereo outputs. For most Live projects, you likely only need 
to enable the Output 1/2 mono and stereo options and assign all track playback to one common 
output. UX8 does offer some very flexible monitoring and signal routing options using its additional 
outputs - please see the Mac Driver Settings section, as well as your TonePort UX8 Pilot’s Handbook 
for more information.

Note - The Ableton Live Lite 5, Line 6 version has a restriction that allows only one stereo output to be 
used at a time. To be able to choose two or more different output devices in a Live Set, you must switch 
into Demo mode, or upgrade to a full version of Ableton Live

Configure Record Options...

Back to the Live Preferences dialog, now select the Record options.

Select the Record 
Warp Launch tab

For File Type you can 
select  AIFF or WAV, 
whichever format you 
prefer your recorded 
audio files to be created 
as. 

For Bit Depth, select 24 
Bit

Configuring an Audio Track for Recording 

Now that your Line 6 hardware is set up, you are ready to start working in a Live Set!  Create a new 
Live Set (or open an existing one) and insert a new audio track to record into...

Choose Insert Audio Track from 
Live’s Insert menu

In the following example, we’ve inserted two audio tracks, assigned their outputs to the “Master” 
track, and assigned the Master Output to the stereo Main 1/2 output of our Line 6 device (TonePort 
UX2). For Audio Track inputs, note that you can select from the mono or stereo inputs of your Line 
6 device, which you “activated” in the previous steps. If you choose a stereo input, a stereo audio file 
will be recorded into the track, and likewise, if you choose a singular mono input, a mono file will be 
recorded.

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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Choose the Arrangement 
View

(Alternatively, you can ac-
cess all these same settings 
in the Session View if you 
prefer)

Click the I-O toggle but-
ton to display the Input/
Output settings for the 
tracks

To configure your Audio 
tracks...

Choose Ext. In for the Input 
Type

Then choose the stereo or 
mono input you want to 
record from

Set your Audio tracks’ Output 
to Master

Note that here we’ve chosen 
to record from TonePort’s 
Send 1-2 for track 1, and Send 
1 for track 2

On the Master track, choose the 
stereo Out 1/2 of your Line 6 device 
for both the Cue Out and Master 
Out

* Note that the Master Track offers two Output selectors. The top selector is to set a “Cue Out”, which 
allows you to route a separate output for playback of browser clips and previews. If you have a TonePort 
UX8, then you can set this Cue Out to a different stereo output to allow you to listen to previews on a 
completely separate headphone or speaker out. Please see Live’s documentation regarding the Cue Out 
feature. For all other Line 6 hardware, set both Master Outs to the same Out 1/2.

Set Input Monitoring Options...

When recording using GearBox, it is recommended to use its ToneDirect Monitoring™ feature, 
where your input monitoring signal is passed directly back out of your Line 6 hardware’s output. This 
allows you to hear the GearBox tone you have selected for your Mic or Instrument with the lowest 
possible latency. Likewise with POD X3 and PODxt, these devices offer a super low latency USB audio 
monitoring. Therefore, we will disable Ableton Live’s Input Monitoring option so that the input 
monitor signal is not additionally fed through the software*.

Click the audio track’s Monitor Off 
button

 
* Optionally, if you are using the GearBox Plug-In, you can load the Plug-In on your Live audio track 
and turn Monitoring to “Auto” to monitor your input signal through the software, and thus through 
the GearBox Plug-in processing. See the Using the GearBox Plug-In chapter for a detailed guide on 
configuring the Gearbox Plug-In with Ableton Live!.
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Arm Your Track & Set Your Levels...

Click the Arm button to arm the audio track for recording

Note that you’ll see the meters measure your input recording 
level once the track is armed

If you are using GearBox with your Line 6 
hardware, you can adjust your recording level in 
using the assigned Send’s Record knob within the 
GearBox window. Note that your Amp and Tone 
Volume knobs in GearBox and on POD devices 
will also affect the recording level into Live

Start Recording!

Once your record level is set, click on Live’s transport Record button to put it 
into Record Mode, then press Play and start riffing!
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apple garageband® ‘08 setup
For this document, we’ll show how to configure Apple GarageBand ‘08® to work with Line 6 TonePort, 
GuitarPort, POD X3 or PODxt as the USB audio device.  

 Note that the features of Line 6 hardware models differ slightly, so we’ll call out where specific instructions 
apply per device type. If you are using a POD X3 device, it is not yet supported as of GearBox version 3.5 
- please check the Line 6 GearBox Online Help site for the latest news and developments.

Configure Your Mac® to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Mac System Preferences and select the 
Line 6 Audio-MIDI Devices dialog to access the Audio Driver settings. If needed, please reference 
the Mac Driver Settings section of the Audio Driver and GearBox Settings chapter. 

Configuring GarageBand to Use the Line 6 Core Audio Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps...

Launch GarageBand and choose Preferences from the menu:

Select your Line 6 device for both the Audio 
Output and Audio Input

Select Audio/MIDI

Note that after selecting your device each 
time you will be prompted if you want to 
change the audio driver - click Yes for this 
prompt

Set the Optimize for option to Minimum 
delay... for the best performance. If your 
session is large and you start getting audio 
drop-outs, come back here and choose the 
Maximum... option

http://line6.com/support/knowledgebase/toneporthelp/
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Configuring an Audio Track for Recording 

Now that your Line 6 hardware is set up, you are ready to start working in a new project! 

Open or create a new GarageBand song project and make the following settings…

Adjust the Recording Level slider to around 75% - this will affect the amplitude of the signal 
being fed into the GarageBand Track, but it is best to keep it at this moderate setting and use your 
Line 6 hardware and/or GearBox Send controls to  adjust your level

Keep the Automatic Level Control unchecked

Select New Track from the GarageBand 
Track menu

Select Real Instrument

Choose Basic Track

For the Input Source, you’ll see all the available 
Mono and Stereo Inputs for your Line 6 device 
- choose the one you want to record from.

Leave Monitor set to off *

 * Optionally, if you are using the GearBox Plug-In, you can load the Plug-In on your GarageBand audio 
track and turn Monitoring “ON” to monitor your input signal through the software, and thus through the 
GearBox Plug-in processing. See the Using the GearBox Plug-In chapter for more info.

About Input Source Options...
In the GarageBand Input Source menu, you will see slightly different options depending on your 
specific Line 6 device:

TonePort GX, D.I. UX1, UX2 and KB37: You’ll see options similar to this...

The individual Mono 1 thru 4 options will receive input from the respective GearBox Send 1 •
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thru 4, and will record a mono file.

The Stereo 1/2 and Stereo 3/4 options will receive input from the respective GearBox Send 1-2 
and 3-4, and will record a stereo file. 

TonePort UX8: You’ll see the following options:

The individual Mono 1 thru 8 options will receive input from the respective TonePort UX8 
Send 1 - 8, and will record a mono file.

The individual Mono 9 thru 12 options will receive input from the respective GearBox Send 9 
thru 12, and will record a mono file.

The Stereo 1/2 thru Stereo 7/8 options will receive input from TonePort UX8’s respective Send 
1-2 thru Send 7-8, and will record a stereo file. 

The Stereo 9/10 and Stereo 11/12 will receive input from the respective GearBox Send 9-10 and 
Send 11-12 and will record a stereo file.

 TonePort UX8’s driver offers multiple Inputs and Sends with many flexible options for routing and 
monitoring GearBox Tones. Please reference the Mac Driver Settings section of the Audio Driver and 
GearBox Settings chapter for more info. 

POD X3 devices: You’ll see the following options:

The individual Mono 1 thru 8 options will receive input from the respective POD X3 Send 1 
thru 8, and will record a mono file.

The Stereo 1/2 thru Stereo 7/8 options will receive input from the respective POD X3 Send 1-2 
thru 7-8, and will record a stereo file.

 

•

•

•

•

•

•

•
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POD X3 offers several onboard options for the type of signal that is assigned to each Send. Look in the 
Line 6 Audio-MIDI Settings dialog’s Inputs screen to see the current POD X3 Send descriptions.  For 
more info about POD X3 Sends,  please reference the Mac Driver Settings section of the Audio Driver 
and GearBox Settings chapter, and your POD X3 Pilot’s Handbook.

PODxt devices: You’ll see the following options:

The individual Mono 1 and 2 options will receive input from the respective PODxt Send 1 and 
2 (or GearBox Sends 1 and 2 if GearBox is in use), and will record a mono file.

The Stereo 1/2 will receive input from the respective PODxt Send 1-2 (or GearBox Send 1-2 if 
GearBox is in use) and will record a stereo file.

Turn off any Track effects...

GarageBand offers a number of optional track effects, and some are typically on by default on a new 
Audio Track. You probably want to toggle them off if you prefer to use just the effects of GearBox or 
your POD device (or if you are using the GearBox Plug-In). To get to the track effects, click on the 
Details twirl-down arrow:

The “built-in” track effects can be enabled/
disabled via the checkboxes. 

To load your own Audio Units Plug-In 
(such as the optional GearBox Plug-In) 
access one of the effect slot menus

Arm your track...

Note that the track meters measure the device/
GearBox input signal once the track is armed

Click here and type in name for your 
track

Press the Arm button to prepare your 
track for recording

•

•
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Click on the transport Record button and start recording!



Apple Logic Pro 8 - Mac

4•12

apple logic® pro 8 setup
For this document, we’ll show how to configure Apple Logic® Pro 8 to work with Line 6 TonePort, 
GuitarPort, POD X3 or PODxt as the USB audio device on a Mac® OS X® 10.4 (Tiger) system.  The 
steps are very similar for the setup of Apple Logic® 8 Express, as well as other recent Logic versions. 

 Note that the features of Line 6 hardware models differ slightly, so we’ll call out where specific instructions 
apply per device type. If you are using a POD X3 device, it is not yet supported as of GearBox version 3.5 
- please check the Line 6 GearBox Online Help site for the latest news and developments.

Configure Your Mac® to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Mac System Preferences and select the 
Line 6 Audio-MIDI Devices dialog to access the Audio Driver settings. If needed, please reference 
the Mac Driver Settings section of the Audio Driver and GearBox Settings chapter. 

Configuring Logic Pro to Use the Line 6 Core Audio Driver

Launch the Logic Pro application. If a project opens, go to Logic’s File menu and select Close Project 
to exit it. 

Open the Logic Preferences...

Go to the Logic Pro menu and 
choose Audio...

Check the Enable box

Select your Line 6 device 

Set the I/O Buffer Size to 256. 
If you encounter audio drop-outs 
in your Logic Pro Projects, come 
back here and raise this to a slightly 
higher value

Check the box for 24 Bit Recording

Click Apply Changes when done

Click on the Core Audio tab 

http://line6.com/support/knowledgebase/toneporthelp/
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Create & Configure a New Project

Go to the File menu and select New...

In the New... dialog, choose 
Empty Project

Typically, Logic will immediately prompt you with the New Track dialog, where you can create one or 
more audio tracks, and designate the track’s input and output. 

Type in the number of tracks and type to be created 
- we’ll just add one audio track...

Choose Mono or Stereo for the track Format

For the Input options, you’ll be able to select either 
an individual mono input or stereo input, depending 
on your Format selection*

The Audio tracks’ Output Routing should default 
to your Line 6 device’s Output 1-2 (see below 
regarding TonePort UX8’s Output options)

Keep Input Monitoring and Record Enable 
unchecked    

*When the Mono Format is chosen, you’ll see one mono Input option for each Send channel that 
your Line 6 device offers. Likewise, if the Stereo Format is chosen, you’ll see one stereo Input option 
for each Stereo Send your hardware offers. Since we’re using a TonePort UX2, the track Input options 
appear like this...

             

Stereo Inputs

Mono Inputs    
You’ll have a different number of track Input and Output options available depending on your specific 
Line 6 device:

TonePort & GuitarPort devices (except TonePort UX8): You will see 4 Mono Inputs and 2 Stereo 
Inputs, as pictured above.

TonePort UX8: You’ll see 12 Mono inputs and 6 Stereo inputs.

 TonePort UX8’s driver offers multiple Inputs and Sends with many flexible options for routing and 
monitoring GearBox Tones. Please reference the Mac Driver Settings section of the Audio Driver and 
GearBox Settings chapter for more details
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POD X3 devices: You’ll see 8 Mono inputs and 4 Stereo inputs.

 
POD X3 offers several onboard options for the type of signal that is assigned to each Send. Look in the 
Line 6 Audio-MIDI Settings dialog’s Inputs screen to see the current POD X3 Send descriptions.  For 
more info about POD X3 Sends,  please reference the Mac Driver Settings section of the Audio Driver 
and GearBox Settings chapter, and your POD X3 Pilot’s Handbook.

PODxt devices: You’ll see 2 Mono inputs and 1 Stereo input.

Next, we need to select a sample rate for our Project...

Select the Project Settings > Audio dialog 
from the File menu 

44,100 Hz is a good choice for your Sample 
Rate, or you can choose 48,000, 88,200 
or 96,000 Hz if your project specifically 
requires one of these higher rates

Now that the Project is all configured, it’s a good time to Save It! Go to File > Save and  type in a name 
and choose a directory to Save to.
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Configuring an Audio Track for Recording 

A few more quick settings to cover for the audio track...  

Set Input Monitoring Options and Get Armed and Ready...
When recording using GearBox, it is recommended to use its ToneDirect Monitoring™ feature, 
where your input monitoring signal is passed directly back out of your Line 6 hardware’s output. This 
allows you to hear the GearBox tone you have selected for your Mic or Instrument with the lowest 
possible latency. Likewise with POD X3 and PODxt, these devices offer a super low latency USB audio 
monitoring. Therefore, we will disable the Cubase “Monitor” option on our Audio track so that the 
input monitor signal is not additionally fed through the software*.

Keep the audio track’s Input Monitor button 
set to OFF*

Click the Record Ready button to ON

Note that once the track is in Record Ready 
mode, you’ll be able to see the input signal 
in both the track header or to the left in the 
“Inspector”. You can use this to reference 
your record levels coming from your Line 6 
device/GearBox

 
* Optionally, if you are using the GearBox Plug-In, you can load the Plug-In on your  audio track and turn 
the Input Monitor button ”ON” to monitor your input signal through the software, and thus through the 
GearBox Plug-in processing. Please see the Logic Pro Help documentation for Input Monitoring options. 
See the Using the GearBox Plug-In chapter for a detailed guide on configuring the Gearbox Plug-In! 
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Be sure to set your record levels before you start recording...

If you are using GearBox with your Line 6 
hardware, you can adjust your recording level in 
using the assigned Send’s Record knob within the 
GearBox window. Note that your Amp and Tone 
Volume knobs in GearBox and on POD devices 
will also affect the recording level into Cubase

Start Recording!

Once your record level is set, click on the transport Record button and start riffing!
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digidesign® pro tools® le™ 7 setup 
Digidesign® has designed Pro Tools™ software so it can only be used with a Digidesign® or M-Audio® 

audio interface; you cannot use your Line 6 hardware as the primary audio interface for a Pro Tools 
system. But you can still enjoy the benefits of your Line 6 USB device and legendary tones by connecting  
to the Digidesign interface’s inputs. TonePort UX2, UX8, KB37, POD X3 and PODxt PRO even let 
you do this with a direct, digital connection.

For this document, we’ll be showing how to connect to the Digidesign® Mbox® 2 unit with Pro Tools 
LE™ 7.3.1, but these steps are similar for connecting to the Digi 002® or other Digidesign and M-
Audio hardware as well. There are two methods described here – Recording from a Line 6 USB device’s 
analog outputs or digital S/PDIF outputs.

 Note that it is not necessary to have both your Line 6 hardware and Digidesign hardware connected to the 
same computer. You can alternatively have your Line 6 and Digidesign hardware on separate computers 
since the two devices are indeed operating individually!

Recording from Your Line 6 Hardware’s Analog Outputs 

In this setup example, we’ll show how to connect a TonePort UX2 to a Digidesign Mbox 2 unit, but it 
is of course possible to record from the analog output of any Line 6 device in much the same way. We 
will call out where different steps might be necessary for other Line 6 hardware. 

 

Note that if you are using a POD X3 or PODxt device it is not necessary to connect your POD to a 
computer via USB at all for this type of analog connection. GearBox is not necessary for any POD, PODxt 
or POD X3 unit since Tones can be by called up, edited and output levels configured completely on your 
POD device! However, if you want to use GearBox with any PODxt family device, you certainly can if you 
connect to the USB port of a computer - as mentioned above, it does not necessarily have to be the same 
computer that Pro Tools is running on.

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed 
with the following steps…

Connect the Analog Outputs* from your Line 6 hardware to the Digidesign Mbox 2:

Using two ¼” to ¼” shielded TS 
or TRS audio cables, plug each into 
the Analog Outs of your device

Connect a USB cable to your  
device & computer’s USB port

 
*Note - If you are using a GuitarPort device the Analog Outs are the RCA style jacks labelled “L” and 
“R”. If using a TonePort UX8, you should connect to the “Out 1” and “Out 2” jacks on the back.
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Plug the other end of the left audio cable into the Mbox Input 1 input, and the right audio cable into 
the Mbox Source 2 input.

From your Line 6 device’s Left Analog Out 
(or “Out 1”), connect to the Mbox 2 Input 
1 - Line input

From your Line 6 device’s Right Analog 
Out (or “Out 2”), connect to the Mbox 2 
Input 2 - Line input

Connect a USB cable to your 
Mbox 2 & computer’s USB port

You will still use the Mbox 2 Mon Outputs (or Headphone Output) to hear playback of all Pro Tools 
LE audio. The Line 6 Hardware/GearBox audio will be mixed with the Pro Tools LE audio as well. 
Therefore, if you are using headphones, you’ll want to plug them into the Mbox 2 headphone jack to 
hear everything:

From the Mbox Mon Out jacks, connect to the 
Left and Right inputs for your powered speakers 
or monitoring system

If you want to use headphones for 
monitoring, plug them in to the 
Mbox 2 Headphone Out

Next, before you launch Pro Tools LE, make sure that your Mac is configured properly for your Line 
6 hardware.  This configuration is slightly different depending on which specific Line 6 hardware you 
are using:

TonePort, GuitarPort and PODxt Devices

Since you will be using GearBox along with your device, you’ll want to consult the GearBox Help PDF 
that is installed with GearBox - just launch GearBox and select Open Help from the Help menu. In 
the GearBox Help document, please reference the Driver Panel & Recording chapter and the details 
for your specific Line 6 device. (For more info about POD X3’s driver & Sends, please see the earlier 
Audio Driver & GearBox Settings chapter.)
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POD X3 Devices
Please check the POD X3 Pilot’s Handbook that came in the box with your POD X3. Or, you can 
download this Handbook in PDF form from the Line 6 User Manual downloads page.  In particular, 
the Reference: Configuration & Setup chapter covers the options for choosing your inputs (Mic, 
Line, Instrument, or multiple input sources) as well as things such as a Tone Blend versus Tone Pair 
tone setting, panning tones and effects, etc. Basically, this is the point where you’ll want to have your 
instrument or mic plugged into POD X3 and have your tone sounding the way you want it be recorded. 
You’ll also want to be sure the panning and levels of the tones and effects feeding to the POD X3 Left 
and Right analog outs are the way you want each to be recorded into your Pro Tools track(s). (For 
more info about POD X3’s driver & Sends, please see the earlier Audio Driver & GearBox Settings 
chapter.)

Creating a New Pro Tools LE Session
Once you have your Line 6 hardware and GearBox configured (if using GearBox), then the next step 
is to launch Pro Tools LE and set up a Session for recording...

To start a new Session in Pro Tools LE, 
choose New Session from the File menu

http://line6.com/support/manuals/
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Type in a title for the 
Session and choose where 
to save it

Choose the Sample Rate 
and Bit Depth - 44.1 kHz 
and 24 Bit are good 
choices unless you have 
specific needs for your 
project

File Type - BWF (.WAV) 
is a good choice here since 
this file type is compatible 
with both Mac and Win-
dows

For I/O Settings, Stereo 
Mix is best

Create and Configure a New Audio Track
Next you’ll need to create at east one new audio track in the session to record into. You can of course 
also create more audio tracks if you want to import existing audio files into this session...

In the Track menu, select New...

Choose how many
Tracks to create 

Choose Mono or Stereo* for 
your audio track format

Choose Audio Track for 
the Track type

Choose Samples 

...Then click Create 

*You’ll need to decide before creating your recording track here if you want to record the output from 
your Line 6 hardware/GearBox as Mono or Stereo.  Mono will of course only record one of your Line 
6 device’s (Left or Right) outputs, and you’ll choose which once the track is created. If you have stereo 
effects active on your GearBox or POD tone, then you’ll probably want to choose Stereo to record 
both channels into a stereo track. 
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On the new audio track, click on the Input Selector and 
choose the Mbox Interface input source. Since we created 
a Stereo track here, we’ll select the In 1-2 (Stereo) to 
record from the Mbox Mic/Line (analog) inputs

At the top left of the Edit Window, click the 
View selector and enable the I/O View

Or… if you created a mono audio track, you’ll have the option for the track input to choose either In 
1 (Mono) to capture the LEFT signal, or In 2 (Mono) to capture the RIGHT signal:

Click the R button to arm the audio track 
for recording 

The track meters will now measure the 
Line 6 Device/GearBox signal level 

Click the M button to 
mute the track while 
recording*

*Muting the track during recording disables the Pro Tools LE software monitoring feature, which 
allows your Line 6 Hardware/GearBox analog input signal to be monitored with the lowest latency 
possible. Adjust the Mbox MIX knob to balance the session audio playback with the input audio (see 
your Mbox documentation for details). Once you are done recording, un-mute the track so you can 
hear playback.

Note to Digi 002 users… when using the Digi 002 hardware with Pro Tools LE, an additional Low Latency 
Monitoring option is available within Pro Tools LE Operations menu. You can alternatively keep your 
track un-muted and activate this option to hear your input monitoring signal when recording (see your Digi 
002/Pro Tools LE documentation for more on this feature).
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Set your Recording Levels - As shown above, once your audio track is armed, you can use the track’s  
meters to gauge your recording levels. Note that the levels coming into the track are affected by a few 
different controls. If you are using GearBox, then the output level is affected by the Tone volume as well 
as the main Monitor volume. Also, the main Output or Master Volume knob on your Line 6 hardware 
unit affects the signal level going out the Analog Outs. Finally, the Mbox unit includes level knobs 
for Inputs 1 & 2 to adjust the incoming signal level. The best practice is to set all of these controls to 
roughly half way to start, and then adjust each of them slightly to acheive the optimum level. You want 
to avoid setting any one control very high or very low to avoid excess noise or degrading the signal 
quality. 

Be sure the input switches are set so that the green 
Mic light is illumintated for both Inputs 1 & 2 (since 
we’re plugging into these Mic/Line inputs) 

Use the Input 1 & 2 knobs to adjust 
the recording levels

Keep both the Mono and 48V 
(phantom power) switches off 

Start Recording...

Click the transport Record button to place Pro 
Tools LE into record mode, then press the Play 
button to start recording! 
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Recording from Your Line 6 Hardware’s S/PDIF Outputs

TonePort UX2, UX8, POD X3 and PODxt Live units all include S/PDIF outputs, therefore you can 
optionally connect these outputs to your Digidesgn or M-Audio hardware to record digitally into 
Pro Tools or Pro Tools LE! In this setup example, we’ll show how to connect a TonePort UX2 to a 
Digidesign Mbox 2 unit, and will call out where different steps might be necessary for the other Line 
6 devices. 

For more information regarding using your Line 6 device’s S/PDIF connections, please also see the 
earlier section titled S/PDIF Digital Output from Line 6 Hardware to an External Device. The Pilot’s 
Handbook that came with your Line 6 device includes more useful information as well. 

Connect Your Hardware...

Using a 75-Ohm, coaxial S/PDIF cable, plug 
one end into the S/PDIF Digital Out of 
your Line 6 device

Plug the other end of the S/PDIF 
cable into the Mbox S/PDIF In 

From the Mbox Mon Out jacks, connect 
to the Left and Right inputs for your 
powered speakers or monitoring system

If you want to use headphones for 
monitoring, plug them in to the 
Mbox 2 Headphone Out 
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You will still use the Mbox Monitor Outputs (or Headphone Output) to hear playback of all Pro Tools 
LE audio. The Line 6 Hardware/GearBox audio will be mixed with the Pro Tools LE audio if you use 
the Pro Tools software monitoring function. See the later section regarding monitoring for more on 
this.

TonePort UX2, UX8 & KB37 Configuration
When connecting two hardware devices digitally, it is necessary that both units are set to operate at the 
same sample rate. For TonePort devices, this is configured in the Mac Audio-MIDI Setup dialog. To get 
to this dialog, launch your Mac System Preferences and choose the Line 6 Audio-MIDI Device item 
in the “Other” category. In the Driver page, click the Run Audio MIDI Setup buttton:

Choose your TonePort 
Device...

Then set the preferred  
sample rate for the 
Format. Mbox 2 
supports 44100 or 
48000 Hz - we’ll use 
44100 Hz for this 
example 
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POD X3 S/PDIF Configuration

Connect the S/PDIF Out on the rear panel of your 
POD X3 device to the S/PDIF Input on the Mbox

POD X3                                                                                             POD X3 Live

The S/PDIF Out sends out 24-bit digital versions of the Left & Right Outputs. Press the OUTPUTS 
button to access additional S/PDIF options:

For S/PDIF, you likely want 
the MATCH STUDIO/
DIRECT option* 

For the S/P SR options, set 
the sample rate to the same 
as your Pro Tools Session 
(44.1 kHz is a good option) 

Use the S/PLVL if you need 
to slightly raise or lower 
the S/PDIF signal level for 
optimum recording levels

*This S/PDIF setting defines what type of audio is sent out the S/PDIF Out. These options are:

Match Studio/Direct – S/PDIF outputs the Tone and Pan settings as shown.

Studio/Direct Tone 1 – S/PDIF outputs Tone 1 only, panned center.

Studio/Direct Tone 2 – S/PDIF outputs Tone 2 only, panned center.

Dry Inputs – S/PDIF Left outpus the unprocessed input(s) to Tone 1, and S/PDIF right outputs 
the unprocessed input(s) to Tone 2.

•

•

•

•
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PODxt Pro - Digital Output Configuration

Connect the S/PDIF Out on the 
rear panel of your device to the 
S/PDIF Input on the Mbox

Press the Tune/System button and turn the Select knob clockwise until the display reads, What are 
you connecting to?

Set the DIGOUT option to 
SPDIF

Set the DEST option to 
STUDIO DIRECT 

Press the I/O & Dig Select button once to access the Digital Out page:

For the FORMAT options, set 
the sample rate to the same as 
your Pro Tools Session (44.1 
kHz is a good option) and 24 
BIT

Set the MODE to NORMAL for  
your fully processed tone to be sent 
out the S/PDIF connection (or 
to DRYGTR for an unprocessed 
signal) 

Use the GAIN if you need 
to slightly raise or lower 
the S/PDIF signal level for 
optimum recording levels

Configure Mbox 2/Pro Tools LE for Digital Recording

Now, launch the Pro Tools LE application and set it up to receive the S/PDIF Digital Input as 
follows:

From the Pro Tools LE Setup menu, 
select Hardware...
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Choose S/PDIF as the 
Clock Source so that 
the Mbox 2 follows the 
digital clock of your Line 6 
hardware

Click OK when done

You will now see the S/PDIF light solidly 
illuminated on the front of the Mbox 2, 
indicating it is in S/PDIF digital input mode

Note that when receiving S/PDIF input, the Input 1 & 2 level knobs on the front of the Mbox 2 do not 
adjust the digital signal level. To adjust the recording level, use the GearBox software’s Tone volume and 
output level controls or your POD’s S/PDIF Gain control.

Creating a New Pro Tools LE Session
Once you have your Line 6 hardware and GearBox configured (if using GearBox), then the next step 
is to launch Pro Tools LE and set up a Session for recording...

To start a new Session in Pro Tools LE, 
choose New Session from the File menu
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Type in a title for the 
Session and choose where 
to save it

Choose the Sample Rate 
and Bit Depth - 44.1 kHz 
and 24 Bit are good 
choices unless you have 
specific needs for your 
project

File Type - BWF (.WAV) 
is a good choice here since 
this file type is compatible 
with both Mac and Win-
dows

For I/O Settings, Stereo 
Mix is best

Note: If you prefer to use the 48 kHz Sample Rate, then you can choose these here in the Pro Tools dialog, 
but you will need to also go back to the Mac Audio-MIDI Setup dialog (or to your POD X3 or PODxt 
S/PDIF settings) and set the sample rate value for your Line 6 hardware to match. Matching sample rates 
are required on both hardware units with a digital connection.

Create and Configure a New Audio Track
Next you’ll need to create at east one new audio track in the session to record into. You can of course 
also create more audio tracks if you want to import existing audio files into this session...

In the Track menu, select New...

Choose how many
Tracks to create 

Choose Mono or Stereo* for 
your audio track format

Choose Audio Track for 
the Track type

Choose Samples 

...Then click Create 

*You’ll need to decide before creating your recording track here if you want to record the output from 
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your Line 6 hardware/GearBox as Mono or Stereo.  Mono will of course only record one of your Line 
6 device’s (Left or Right) outputs, and you’ll choose which once the track is created. If you have stereo 
effects active on your GearBox or POD tone, then you’ll probably want to choose Stereo to record 
both channels into a stereo track. 

On the new audio track, click on the Input Selector and 
choose the Mbox input source. Since we created a Stereo 
track here, we’ll select the S/PDIF In L-R (Stereo)

At the top left of the Edit Window, click the 
View selector and enable the I/O View

Or… if you create a mono audio track, you’ll 
have the option for the track input to choose 
either S/PDIF L (Mono) to capture the LEFT 
signal, or S/PDIF R (Mono) to capture the 
RIGHT signal

Click the R button for to Arm the 
track for recording 

Once armed, the track’s meters 
will measure the Line 6 device/
GearBox S/PDIF signal level 

Keep the track’s Mute button 
set to un-muted to monitor your 
TonePort/GearBox signal*

*When receiving a S/PDIF input, the Mbox 2 will only allow the signal to be monitored through the Pro 
Tools LE software. With the audio track armed and not muted, the track’s volume control will adjust 
the monitor signal coming from your Hardware/Gearbox, allowing you to balance your listening levels 
independently of your recording level. The Pro Tools LE software monitoring is also subject to latency, 
which is affected by your Pro Tools LE Hardware Buffer settings (see your Mbox documentation for more 
information regarding latency and monitoring).

Note to Digi 002 users… when using the Digi 002 hardware with Pro Tools LE, an additional Low 
Latency Monitoring option is available in the Pro Tools LE Operations menu. It is best to activate this 
option to hear your input monitoring signal with the lowest latency when recording (see your Digi 
002/Pro Tools LE documentation for more about this feature).
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Adjusting the Pro Tools LE Hardware Buffers

Go to the Pro Tools LE Setup menu 
and choose Playback Engine... 

The lower the H/W Buffer Size value that is selected, the lower the 
latency. However, lower values can also result in less stability for session 
playback and recording. 256 Samples is a good starting value to try.

TIP: Alternative Mbox monitoring option… If monitoring your Line 6 Hardware recording signal through 
the Pro Tools LE software results in excessive latency, you can alternatively connect you device’s Analog 
Outs to an external Mixing Console and manually mix the device signal with the output of your Mbox. This 
allows you to hear the Line 6 device signal with no added latency from Pro Tools LE. In this configuration, 
you should Mute your Pro Tools LE track while recording to silence its software monitoring signal.

Start Recording…

Click the transport Record 
button to place Pro Tools 
LE into record mode, then 
press the Play button to 
start recording! 
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GearBox RTAS Plug-in

The GearBox Plug-in is really a great tool for Pro Tools and Pro Tools LE users! Like any RTAS Plug-
In, it can be added on any track insert, allowing you to non-destructively apply entire GearBox Tones 
on any of your Pro Tools sessions. The GearBox Plug-In is available as an Add-On purchase to your 
Line 6 hardware (or, already comes included if you own a TonePort D.I. or UX8), and works with Mac 
or Windows. You can grab it now without even getting out of your chair! Just run Line 6 Monkey with 
your Line 6 USB device connected and go to the Optional Add-Ons tab. Or, you can read all about 
it here:

Line 6 GearBox Plug-In

We’ve included a complete setup section on using the RTAS GearBox Plug-In specifically with Pro 
Tools LE 7 within the GearBox Plug-In chapter. 

http://www.line6.com/gearbox_plugin/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=AddOns+GearBoxPlugIn+DropDown
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Motu digital perforMer® 5 setup
For this document, we’ll show how to configure Mark of the Unicorn Digital Performer® version 5.11 
to work with Line 6 TonePort, GuitarPort, POD X3 or PODxt as the USB audio device. The steps are 
very similar for the setup of other earlier Digital Performer versions as well.  

 Note that the features of Line 6 hardware models differ slightly, so we’ll call out where specific instructions 
apply per device type. If you are using a POD X3 device, it is not yet supported as of GearBox version 3.5 
- please check the Line 6 GearBox Online Help site for the latest news and developments.

Configure Your Mac® to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Mac System Preferences and select the 
Line 6 Audio-MIDI Devices dialog to access the Audio Driver settings. If needed, please reference 
the Mac Driver Settings section of the Audio Driver and GearBox Settings chapter. 

Configuring Digital Performer to Use the Line 6 Core Audio Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps...

Launch Digital Performer and click on the Setup menu:

First, go to the Digital Performer Setup > 
Audio System menu and select MOTU 
Audio System so that it is active

http://line6.com/support/knowledgebase/toneporthelp/
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Next, choose Configure Audio System > Configure Hardware Driver from the Setup menu...

Select CoreAudio as your driver type

Choose your Line 6 hardware

Choose 44100 as the Sample Rate - 
alternatively 48000, 88200 or 96000 can also 
be used if your project requires it 

A Buffer Size of 256 and Multiplier of 1 are 
good settings to start with*

Set Work Priority to High for snappy 
performance

Click OK to exit

Choose Configure Audio System > Sample Format from the Setup menu

Select 24 Bit as the Sample Format
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Configuring an Audio Track for Recording 

Now that your Line 6 hardware is set up, you are ready to start working in a DP Project! 

Create a New DP Project (or open an existing one) and create a new audio track to record into. You 
can choose to add either a Mono or Stereo audio track to your current Project. This track type also 
determines which Line 6 device’s Record Sends become available to choose from as the track’s input 
(Mono or Stereo). 

Selecting Track Input and Output Devices

Once your Audio Track is created, you can select your track Input and Output device for Recording 
and Playback specifically for this track. (Note that the following screenshots show DP’s “Sequence” 
view layout - this makes it easy to see your track settings at the left of the work area). We’ve created a 
Stereo track in our example here. 

Note that when you first set up your Project with your audio hardware, you’ll need to select one or 
more New Stereo Bundles (or Mono Bundles if your track is Mono) to make them available as 
selectable track inputs. To do this, open the Track Menu for your audio track and select Input > New 
Stereo Bundle. You will see a list of all available items that can be assigned. Your Line 6 stereo inputs 
should appear at the top of this list, as shown here for a TonePort UX2:

Click the Track Menu button 
for your audio track Line 6 device stereo input options

Select each Line 6 hardware input that you’ll potentially want to record from for your Project to create 
each as a “Stereo Bundle” input. Once you do, you’ll then see them as selectable in the track Input 
menu and you can choose the one you want here for all future audio tracks. 
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New Stereo Bundles created now appear 
here in the Input menu. We’ve selected 
TonePort Record Send 1-2 1-2 as this 
stereo audio track’s input

About Input Options for Your Device
In the Input > New Mono/Stereo Bundle menus for audio tracks in DP, you will see slightly different 
options depending on your specific Line 6 device...

TonePort GX, D.I. UX1, UX2 and KB37: You’ll see the following

The Stereo “Record Send 1-2 1-2” and “Record Send 3-4 3-4” options will receive input from the 
respective GearBox Send 1-2 and 3-4, and will record a stereo file (See above screenshots). 

The individual “Record Send 1-2 1” thru “Record Send 3-4 4”  options will receive input from 
the respective GearBox Send 1 thru 4, and will record a mono file.

TonePort UX8: You’ll see the following.

The Stereo “Send 1-2 1-2” thru “Send 7-8 7-8” options will receive input from TonePort UX8’s 
respective Send 1-2 thru Send 7-8, and will record a stereo file. 

The Stereo “Send 9-10” and “Send 11-12 11-12” options will receive input from the respective 
GearBox Send 9-10 and Send 11-12 and will record a stereo file.

The individual Mono “Send 1-2 1” thru “Send 7-8 8” options will receive input from the 
respective TonePort UX8 Send 1 - 8, and will record a mono file.

The individual Mono “Send 9-10 9” thru “Send 11-12 12” options will receive input from the 
respective GearBox Send 9 thru 12, and will record a mono file.

•

•

•

•

•

•
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 TonePort UX8’s driver offers multiple Inputs and Sends with many flexible options for routing and 
monitoring GearBox Tones. Please reference the Mac Driver Settings section of the Audio Driver and 
GearBox Settings chapter for more info. 

POD X3 devices: You’ll see the following options:

The Stereo “Send 1-2 1-2” thru “Send 7-8 7-8” options will receive input from the respective 
POD X3 Send 1-2 thru 7-8, and will record a stereo file.

The individual “Send 1-2 1” thru “Send 7-8 8” options will receive input from the respective 
POD X3 Send 1 thru 8, and will record a mono file.

 
POD X3 offers several onboard options for the type of signal that is assigned to each Send. Look in the 
Line 6 Audio-MIDI Settings dialog’s Inputs screen to see the current POD X3 Send descriptions.  For 
more info about POD X3 Sends,  please reference the Mac Driver Settings section of the Audio Driver 
and GearBox Settings chapter, and your POD X3 Pilot’s Handbook.

PODxt devices: You’ll see the following options:

The Stereo “Main In 1-2” will receive input from the respective PODxt Send 1-2 (or GearBox 
Send 1-2 if GearBox is in use) and will record a stereo file. 

The individual “Main In 1” and “Main In 2” options will receive input from the respective 
PODxt Send 1 and 2 (or GearBox Sends 1 and 2 if GearBox is in use), and will record a mono 
file.

Select a Track Output...

Choosing a track ouptut is much the same process as described above for the track input - you may 
need to first create the New Stereo/Mono Bundle for each Output you’ll want to be available for your 
audio tracks. In most cases, this will just be the “Main Out 1-2” for your Line 6 device. TonePort UX8 
offers multiple Output options and can be configured for many different monitoring or even multi-
channel Surround operation - please see your TonePort UX8 Pilot’s Handbook and GearBox Help 

•

•

•

•

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
http://line6.com/support/knowledgebase/toneporthelp/
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documentation for more about these advanced features. 

For our example, we’ll choose the Main Out 1-2 for our TonePort UX2 as the track Output for our 
stereo audio track:

Audio track output set to the TonePort 
Main Out 1-2

Set Input Monitoring Options...

When recording using GearBox, it is recommended to use the ToneDirect Monitoring feature, where 
your input monitoring signal is passed directly back out of your Line 6 hardware’s output. This allows 
you to hear the GearBox tone you have selected for your Mic or Instrument with the lowest possible 
latency. Likewise with POD X3 and PODxt, these devices offer a super low latency USB audio 
monitoring. Therefore, we will disable the Digital Performer Input Monitoring option so that the 
input monitor signal is not additionally fed through the software.

Input Monitoring On/Off button

 * Optionally, if you are using the GearBox Plug-In, you can load the Plug-In on your DP audio track and 
turn Monitoring “ON” to monitor your input signal through the software, and thus through the GearBox 
Plug-in processing. See the Using the GearBox Plug-In chapter for more info.

Arm Your Track & Set Your Levels...

Note that the track meters measure the device/
GearBox input signal once the track is armed

Press the Arm button to prepare your 
track for recording
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If you are using GearBox with your Line 6 
hardware, you can adjust your recording level in 
using the assigned Send’s Record knob within the 
GearBox window. Note that your Amp and Tone 
Volume knobs in GearBox and on POD devices 
will also affect the recording level into DP.

Start Recording!

Once your record level is set, just click on the Digital Performer transport 
Record button and start riffing!
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propellerhead reason® 4 setup
Propellerhead Software’s Reason® is an amazing virtual studio filled with synthesizers, drums and 
effects, all combined with a MIDI sequencer for easy pattern-based music creation. Reason does not 
offer a feature for recording audio; therefore, GearBox and Line 6 USB audio devices cannot be used 
for input directly into Reason. However, you do of course need a sound card device for playback, and 
your TonePort, GuitarPort, POD X3 or PODxt is a perfect high quality audio interface for this task! 

When using your Line 6 device, you can also simultaneously plug in your instruments and jam along 
with the playback of your Reason project. Or, utilize Reason’s ReWire technology to combine a Reason 
project with that of another ReWire-capable audio software host, and use your Line 6 device in this 
setup for playback and recording with the host software! For this document, we’ll be showing how to 
set up a Line 6 USB audio device with Propellerhead Reason ver. 4.0 - setup is similar with earlier 
Reason versions as well. 

 Note that the features of Line 6 hardware models differ slightly, so we’ll call out where specific instructions 
apply per device type. If you are using a POD X3 device, it is not yet supported as of GearBox version 3.5 
- please check the Line 6 GearBox Online Help site for the latest news and developments.

Configure Your Mac® to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Mac System Preferences and select 
the Line 6 Audio-MIDI Devices dialog to access the Audio Driver settings. Please reference the 
Mac Driver Settings section of the Audio Driver and GearBox Settings chapter for details on Driver 
settings for your specific Line 6 hardware. 

 

Configuring Reason to Use the Line 6 Core Audio Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps...

Launch the Reason’s Preferences dialog:

Select Preferences from the Reason menu

http://line6.com/support/knowledgebase/toneporthelp/


Propellerhead Reason 4 Setup - Mac

4•40

Select the Audio page

For Audio Output, choose your Line 
6 device

Choose a Sample Rate – 44100 is a 
good choice for most projects, but you 
can choose 4800, 88200, or 96000 
if your project requires one of these 
specific sample rates

Set the Buffer Size to 256 as a good 
starting point. If your Reason playback 
starts experiencing audio drop-outs, 
come back and raise the slider slightly

Close the Preferences dialog when 
done 

Now just hit the Play button in Reason’s transport and to hear the 
Reason playback through your Line 6 hardware!

To Jam Along with Reason…

You can also of course still use GearBox or configure your POD X3 for your Mic and Instrument tones 
while Reason is playing back if you want to sing or jam along. Just plug in your Mic or Instrument and 
use GearBox or your POD just as you normally do. Note that you can adjust the level of your Mic or 
Instrument independently of the level of the Reason playback.

If you are using GearBox, you can adjust the Monitor Volume and Out to Hardware controls 
within GearBox to balance out your Mic/Instrument volume versus the Reason playback:

The Monitor Volume, Pan and Mute controls act 
only upon your Mic/Instrument tone signal

The Out to Hardware Volume and Mute controls act on the combined 
Mic/Instrument + Reason output sent to your speakers or headphones
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Of course you can also the Master slider in the 
Reason Mixer to control Reason’s playback volume

If you are using POD X3, then you can adjust Tone Volume and Master Volume on the POD X3 
unit to balance out your Mic/Instrument volume versus the Reason playback:

The Tone Volume knob affects only your Mic/
Instrument Tone  level

The Master Volume knob controls the combined 
Mic/Instrument + Reason output sent to your speakers 
or headphones

With this configuration, both the Reason project playback and your Mic/Instrument GearBox/POD 
tones are heard through your speakers, and sent to all your device’s outputs. This also allows you to 
connect the Line 6 hardware’s outputs to an external device, such as a tape recorder, mixer, P.A. 
system, etc., to record or amplify this stereo output signal!

Using your Line 6 Hardware with Reason 3 in a ReWire Setup

The Propellerhead ReWire® technology allows the Reason modules’ outputs to be directly routed 
into any ReWire “Host” application. Using ReWire, the Host application can send MIDI tracks to 
Reason’s synth. modules, and Reason then sends audio playback directly into the ReWire Host, which 
is mixed with the audio of the Host application. When Reason is configured as a ReWire “Slave” in 
this manner, it is controlled by the Host application and does not utilize a sound card connection itself. 
Therefore, if you want to use your Line 6 hardware as your sound card device in a ReWire setup like 
this, it is necessary for you to choose your device as the assigned audio device within the ReWire Host 
application. To read more about the ReWire technology and the latest about ReWire Host support, 
please visit the Propellerheads web site. 

Using Reason with Ableton Live as a ReWire Host

The Ableton Live audio software is capable of functioning as a ReWire Host application. The following 
steps show you how to set TonePort as the audio device for the Ableton Live 7 software, and then 
configure Live to connect with Reason 4 as a ReWire Slave device. This enables you to do audio 
recording and playback with Ableton Live, allowing Reason’s output(s) to be automatically played 
in sync and channeled through Live’s audio tracks via ReWire. The setup process is similar in other 

http://www.propellerheads.se/
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ReWire Host applications as well (Steinberg Cubase®, Apple Logic®, etc.) and you can certainly use 
your Line 6 hardware with these other ReWire Host applications with Reason as well!

 Some Line 6 TonePort packages come with a special Ableton Live Lite, Line 6 version software included. 
This Live version also supports Propellerheads ReWire technology! Configuring the Live Lite Line 6 
version is much the same as the following steps for the Ableton Live 7 version.

You first want to be sure to exit Reason if it is currently running. The ReWire Host application must 
always be launched first. Launch Ableton Live and make the following settings to set your Line 6 
hardware as the Live audio device…

Launch the Ableton Live Preferences dialog:

Go to the Live menu and 
choose Preferences

Just as with most Multitrack recording software, in Live you also need to 
configure the individual inputs and outputs once a Multi-in/out device is 
selected. Click on the Input Config button to access the Inputs.

Go to the Audio tab

Choose CoreAudio as the driver type…

Then choose your Line 6 device for both 
the Input and Output Audio Device. In 
this example, we’ll choose our connected 
TonePort UX2

Set a Sample Rate – 44,100 is a good 
choice here, or you can use 48,000, 
88,200 or 96,000 Hz if your Project 
requires a higher sample rate

Activate Inputs:

Here you can “activate” all the inputs from your 
Line 6 hardware that you want to be accessible 
for any audio track as a track input for recording

Click OK when done

You’ll want at least the 1 (mono) & 2 (mono) and the 1/2 (stereo) inputs activated. Each additional 
activated input utilizes more CPU, so only activate the ones you need!

Note that you’ll see a different number of inputs listed in the Input Config dialog depending on 
the specific Line 6 device you are using. Typically these enumerated inputs correspond to the Line 6 
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device’s Sends of the same number (i.e. - Live’s input “3/4 (stereo)” is the TonePort UX2/GearBox 
Send 3-4).  

Activate Outputs:

To access the outputs, click the Output Config button back in the Live Preferences > Audio tab. This 
will show you all outputs available for your selected Line 6 Output Device. 

For all Line 6 devices (except TonePort UX8), the CoreAudio driver offers is only Output 1/2, 
therefore the dialog will show its two mono and 1 stereo output options, and they will automatically 
be selected. 

TonePort UX8: You’ll see 8 mono and 4 stereo outputs. For most Live projects, you likely only need 
to enable the Output 1/2 mono and stereo options and assign all track playback to one common 
output. UX8 does offer some very flexible monitoring and signal routing options using its additional 
outputs - please see the Mac Driver Settings section, as well as your TonePort UX8 Pilot’s Handbook 
for more information.

Note - The Ableton Live Lite 5, Line 6 version has a restriction that allows only one stereo output to be 
used at a time. To be able to choose two or more different output devices in a Live Set, you must switch 
into Demo mode, or upgrade to a full version of Ableton Live

Now that Ableton Live is configured to use your Line 6 device, launch Reason. Reason will automatically 
set itself to ReWire Slave Mode. You can check this mode in the Reason Preferences: 

Select the Audio settings

When Reason is in ReWire mode, the Audio 
Output will be non-selectable and this message 
appears 

Now in Ableton Live, you can simply access the Output menu of any MIDI track to route its MIDI to 
any of the Reason synth modules.

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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In any of Live’s MIDI tracks, choose 
Reason as the MIDI To output...

Then click on the Output Channel 
selector to choose any Reason module

To receive the audio output from Reason, set the Input of any of Live’s audio tracks to receive the 
audio from any of Reason’s outputs.

In one of Live’s Audio tracks, choose 
Reason as the Audio From input...

Then click on the Input Channel 
selector to choose any Reason output

(Note that the 1/2 Mix L, Mix R 
channel receives the full Reason project 
audio mix)

Now just hit the Play button in either Live or Reason, 
and both projects will play in sync, with all the audio 
being routed into Ableton Live and played through 
your Line 6 hardware!

You can utilize your Line 6 device/GearBox to also plug in a Mic or Instrument, dial in your tone, and 
record audio tracks right into the Ableton Live Set. This ReWire configuration is especially slick since 
the Reason audio can be treated as part of your Live Set - you can mix, add effects plug-ins (such as the 
GearBox Plug-In) on the incoming Reason audio track, and all will be incorporated into your audio 
mix-down when you do an Export from Live! It is important to note, however, that running all these 
programs at one time can require some hefty usage of your computers processor, RAM and disk access, 
especially as you add more tracks, Reason modules and real-time effects. Your actual performance will 
depend on the specifications of your computer.
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sonoMa Wire Works riffWorks® 2, line 
6 edition setup

For this document, we’ll show how to configure Sonoma Wire Works, RiffWorks® version 2.1 to work 
with Line 6 TonePort, GuitarPort, or PODxt. The steps are very similar for the setup of other earlier 
RiffWorks versions as well. The RiffWorks, Line 6 Edition is available as an Add-On that you can 
purchase from the Line 6 Online Store - just a click away! For RiffWorks full retail version and info, 
please visit the Sonoma Wire Works site.

 
Note that Line 6 TonePort UX8 and POD X3 family devices do not support the RiffWorks Line 6 Edition 
software. Please check the Line 6 GearBox Online Help site for the latest news and developments.

Configure Your Mac® to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Mac System Preferences and select the 
Line 6 Audio-MIDI Devices dialog to access the Audio Driver settings. If needed, please reference 
the Mac Driver Settings section of the Audio Driver and GearBox Settings chapter. 

Configuring RiffWorks to Use the Line 6 ASIO Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps...

Launch the RiffWorks Audio Setup Dialog:

In the bottom right area of the  RiffWorks 
main screen, select the Audio Setup button

Select your Line 6 device as the ASIO 
Device, if not automatically selected for you 
already

Set the Output Channel to Output 
1+Output 2 (the stereo Output 1-2 of your 
Line 6 hardware)

Set the Buffer Size to 256 frames as a 
starting value. If you experience audio drop-
outs in RiffWorks, then come back here and 
raise this to a slightly higher value

Press Done when settings are complete

http://www.line6.com/store/storefront.html?categoryID=1
http://www.sonomawireworks.com/
http://line6.com/support/knowledgebase/toneporthelp/
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Inputs Options for Recording

You can choose to record from any of your Line 6 Devices mono or stereo Sends into RiffWorks, which 
appear as “Inputs” within the RiffWorks input selector. These RiffWorks Inputs 1 thru 4 equate to the 
GearBox Sends 1 thru 4*. A mono Input will record a mono audio file, and a stereo Input will record a 
stereo file. These selections are made in the Input section of the RiffWorks main screen, at the bottom 
left. First toggle the “Stereo” button to switch between mono/stereo, and then click the menu beneath 
to select from the desired Line 6 device Input.

Click the Stereo button - when the light is on, this indicates 
Stereo input mode, when off, the input mode is Mono

You’ll then be offered Stereo or Mono input options in the menu 

 
*Note - if you are using a PODxt device, you’ll see only Inputs 1 + Input 2 for Stereo and Input 1 and 
Input 2 for Mono since PODxt offers only one stereo Record Send.   

Hardware Monitoring Options...

When recording using GearBox, it is recommended to use its ToneDirect Monitoring™ feature, where 
your input monitoring signal is passed directly back out of your Line 6 hardware’s output. This allows 
you to hear the GearBox tone you have selected for your Mic or Instrument with the lowest possible 
latency. In order to fully utilize ToneDirect Monitoring, you must turn on the RiffWorks Hardware 
Monitoring as shown below so that the input signal is not fed through the software. Keep in mind 
that you won’t hear any of RiffWorks’ plug-in effects if you monitor the input thru your Line 6 device. 
Please refer to your RiffWorks documentation for more info on its internal effects.

Click the Hardware Monitor button to 
“On” (the light is illuminated when on)

You see the following alert after enabling the Hardware Monitoring 
- read it’s message and click Yes to accept the setting
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Prepare Your RiffWorks Session...

Open a new RiffWorks Session, and follow these steps...

Enter a name for your riff here (Intro, 
Verse, Chorus, etc…)

Choose the Tempo

Choose the Length (in bars) of your riff

Choose the Time Signature of your riff

Choose whether your want the Lead In 
count to be the metronome, a drummer, or 
nothing at all

Before you click that record button, it’s a good idea to check your recording levels.

Go ahead and strum a few chords and you’ll see the meters 
measure your input recording level coming into the selected 
Inputs here in the RifWorks Input section at the bottom left 
of the main window

You can adjust your recording level in using the 
assigned Send’s Record knob within the GearBox 
window. Note that your Amp and Tone Volume 
knobs in GearBox and on POD devices will also 
affect the recording level into RiffWorks

Start Recording Your Riffs

Once your record level is set, click on the RiffWorks transport Record button 
and lay down your first Riff!
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The Riff you just recorded will appear in the Riff recorder window as “Take 001”. You 
can record several takes of the same riff, which will appear underneath this one

When ready to record another section of 
your song, click Create in the Riffs panel 

The newly created Riff will appear as riff2 in the Riff 
window. You can now record this Riff as described above 

Once you’ve laid down all your Riffs, it’s time to piece them all together in the Song panel…

Drag each Riff into the Song panel above in any order to build a song

And you’ve got a new song - it should look something like this...

RiffWorks 2, Line 6 Edition lets you import, export and manipulate your Riffs all kinds of ways. For 
more information, please refer to your RiffWorks Help documentation.
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steinberg cubase®/cubase® studio 4 
setup

For this document, we’ll show how to configure Steinberg Cubase® 4.02 to work with Line 6 TonePort, 
GuitarPort, POD X3 or PODxt as the USB audio device.  The steps are very similar for the setup of 
Steinberg Cubase® Studio 4 & Nuendo® 4, as well as previous Cubase® SE/SX/SL 3 and Nuendo® 
3 versions. 

 Note that the features of Line 6 hardware models differ slightly, so we’ll call out where specific instructions 
apply per device type. If you are using a POD X3 device, it is not yet supported as of GearBox version 3.5 
- please check the Line 6 GearBox Online Help site for the latest news and developments.

Configure Your Mac® to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Mac System Preferences and select the 
Line 6 Audio-MIDI Devices dialog to access the Audio Driver settings. If needed, please reference 
the Mac Driver Settings section of the Audio Driver and GearBox Settings chapter. 

Configuring Cubase to Use the Line 6 Audio Driver

Launch Cubase and Open the Device Setup Dialog:

Go to the Cubase Devices menu 
and choose Device Setup

Click on VST Audio System 

Select your Line 6 
device for the ASIO  
Driver 

Select 256 for your 
Audio Buffer Size. 
If you experience any 
audio drop-outs in 
your Cubase Project, 
you cna come back 
and set this to a  
slightly higher value

http://line6.com/support/knowledgebase/toneporthelp/
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If you are prompted to “switch the ASIO driver” after selecting 
your Line 6 device, go ahead and click on Switch

You can now exit the VST Connections dialog.

Establish Your Inputs and Outputs:
Next we need to configure the Inputs and Outputs from the Line 6 hardware so they can be accessed 
within your Cubase Projects. This can get a bit fiddly in Cubase, but you only need to do this once for 
your audio device, so hang in there!

Return the Cubase Devices menu 
and select VST Connections

Go to the Inputs tab...

Initially, you’ll see that one Stereo In “Bus” has already been created for you. You should see your Line 
6 device listed, and its Send 1 and 2 audio channels each assigned as the Left and Right channels for 
this initial Bus. TonePort and POD X3 devices offer more than just the one stereo Send 1-2, however, 



Steinberg Cubase 4 Setup - Mac

4•51

so for these devices you’ll want to create an additional stereo Bus for each Send. Also, you may want 
to create mono Buses for all the individual Send audio channels to allow you to record from any one 
of them as a mono input to a Cubase audio track. In our example we’re using a TonePort UX2, and 
just like TonePort GX, D.I., UX1, KB37 and GuitarPort devices, there is also a Send 3-4 available. 
TonePort UX8 offers 6 stereo Sends, and POD X3* offers 4 stereo Sends. 

 
*POD X3 offers several onboard options for the type of signal that is assigned to each Send. Look in the 
Line 6 Audio-MIDI Settings dialog’s Inputs screen to see the current POD X3 Send descriptions.  For 
more info about POD X3 Sends,  please reference the Mac Driver Settings section of the Audio Driver 
and GearBox Settings chapter, and your POD X3 Pilot’s Handbook.

You can follow these steps in this dialog to add additional Buses for all your device’s Sends...

Add Buses

Press the Add Bus button, create 1 Stereo Bus, then repeat and add 4 Mono 
Buses using the Add Input Bus dialog...

Next, each Bus channel needs to be correctly assigned to the desired hardware Send. The Stereo In 2 
Bus likely already assigned itself to the Line 6 device’s next stereo Send (Send 3-4 for our TonePort), 
which is what we want. But the Mono In Buses all defaulted to “Send 1”, which we need to edit. Click 
directly on the Device Port field for each of the Mono Buses and select a different Send channel for 
each. For our TonePort UX8, we’ll assign one each to Send 1, 2, 3, & 4 to give us a dedicated Mono 
input for each of our TonePort UX2’s 4 mono Send channels.

Click on the Device 
Port to choose 
the desired Line 6 
device Send channel 
assignment - do this 
for each Mono Bus
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The result should now look like this, 
with each Stereo In and Mono In 
Bus assigned to its own specific Line 6 
hardware Send.  

(Make a mistake? No worries, you can 
right click on any Bus Name and “Re-
move” it and add another if needed).

Now to the Outputs tab... the procedure is the same here. You should see a Stereo Out Bus already 
created here for you and correctly assigned to your Line 6 device’s main Output 1 & 2 for its Left and 
Right channels...

This one Stereo Out Bus is fine as is for most Cubase Projects, since you’ll likely just assign all audio 
tracks to this one, common stereo output. But you can optionally create Mono Buses for each of 
these Outputs if you need them. Or, if you have a TonePort UX8, your device includes 8 outputs 
which means you can do the Add Bus thing here and create Stereo and Mono Buses utilizing all the 
additional Outputs if you like - even for a 5.1 Surround system if needed! 

 TonePort UX8’s driver offers multiple Inputs and Sends with many flexible options for routing and 
monitoring GearBox Tones. Please reference the Windows Driver Settings section of the Audio Driver 
and GearBox Settings chapter for more details

Create a Preset...
Finally, it’s a good idea to now save all these settings as a Preset. You can even create several different 
Bus scenarios for your Line 6 hardware and save each as a different Preset to recall them easily any 
time!

Click the little Add button 

Then type in a name for your Preset 
and click OK to finish it up

You can now exit the VST Connec-
tions dialog
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TIP! Be sure to open the VST Connections window and select this Preset before you open or create a 
Cubase Project so that it will use this set of Inputs and Outputs! It’s also pretty handy to create a Project 
Template with a Cubase Project so that you don’t need to go through the repetitive task of creating a bunch 
of tracks and assigning them to the same Ins & Outs every time you start a new Project. See the Cubase 
documentation regarding creating a Project Template.

Open or Create a New Cubase Project...
Go to File > New Project to start a new Cubase Project. Once your Project is open, look at the bottom 
left of the Cubase screen to check its Sample Rate & Bit Depth. If these are not what you want, then 
you can go to the Project > Project Setup dialog. 

 

Look at the Cubase Project’s Sample Rate 
& Bit Depth here 

44,100 Hz is a good choice for your Sample 
Rate, or you can choose 48,000, 88,200 or 
96,000 Hz if your project specifically requires one 
of these higher rates

Choose 32 Bit as your Record Format
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Configuring an Audio Track for Recording 

Now that your Line 6 hardware and Cubase Buses are set up, you are ready to start working in your 
Cubase Project!  

Add a New Audio Track...

Select Your Audio Track’s Input and Output

Click on the Audio track’s Input Routing 
selector to choose the recording input. You’ll 
see all the Input Buses here that you created 
in the VST Connections - Input dialog. You 
can choose either a stereo or mono input*

The Audio tracks’ Output Routing should 
default to your Line 6 device’s Output 1
(Or, if you created additional Output Buses in 
the VST Connections dialog, you can choose 
the preferred one here)

*Note that for a stereo audio track, choosing a Stereo Input Bus will record a stereo file. Choosing a 
Mono Input Bus will record a mono file. If you create a mono audio track, then you can only choose 
a Mono Input Bus (or only one channel of your Stereo Bus) as the track input, and this will record a 
mono file. 

Set Input Monitoring Options...
When recording using GearBox, it is recommended to use its ToneDirect Monitoring™ feature, 
where your input monitoring signal is passed directly back out of your Line 6 hardware’s output. This 
allows you to hear the GearBox tone you have selected for your Mic or Instrument with the lowest 
possible latency. Likewise with POD X3 and PODxt, these devices offer a super low latency USB audio 
monitoring. Therefore, we will disable the Cubase “Monitor” option on our Audio track so that the 
input monitor signal is not additionally fed through the software*.

Keep the audio track’s Monitor button set to OFF
(You can access this and most other track controls on both the Track Header 
or to the left in the “Inspector”)
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 * Optionally, if you are using the GearBox Plug-In, you can load the Plug-In on your  audio track and turn 
the Cubase Monitor button ”ON” to monitor your input signal through the software, and thus through 
the GearBox Plug-in processing. Please see the Cubase Help documentation for Global and Track Input 
Monitoring options. See the Using the GearBox Plug-In chapter for a detailed guide on configuring the 
Gearbox Plug-In! 

Arm Your Track & Set Your Levels...

Click the Record Enable button “ON” 
to arm the audio track for recording*

*Note that the track meters in Cubase will not measure the input signal unless the Input Monitoring 
feature is on (which of course we just turned OFF in the last step). You can display the Cubase Mixer and 
the level meters there are active for inputs with the Monitor function on or off. 

If desired, launch the Mixer and you can view the 
meters for the respective Audio track to gauge your 
input levels before you start recording

If you are using GearBox with your Line 6 
hardware, you can adjust your recording level in 
using the assigned Send’s Record knob within the 
GearBox window. Note that your Amp and Tone 
Volume knobs in GearBox and on POD devices 
will also affect the recording level into Cubase
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Start Recording!

Once your record level is set, click on the transport Record button and start riffing!
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WindoWs® audio applications
The following chapters cover the setup of Line 6 GearBox software and TonePort, GuitarPort, POD 
X3 and PODxt devices with several popular Windows® audio recording applications. The examples 
used in these Setup chapters all utilize Windows® XP®, Service Pack 2.  

Note that GearBox version 3.5 and Line 6 audio device drivers can also be used with Windows® Vista®, and 
most setup instructions in the following chapters are very similar. For the latest news and developments on 
GearBox, audio drivers and Windows® Vista® support, please visit the GearBox Online Help site.

You can use the following links to jump to the chapter that covers your specific 
application...

Ableton Live®

Adobe® Audition®

Cakewalk SONAR®

Digidesign® Pro Tools® LE™

Image Line FL Studio® 

Propellerhead Reason®

Sonoma Wire Works RiffWorks®

Steinberg Cubase®

Mac® audio applications

http://line6.com/support/knowledgebase/toneporthelp/
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ableton liVe® 7 setup
For this document, we’ll show how to configure Ableton Live® version 7.01 to work with Line 6 
TonePort, GuitarPort, POD X3 or PODxt as the USB audio device.  The steps are very similar for the 
setup of other Live versions as well, including the Ableton Live Lite 5, Line 6 Edition version that 
comes included with some Line 6 TonePort packages.

 Note that the features of Line 6 hardware models differ slightly, so we’ll call out where specific instructions 
apply per device type. If you are using a POD X3 device, it is not yet supported as of GearBox version 3.5 
- please check the Line 6 GearBox Online Help site for the latest news and developments.

Configure Your Windows® PC to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Windows Control Panel and select the 
Line 6 Audio-MIDI Devices to access the Audio Driver settings. 

Go to the Driver tab

Set the ASIO Buffer Size to 
512 as a good starting point 
- or, you can try a lower value 
if your PC is snappy enough.

Set the Bit Depth to 24 bit

Please reference the Windows Driver Settings section of the Audio Driver and GearBox Settings 
chapter for details on Driver settings for your specific Line 6 hardware. 

Configure Live to Use the Line 6 ASIO Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps...

Launch the Ableton Live Preferences dialog:

Go to the Live Options 
menu and choose 
Preferences

http://line6.com/support/knowledgebase/toneporthelp/
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Make the following settings within the Preferences - Audio tab...

Just as with most Multitrack recording software, in Live 
you also need to configure the individual inputs and 
outputs once a Multi-in/out ASIO device is selected. 
Click on the Input Config button to access the Inputs.

Go to the Audio tab

Choose ASIO as the driver type…

Then choose your Line 6 device for the 
Audio Device. In this example, we’ll 
choose our connected TonePort UX2

Since we’re using the ASIO driver, the 
Buffer Size is adjusted in the Line 6 
Audio-MIDI Devices dialog - click the 
Hardware Setup button to launch it*

Set a Sample Rate – 44, 100 is a good 
choice here, or you can use 48,000, 
88,200 or 96,000 Hz if your Project 
requires a higher sample rate

*For more about ASIO Buffer settings, please reference the Windows Driver Settings section of the 
Audio Driver and GearBox Settings chapter.

Activate Inputs:

Here you can “activate” all the inputs from your 
Line 6 hardware that you want to be accessible 
for any audio track as a track input for recording

Click OK when done

You’ll want at least the 1 (mono) & 2 (mono) and the 1/2 (stereo) inputs activated. Each additional 
activated input utilizes more CPU, so only activate the ones you need!

Note that you’ll see a different number of inputs listed in the Input Config dialog depending on the 
specific Line 6 device you are using. Typically these enumerated ASIO inputs correspond to the Line 
6 device’s Sends of the same number (i.e. - Live’s input “3/4 (stereo)” is the TonePort UX2/GearBox 
Send 3-4).  More about this when we get to the part about setting up your audio track.

TonePort GX, D.I. UX1, UX2 and KB37: You will see 4 Mono inputs and 2 Stereo inputs, as 
pictured above.

TonePort UX8: You’ll see 12 Mono inputs and 6 Stereo inputs.

 TonePort UX8’s driver offers multiple Inputs and Sends with many flexible options for routing and 
monitoring GearBox Tones. Please reference the Windows Driver Settings section of the Audio Driver 
and GearBox Settings chapter for more details
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POD X3 devices: You’ll see 8 Mono inputs and 4 Stereo inputs.

 
POD X3 offers several onboard options for the type of signal that is assigned to each Send. Look in the 
Line 6 Audio-MIDI Settings dialog’s Inputs screen to see the current POD X3 Send descriptions.  For 
more info about POD X3 Sends,  please reference the Windows Driver Settings section of the Audio 
Driver and GearBox Settings chapter, and your POD X3 Pilot’s Handbook.

PODxt devices: You’ll see 2 Mono inputs and 1 Stereo input.

Activate Outputs:

To access the outputs, click the Output Config button back in the Live Preferences > Audio tab. This 
will show you all outputs available for your selected Line 6 Output Device. 

For all Line 6 devices (except TonePort UX8), the ASIO driver offers only Output 1/2, therefore the 
dialog will show its two mono and 1 stereo output options, and they will automatically be selected. 

TonePort UX8: You’ll see 8 mono and 4 stereo outputs. For most Live projects, you likely only need 
to enable the Output 1/2 mono and stereo options and assign all track playback to one common 
output. UX8 does offer some very flexible monitoring and signal routing options using its additional 
outputs - please see the Windows Driver Settings section, as well as your TonePort UX8 Pilot’s 
Handbook for more information.

Note - The Ableton Live Lite 5, Line 6 version has a restriction that allows only one stereo output to be 
used at a time. To be able to choose two or more different output devices in a Live Set, you must switch 
into Demo mode, or upgrade to a full version of Ableton Live

Configure Record Options...

Back to the Live Preferences dialog, now select the Record options.

Select the Record 
Warp Launch tab

For File Type you can 
select WAV

For Bit Depth, select 24 
Bit

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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Configure an Audio Track for Recording 

Now that your Line 6 hardware is set up, you are ready to start working in a Live Set!  Create a new 
Live Set (or open an existing one) and insert a new audio track to record into...

Choose Insert Audio Track from 
Live’s Insert menu

In the following example, we’ve inserted two audio tracks, assigned their outputs to the “Master” track, 
and assigned the Master Output to the stereo Main 1/2 output of our Line 6 device (TonePort UX2). 
For Audio track inputs, note that you can select from the mono or stereo ASIO inputs of your Line 
6 device, which you “activated” in the previous steps. If you choose a stereo input, a stereo audio file 
will be recorded into the track, and likewise, if you choose a singular mono input, a mono file will be 
recorded.

Choose the Arrangement 
View

(Alternatively, you can ac-
cess all these same settings 
in the Session View if you 
prefer)

Click the I-O toggle but-
ton to display the Input/
Output settings for the 
tracks

To configure your Audio 
tracks...

Choose Ext. In for the Input 
Type

Then choose the stereo or 
mono input you want to 
record from

Set your Audio tracks’ Output 
to Master

Note that here we’ve chosen 
to record from TonePort’s 
Send 1-2 for track 1, and Send 
1 for track 2

On the Master track, choose the 
stereo Out 1/2 of your Line 6 device 
for both the Cue Out and Master 
Out*

* Note that the Master Track offers two Output selectors. The top selector is to set a “Cue Out”, which 
allows you to route a separate output for playback of browser clips and previews. If you have a TonePort 
UX8, then you can set this Cue Out to a different stereo output to allow you to listen to previews on a 
completely separate headphone or speaker out. Please see Live’s documentation regarding the Cue Out 
feature. For all other Line 6 hardware, set both Master Outs to the same Out 1/2.
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Set Input Monitoring Options...

When recording using GearBox, it is recommended to use its ToneDirect Monitoring™ feature, 
where your input monitoring signal is passed directly back out of your Line 6 hardware’s output. This 
allows you to hear the GearBox tone you have selected for your Mic or Instrument with the lowest 
possible latency. Likewise with POD X3 and PODxt, these devices offer a super low latency USB audio 
monitoring. Therefore, we will disable Ableton Live’s Input Monitoring option so that the input 
monitor signal is not additionally fed through the software*.

Click the audio track’s Monitor Off 
button

 
* Optionally, if you are using the GearBox Plug-In, you can load the Plug-In on your Live audio track 
and turn Monitoring to “Auto” to monitor your input signal through the software, and thus through 
the GearBox Plug-in processing. See the Using the GearBox Plug-In chapter for a detailed guide on 
configuring the Gearbox Plug-In with Ableton Live!.

Arm Your Track & Set Your Levels...

Click the Arm button to arm the audio track for recording

Note that you’ll see the meters measure your input recording 
level once the track is armed

If you are using GearBox with your Line 6 
hardware, you can adjust your recording level in 
using the assigned Send’s Record knob within the 
GearBox window. Note that your Amp and Tone 
Volume knobs in GearBox and on POD devices 
will also affect the recording level into Live
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Start Recording!

Once your record level is set, click on Live’s transport Record button to put it 
into Record Mode, then press Play and start riffing!
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adobe® audition® 3 setup 
For this document, we’ll show how to configure Adobe® Audition® 3.0 to work with Line 6 TonePort, 
GuitarPort, POD X3 or PODxt as the USB audio device on a Windows® XP® (32-bit) system.  The 
steps are very similar for the setup previous Adobe® Audition® versions as well.

 Note that the features of Line 6 hardware models differ slightly, so we’ll call out where specific instructions 
apply per device type. If you are using a POD X3 device, it is not yet supported as of GearBox version 3.5 
- please check the Line 6 GearBox Online Help site for the latest news and developments.

Configure Your Windows® PC to Use Your Line 6 Hardware

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port. If you have 
not already done so, the first step is to go to the Windows® Control Panel and select Line 6 Audio-
MIDI Devices to configure the ASIO driver settings for your Line 6 device. 

Go to the Driver tab

Set the ASIO Buffer Size to 
512 as a good starting point 
- or, you can try a lower value 
if your PC is snappy enough.

Set the Bit Depth to 24 bit

For more information, please reference the Windows Driver Settings section of the Audio Driver and 
GearBox Settings chapter for details on Driver settings for your specific Line 6 hardware. 

Configure Adobe Audition’s Audio Driver Settings 

Adobe Audition is unique in that it is actually two audio applications in one - the Edit View (a stereo 
Wave Editor), and the Multitrack View (a full Audio/MIDI Multitrack). These two “Views” have 
individual settings for the audio driver and input/output. We’ll configure both Views to use a Line 6 
TonePort UX2, and we’ll point out where things might be different for other Line 6 hardware.

http://line6.com/support/knowledgebase/toneporthelp/
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Edit View Audio Driver & Input/Output Settings

Launch Audition and open the Audio Hardware Setup dialog:

Go to the Audition Edit menu and 
choose Audio Hardware Setup

Go to the Edit View tab

For the Audio Driver, select the one named 
“ASIO” followed by the name of your 
specific Line 6 device*

For Default Input, choose the mono or 
stereo Send that you want to record from in 
the Edit View**

For Default Output, you probably want to 
choose the [01S] Output 1, which is  your 
Line 6 device’s primary stereo Output 1/2. 
With this setting all Edit View playback will 
be routed to the main outputs

The Control Panel button will launch the Line 6 Audio-MIDI 
Devices dialog, which is where you can make Sample Rate and Bit 
Depth settings (see the previous section)

*For the Audio Driver setting, it is also possible to alternatively use the “Audition Multimedia” 
(DirectSound) driver for the Edit View audio driver. This does offer some convenience since it will 
allow you to record or playback at just about any Sample Rate, where ASIO is limited to 44100, 48000, 
88200 or 96000 only. The Line 6 “ASIO” driver option does offer snappier  performance. For more 
about ASIO Buffer settings, please reference the Windows Driver Settings section of the Audio Driver 
and GearBox Settings chapter.

**The Default Input is an important setting for the Edit View since it determines what Line 6 Sends 
you are recording from. You can come back to this dialog any time to switch this - which you might 
need to do if, for example, you want to record a mono vocal from TonePort Send 1 versus a stereo file 
from the output of your stereo receiver on TonePort Send 1-2. 

For details as to what you are actually selecting in these Default Input and Output menus, please see 
the Line 6 Device ASIO Input & Output Options Within Audition section.

When the above Edit View tab settings are complete, click Apply and then go to the Multitrack 
tab.
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Multitrack View Audio Driver & Input/Output Settings

Go to the Multitrack View tab

For the Audio Driver, select the one named 
“ASIO” followed by the name of your 
specific Line 6 device*

For Default Input, choose the mono or 
stereo Send that you want your audio tracks 
to use as the default **

For Default Output, choose the [01S] 
Output 1, which is  your Line 6 device’s 
primary stereo Output 1/2

The Control Panel button will launch the Line 6 Audio-MIDI 
Devices dialog, which is where you can make Sample Rate and Bit 
Depth settings

If you receive this alert when changing the Audio Driver to ASIO, just note its message and click OK. If 
you already have some Audition Sessions you created and saved with a different Audio Driver then you 
migth need ot check that its audio track inputs & outputs match up with the new Line 6 ASIO inputs 
and outputs - if not then just change the audio track ins and outs in that Session

*For the Audio Driver setting, it is also possible to alternatively use the “Audition Multimedia” 
(DirectSound) driver for the Multitrack View audio driver. This does offer some convenience since it 
will allow you to record or playback at just about any Sample Rate, where ASIO is limited to 44100, 
48000, 88200 or 96000 only. BUT, the Line 6 “ASIO” driver option is highly recommended for the 
Multitrack will provide an individual input for each Send and offer much snappier  performance. For 
more about ASIO Buffer settings, please reference the Windows Driver Settings section of the Audio 
Driver and GearBox Settings chapter.
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**The Default Input is really just a convenience for the Multitrack View - you can still manually set 
the input for each audio track within your Session to record from any other Send. 

For details as to what you are actually selecting in these Default Input and Output menus, please see 
the Line 6 Device ASIO Input & Output Options Within Audition section.

Recording in Audition’s Edit View

Once the above driver and input/output settings are complete, you are ready to put Audition to work! 
First let’s look at recording in the Edit View. Use the View buttons at the top of the Audition screen 
to toggle to the Edit View.

Open or Create a New File...

Go to File > New Project to create a new, blank audio file to record into. You’ll be prompted to  define 
the file’s properties. 

In Audition’s Edit View, select New 
from the File menu

Choose the properties for your new file: 

Your preferred Sample Rate - 44100 is 
typically a good choice

Choose Mono or Stereo as preferred

Choose 32-bit (since this is the Bit Depth we 
already set in the Line 6 Audio-MIDI Devices 
dialog)

Click OK and the file will be created

A few tips about Edit View recording and these settings...

Sample Rate support: If you are using the ASIO Audio Driver for Edit View that you are limited 
to a sample rate of 44100, 48000, 88200 or 96000 for recording or playback. If you need any other 
sample rate you’ll need to switch to the “Audition Multimedia” driver. See the Edit View Driver 
Settings section above. 

Mono/Stereo Channels: You can to create a new Mono or Stereo audio file here, but note that 
what gets recorded into this new file is still determined by your Edit View’s Default Input 
selection in the Audition Audio Hardware Setup dialog. For example, if you create a Stereo 

•

•
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audio file and your Default Input is set to a Mono input (such as [01M] Send 1) then this will 
grab the mono signal from your Line 6 hardware’s Send 1 channel only and record it into both 
the left and right channels of your stereo file! It is best to choose a mono Default Input for 
recording a mono file, and stereo Default Input for a stereo file. See the Edit View Driver Settings 
section above. 

Check your Edit View Recording Levels

Before you hit that Record button, it is of course a good idea to play your instrument with your desired 
GearBox/POD settings and check the level coming into Audition. 

To activate the input metering, right click on Audition’s Level 
meter and choose Monitor Record Level - repeat to toggle it off

If you are using GearBox with your Line 6 
hardware, you can adjust your recording level in 
using the assigned Send’s Record knob within the 
GearBox window. Note that your Amp and Tone 
Volume knobs in GearBox and on POD devices 
will also affect the recording level into Cubase

Start Recording!

Once your record level is set, click on the transport Record button and start recording!



Adobe Audition 3 Setup - Windows

5•13

Recording in Audition’s Multitrack View

Now let’s look at recording in the Edit View. Use the View buttons at the top of the Audition screen 
to toggle to the Multitrack View.

Open or Create a New Session...

Go to File > New Session to create a new, blank Multitrack Session to record into. You’ll be prompted 
to  define the Session’s Sample Rate. 

In Audition’s Multitrack View, select 
New Session from the File menu

Choose the properties for your new file: 

Your preferred Sample Rate - 44100 is 
typically a good choice, or you can select 
48000, 88200, or 96000 if your project requires 
one of these specific rates. (Other sample rates 
are not supported  by the ASIO driver)

Click OK and the new Session will be created

Once your Session is created, it’s a good idea to go ahead and do File > Save Session, type in a name 
and choose a directory to save it in where you have lots of free hard disk space.

Set your Audio Track Input and Output...

In a new Session, you’ll already have several empty audio tracks ready for you. if needed, you can go 
to the Insert menu and select New Audio Track if you need to create another. You’ll see that all audio 
tracks’ Input and Output options will already be set to the Default Input and Default Output options 
you selected earlier in the Audition Audio Hardware Setup dialog. But if you want to change the Input 
to record from a different Send, just click on the Track Input selector at the left of the track. 

Choose a Line 6 device Send to 
record from in the Track Input 
Selector*

For Track Output, set this to Master 
track (and then we’ll set the Master 
track output next)

*You can choose a Stereo or Mono Send as your audio track input - a Stereo input will record a stereo 
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file into the track. A Mono input will record a mono file. The track output is always stereo.

Set the Session’s Master Output...

By setting the audio tracks’ Output to Master, as shown above, this allows you to use the Master track’s 
volume, pan, effects inserts etc. on all tracks’ mixed output before it goes to your Line 6 hardware. By 
default, your Master track Output should already be assigned to [01S] Output 1 (your Line 6 device’s 
Output 1-2). But, to check this, or if you have a TonePort UX8 and want a different Master Output, 
you can check this setting in the Audition Mixer panel.

Go to the Mixer panel

Go to the Master channel strip at the far 
right of the Mixer. You can see and change 
the Master Output here

Set Input Monitoring Options...

When recording using GearBox, it is recommended to use its ToneDirect Monitoring™ feature, 
where your input monitoring signal is passed directly back out of your Line 6 hardware’s output. This 
allows you to hear the GearBox tone you have selected for your Mic or Instrument with the lowest 
possible latency. Likewise with POD X3 and PODxt, these devices offer a super low latency USB audio 
monitoring. Therefore, we will set the Audition Session to “External Monitoring” so that the input 
monitor signal is not additionally fed through the software*.

In the Session Properties panel, set 
the Monitoring option to External

 * Optionally, if you are using the GearBox Plug-In, you can load the Plug-In on your audio track and set 
this option to “Audition Mix” to monitor your input signal through the software, and thus through the 
GearBox Plug-in processing. Please see Audition’s Help documentation for more abut the Audition Mix 
Monitoring options. See the Using the GearBox Plug-In chapter for a detailed guide on configuring the 
Gearbox Plug-In!
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Arm Your Track and Check Your Recording Levels...

Before you can record into a track you need to “arm” it, and of course it’s a good idea to play your 
instrument with your desired GearBox/POD settings and check the level coming into the Audition 
track before you start rolling. You can access these Audio Track options either in the Mixer panel, or 
back in the Main panel.

In either the Main or the Mixer panel, press the 
R button to Arm your configured Audio Track for 
recording...

Go to the Options menu and select Monitor 
Input Level and you’ll see the armed track’s meters 
measure your incoming signal. (Or hit F10 to easily 
toggle this on/off)

If you are using GearBox with your Line 6 
hardware, you can adjust your recording level in 
using the assigned Send’s Record knob within the 
GearBox window. Note that your Amp and Tone 
Volume knobs in GearBox and on POD devices 
will also affect the recording level into Cubase
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Start Recording!

Once your record level is set, click on the transport Record button and start Recording!

Line 6 Device ASIO Inputs & Ouputs Within Audition

As mentioned in the previous sections, you will see a different number of options in Audition’s Audio 
Hardware Setup dialog’s Default Input and Default Output menus depending on your specific Line 6 
device. When using the Line 6 ASIO driver, each Send is offered both as individual mono Sends and 
as paired stereo Sends. To follow is a description of these ASIO Inputs and Outputs so you can decipher 
them within Audition!

Audition Default Input Options

TonePort and GuitarPort devices (except TonePort UX8): You will see the following ASIO 
Inputs...

[01M] Send 1 = TonePort/GearBox Send 1, mono
[01M] Send 2 = TonePort/GearBox Send 2, mono
[01M] Send 3 = TonePort/GearBox Send 3, mono
[01M] Send 4 = TonePort/GearBox Send 4, mono
[01S] Send 1 = TonePort/GearBox Send 1-2, stereo
[01S] Send 3 = TonePort/GearBox Send 3-4, stereo

•
•
•
•
•
•
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TonePort UX8: You will see the following ASIO Inputs...

[01M] Send 1 = TonePort Send 1, mono
[01M] Send 2 = TonePort Send 2, mono
[01M] Send 3 = TonePort Send 3, mono
[01M] Send 4 = TonePort Send 4, mono
[01M] Send 5 = TonePort Send 5, mono
[01M] Send 6 = TonePort Send 6, mono
[01M] Send 7 = TonePort Send 7, mono
[01M] Send 8 = TonePort Send 8, mono
[01M] GearBox Send 9 = GearBox Send 9, mono
[01M] GearBox Send 10 = GearBox Send 10, mono
[01M] GearBox Send 11 = GearBox Send 11, mono
[01M] GearBox Send 12 = GearBox Send 12, mono

•
•
•
•
•
•
•
•
•
•
•
•

[01S] Send 1 = TonePort Send 1-2, stereo
[01S] Send 3 = TonePort Send 3-4, stereo
[01S] Send 5 = TonePort Send 5-6, stereo
[01S] Send 7 = TonePort Send 7-8, stereo
[01S] GearBox Send 9 = GearBox Send 9-10, stereo
[01S] GearBox Send 1 = GearBox Send 11-12, stereo

•
•
•
•
•
•

 TonePort UX8’s driver offers multiple Inputs and Sends with many flexible options for routing and 
monitoring GearBox Tones. Please reference the Windows Driver Settings section of the Audio Driver 
and GearBox Settings chapter for more details

POD X3 devices: You will see the following ASIO Inputs...

[01M] Send 1 = POD X3 Send 1, mono
[01M] Send 2 = POD X3 Send 2, mono
[01M] Send 3 = POD X3 Send 3, mono
[01M] Send 4 = POD X3 Send 4, mono
[01M] Send 5 = POD X3 Send 5, mono
[01M] Send 6 = POD X3 Send 6, mono
[01M] Send 7 = POD X3 Send 7, mono
[01M] Send 8 = POD X3 Send 8, mono

•
•
•
•
•
•
•
•

[01S] Send 1 = POD X3 Send 1-2, stereo
[01S] Send 3 = POD X3 Send 3-4, stereo
[01S] Send 5 = POD X3 Send 5-6, stereo
[01S] Send 7 = POD X3 Send 7-8, stereo

•
•
•
•

 
*POD X3 offers several onboard options for the type of signal that is assigned to each Send. Look in the 
Line 6 Audio-MIDI Settings dialog’s Inputs screen to see the current POD X3 Send descriptions.  For 
more info about POD X3 Sends,  please reference the Windows Driver Settings section of the Audio 
Driver and GearBox Settings chapter, and your POD X3 Pilot’s Handbook.

PODxt devices: You will see the following ASIO Inputs...

[01M] Input 1 = PODxt/GearBox Send 1, mono
[01M] Input 2 = PODxt/GearBox Send 2, mono
[01S] Input 1 = PODxt/GearBox Send 1-2, stereo

•
•
•

Also important to note is that the signal carried on the Line 6 device’s Sends will differ depending on 
if GearBox is running or not, since GearBox offers options to slather on amp, cab amd effects models 
onto your Mic or Instrument signal before that signal gets routed out the Sends. You can launch the 
Line 6 Audio-MIDI Devices dialog at any time and take a look in the Inputs & Recording tab - the 
Record Sends pane there provides handy descriptions of what is actually carried on each Send. Need a 
refresher on all that? Head on back to the Windows Driver Settings section.
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Audition Default Output Options

For Outputs things are much simpler! All Line 6 devices offer one ASIO stereo Output, which appears 
as:

[01S] Output 1

This is of course sent to your Line 6 hardware’s Output 1-2, and typically this is automatically selected 
as Audition’s Default Output for both the Edit View and Multitrack View. This is all good since for 
most projects you’ll simply want all audio being routed to the same common stereo output on your Line 
6 device so that you can connect your stereo monitor speakers to  the Output 1-2 jacks. 

The one exception to this is the TonePort UX8 - this fancy device offers multiple outputs. Therefore, 
you’ll see the following options in Audition’s Default Output menus:

[01S] Output 1 = TonePort UX8 Outputs 1-2, stereo
[01S] Output 3 = TonePort UX8 Outputs 3-4, stereo
[01S] Output 5 = TonePort UX8 Outputs 5-6, stereo
[01S] Output 7 = TonePort UX8 Outputs 7-8, stereo

•
•
•
•
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cakeWalk sonar® 7 studio/producer 
setup

For this document, we’ll show how to configure Cakewalk SONAR® 7.01 Producer Edition to work 
with Line 6 TonePort, GuitarPort, POD X3 or PODxt as the USB audio device on a Windows® XP® 
(32 -bit) system.  The steps are very similar for the setup of other Cakewalk SONAR Producer, 
Studio, Home Studio® & Guitar Tracks Pro® versions as well. (The SONAR 64-bit version is not 
currently supported by Line 6 audio device drivers or GearBox software).

 Note that the features of Line 6 hardware models differ slightly, so we’ll call out where specific instructions 
apply per device type. If you are using a POD X3 device, it is not yet supported as of GearBox version 3.5 
- please check the Line 6 GearBox Online Help site for the latest news and developments.

Configure Your Windows® PC to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Windows® Control Panel and select the 
Line 6 Audio-MIDI Devices to access the Audio Driver settings. 

 IMPORTANT! For all Cakewalk SONAR, Home Studio and Guitar Tracks applications, the highest 
ASIO bit depth supported by this application with Line 6 devices is 24 bit. Before launching your Cakewalk 
software, be sure to set the bit depth in the Line 6 Audio-MIDI Devices dialog specifically to 24 bit.

Go to the Driver tab

Set the ASIO Buffer Size to 
512 as a good starting point 
- or, you can try a lower value 
if your PC is snappy enough.

Set the Bit Depth to 24 bit

For more information, please reference the Windows Driver Settings section of the Audio Driver and 
GearBox Settings chapter for details on Driver settings for your specific Line 6 hardware. 

Configuring SONAR to Use the Line 6 ASIO Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps...

http://line6.com/support/knowledgebase/toneporthelp/


Cakewalk SONAR 7 Setup - Windows

5•20

Launch the SONAR Audio settings:

Go to the SONAR Options 
menu and choose Audio

First, go to the Advanced tab and select the ASIO driver

Go to the Advanced tab

Choose ASIO as the Driver Mode*

Click OK when done

*It is possible to use the WDM or MME driver modes, but using the ASIO driver type is recommended 
since it offers the best performance and multiple input/output channels. For more about ASIO Buffer 
settings, please reference the Windows Driver Settings section of the Audio Driver and GearBox 
Settings chapter.

 Important: If you are switching to ASIO Driver Mode from a different Mode, you will be prompted with 
the following alert to exit and restart SONAR - if prompted, you must do so before making the next 
settings.
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Activate Inputs & Outputs:

Once you’ve restarted SONAR, go to Options > Audio once again and go to the Drivers 
tab...

Go to the Drivers tab

Here you will see all ASIO Inputs and 
Outputs for your Line 6 hardware*

You can “activate” all the Input Drivers 
& Output Drivers for your Line 6 
hardware that you want to be accessible 
for any audio tracks within a SONAR 
Project

*Input Drivers:

Note that you’ll see a different number of inputs depending on the specific Line 6 device you are using.  
Each Input Driver represents one stereo pair of (or two mono)  audio channels, which are the same as 
the numbered device Sends (i.e. - “ASIO TonePort UX2 Send 1” is the UX2/GearBox stereo Record 
Send 1-2). You can select as many as you think you’ll want to record from into SONAR audio tracks, 
but keep in mind that each additional activated input utilizes more CPU, so only activate the ones 
you need!

TonePort GX, D.I. UX1, UX2 and KB37: You will see 2 TonePort Input Drivers, as pictured 
above.

TonePort UX8: You’ll see 6 TonePort UX8 Input Drivers.

 TonePort UX8’s driver offers multiple Inputs and Sends with many flexible options for routing and 
monitoring GearBox Tones. Please reference the Windows Driver Settings section of the Audio Driver 
and GearBox Settings chapter for more details

POD X3 devices: You’ll see 4 POD X3 Input Drivers.

 
POD X3 offers several onboard options for the type of signal that is assigned to each Send. Look in the 
Line 6 Audio-MIDI Settings dialog’s Inputs screen to see the current POD X3 Send descriptions.  For 
more info about POD X3 Sends,  please reference the Windows Driver Settings section of the Audio 
Driver and GearBox Settings chapter, and your POD X3 Pilot’s Handbook.

PODxt devices: You’ll see 1 PODxt Input Driver.
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Output Drivers:

For all Line 6 devices (except TonePort UX8), the ASIO driver offers only one stereo output, therefore, 
you’ll see one Output Driver, and it will likely already be automatically selected. 

TonePort UX8: You’ll see 4 UX8 Output Drivers. For most SONAR projects, you likely only need 
to enable the first “Output 1” options and assign all track playback to this one common output. 
However, TonePort UX8 does offer some very flexible monitoring and signal routing options using 
its additional outputs - please see the Windows Driver Settings section, as well as your TonePort 
UX8 Pilot’s Handbook for more information.

Additional Audio settings...

Now click on the General tab in the Audio dialog to make a few final settings.

For the Playback Timing Master, select 
the primary ASIO “Output 1” of your 
Line 6 device

For the Recording Timing Master, select 
the primary ASIO “Send 1” of your Line 
6 device

The Audio Driver Bit Depth likely is 
grayed out here. You’ll want to set it to 24 
bit if it is not already. If needed, go to the 
Global Options to change this setting*

44100 is a good Sampling Rate to 
choose, or you can select 48000, 88200, 
or 96000 if your Project requires a higher, 
specific rate 

The ASIO Panel button launches the 
Line 6 Audio-MIDI Devices dialog, 
where you can adjust the ASIO Buffer or  
Bit Depth if needed

Click OK when done

*If the Audio Bit Depth was not automatically set to 24 Bit in the previous step, then you can go to 
SONAR’s Options > Global... > Audio Data tab and change this setting...

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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For the Record Bit Depth, select 24. 
Click OK when done to exit

Configuring an Audio Track for Recording 

Now that your Line 6 hardware is set up, you are ready to start working in a SONAR Project!  Create 
a new Project File (or open an existing one) and insert a new audio track to record into...

Choose Insert Audio Track from 
SONAR’s Insert menu

Select your Audio track’s Input and Output

You’ll see that you have the option of choosing either a “Left” or “Right”  
mono, or a “Stereo” input for any Audio track’s recording input* 

Click on the Audio track’s 
Input selector to choose a 
mono or stereo input

Set your Audio tracks’ Output 
to your Line 6 device’s stereo 
Output 1
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*Note that the “Left” and “Right” labeled ASIO TonePort Send 1 and ASIO TonePort Send 3 
options will record from either the Line 6 Device Send 1-2 or Send 3-4, respectively, where “Left” 
is always the odd-numbered channel and “Right” is always the even-numbered channel of the Send. 
These “Left” and “Right” labeled inputs will record a mono file. 

The “Stereo” labeled options will record from the correspondingly numbered Line 6 hardware’s Send 
1-2, Send 3-4, etc., and will record a stereo file.

Set Input Monitoring Options...

When recording using GearBox, it is recommended to use its ToneDirect Monitoring™ feature, 
where your input monitoring signal is passed directly back out of your Line 6 hardware’s output. This 
allows you to hear the GearBox tone you have selected for your Mic or Instrument with the lowest 
possible latency. Likewise with POD X3 and PODxt, these devices offer a super low latency USB audio 
monitoring. Therefore, we will disable SONAR’s “Input Echo” option on our Audio track so that the 
input monitor signal is not additionally fed through the software*.

Click the audio track’s Monitor Off 
button

 

* Optionally, if you are using the GearBox Plug-In, you can load the Plug-In on your Live audio track 
and turn SONAR’s Input Echo button ”ON” to monitor your input signal through the software, and thus 
through the GearBox Plug-in processing. Please see SONAR’s Help documentation for Global and Track 
Input Monitoring options. See the Using the GearBox Plug-In chapter for a detailed guide on configuring 
the Gearbox Plug-In!

Arm Your Track & Set Your Levels...

Click the R button “ON” to arm the audio track for 
recording

Note that you’ll see the meters measure your input 
recording 
level once the track is armed

If you are using GearBox with your Line 6 
hardware, you can adjust your recording level in 
using the assigned Send’s Record knob within the 
GearBox window. Note that your Amp and Tone 
Volume knobs in GearBox and on POD devices 
will also affect the recording level into SONAR
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Start Recording!

Once your record level is set, click on the transport Record button and start riffing!
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digidesign® pro tools® le™ 7 setup 
Digidesign® has designed Pro Tools® software so it can only be used with a Digidesign or M-Audio ® 

audio interface; you cannot use your Line 6 hardware as the primary audio interface for a Pro Tools 
system. But you can still enjoy the benefits of GearBox by connecting your Line 6 device to the 
Digidesign interface’s inputs. TonePort UX2, UX8, KB37, POD X3 and PODxt PRO even let you do 
this with a direct, digital connection.

For this document, we’ll be showing how to connect to the Digidesign® Mbox® 2 unit with Pro Tools 
LE™ 7.3.1, but these steps are similar for connecting to the Digi 002® or other Digidesign and M-
Audio hardware as well. There are two methods described here – Recording from a Line 6 USB device’s 
analog outputs or digital S/PDIF outputs.

 Note that it is not necessary to have both your Line 6 hardware and Digidesign hardware connected 
to the same computer. You can alternatively have your Line 6 and Digidesign hardware on separate 
computers since the two devices are indeed operating individually!

Recording from Your Line 6 Hardware’s Analog Outputs 

In this setup example, we’ll show how to connect a TonePort UX2 to a Digidesign Mbox 2 unit - it is 
of course possible to record from the analog output of any Line 6 device in much the same way. We will 
call out where different steps are needed for other Line 6 hardware. 

 

Note that if you are using a POD X3 or PODxt device it is not necessary to connect your POD to a 
computer via USB at all for this type of analog connection. GearBox is not necessary for any POD, PODxt 
or POD X3 unit since Tones can be by called up & edited, and output levels configured completely on your 
POD device! However, if you want to use GearBox with any PODxt family device, you certainly can if you 
connect to the USB port of a computer - as mentioned above, it does not necessarily have to be the same 
computer that Pro Tools is running on.

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed 
with the following steps…

Connect the Analog Outputs* from your Line 6 hardware to the Digidesign Mbox 2:

Using two ¼” to ¼” shielded TS or 
TRS audio cables, plug each into the 
Analog Outs of your device

Connect a USB cable to your  
device & computer’s USB port

*Note - If you are using a GuitarPort device, the Analog Outs are the RCA style jacks labelled “L” and 
“R”. If using a TonePort UX8, you should connect to the “Out 1” and “Out 2” jacks on the back.
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Plug the other end of the Left audio cable into the Mbox Input 1 input, and the right audio cable into 
the Mbox Source 2 input.

From your Line 6 device’s Left Analog Out 
(or “Out 1”), connect to the Mbox 2 Input 
1 - Line input

From your Line 6 device’s Right Analog 
Out (or “Out 2”), connect to the Mbox 2 
Input 2 - Line input

Connect a USB cable to your 
Mbox 2 & computer’s USB port

Use the Mbox 2 Mon Outputs to hear playback of all Pro Tools LE audio. The Line 6 Hardware/GearBox 
audio will be mixed with the Pro Tools LE audio as well. Therefore, if you are using headphones, you’ll 
want to plug them into the Mbox 2 headphone jack to hear everything:

From the Mbox Mon Out jacks, connect to the 
Left and Right inputs for your powered speakers 
or monitoring system

If you want to use headphones for 
monitoring, plug them in to the 
Mbox 2 Headphone Out

Next, before you launch Pro Tools LE, make sure that your Windows PC is configured properly for your 
Line 6 hardware.  This configuration is slightly different depending on which specific Line 6 hardware 
you are using:

TonePort, GuitarPort and PODxt Devices

If you are using GearBox along with your device, you’ll want to consult the GearBox Help PDF that 
is installed with GearBox - just launch GearBox and select Open Help from the Help menu. In the 
GearBox Help document, please reference the Driver Panel & Recording chapter and the details for 
your specific Line 6 device. 

POD X3 Devices

If you will using GearBox along with your POD X3, you’ll want to consult the GearBox Help PDF 
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that is installed with GearBox - just launch GearBox and select Open Help from the Help menu. In 
the GearBox Help document, please reference the Driver Panel & Recording chapter and the details 
for your specific Line 6 device. It may also be helpful to read through the POD X3 Pilot’s Handbook 
that came in the box with your POD X3. Or, you can download this Handbook in PDF form from the 
Line 6 User Manual downloads page.  In particular, the Reference: Configuration & Setup chapter 
covers the options for choosing your inputs (Mic, Line, Instrument, or multiple input sources) as well 
as things such as a Tone Blend versus Tone Pair tone setting, panning tones and effects, etc. Basically, 
this is the point where you’ll want to have your instrument or mic plugged into POD X3 and have your 
tone sounding the way you want it be recorded. You’ll also want to be sure the panning and levels of 
the tones and effects feeding to the POD X3 Left and Right analog outs are the way you want each to 
be recorded into your Pro Tools track(s).

Creating a New Pro Tools LE Session
Once you have your Line 6 hardware and GearBox configured (if using GearBox), then the next step 
is to launch Pro Tools LE and set up a Session for recording...

To start a new Session in Pro Tools LE, 
choose New Session from the File menu

Choose a directory where 
to save your new Session 
and type in a name for it

File Type - WAV is a 
good choice here for 
Windows

For I/O Settings, Stereo 
Mix is best

Choose the Sample 
Rate and Bit Depth, 
44.1 kHz and 24 Bit 
are good choices unless 
you have specific needs 
for your project

Create and Configure a New Audio Track
Next create at least one new audio track in the session to record into. You can of course also create 
more audio tracks if you want to import existing audio files into this session...

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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In the Track menu, select New...

Choose how many
Tracks to create 

Choose Mono or Stereo* for 
your audio track format

Choose Audio Track for 
the Track type

Choose Samples 

...Then click Create 

*You’ll need to decide before creating each recording track here if you want to record the output from 
your Line 6 hardware/GearBox as Mono or Stereo.  Mono will of course only record one of your Line 
6 device’s (Left or Right) outputs, and you’ll choose which once the track is created. If you have stereo 
effects active on your GearBox or POD tone, then you’ll probably want to choose Stereo to record 
both channels into a stereo track. 

On the new audio track, click on the Input Selector and 
choose the Mbox Interface input source. Since we created 
a Stereo track here, we’ll select the In 1-2 (Stereo) to 
record from the Mbox Mic/Line (analog) inputs

At the top left of the Edit Window, click the 
View selector and enable the I/O View

Or… if you created a mono audio track, you’ll have the option for the track input to choose either In 
1 (Mono) to capture the LEFT signal, or In 2 (Mono) to capture the RIGHT signal:
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Click the R button to arm the audio track 
for recording 

The track meters will now measure the 
Line 6 Device/GearBox signal level 

Click the M button to 
mute the track while 
recording*

*Muting the track during recording disables the Pro Tools LE software monitoring feature, which 
allows your Line 6 Hardware/GearBox analog input signal to be monitored with the lowest latency 
possible. Adjust the Mbox MIX knob to balance the session audio playback with the input audio (see 
your Mbox documentation for details). Once you are done recording, un-mute the track so you can 
hear playback.

Note to Digi 002 users… when using the Digi 002 hardware with Pro Tools LE, an additional Low Latency 
Monitoring option is available within Pro Tools LE Operations menu. You can alternatively keep your 
track un-muted and activate this option to hear your input monitoring signal when recording (see your Digi 
002/Pro Tools LE documentation for more on this feature).

Set your Recording Levels - As shown above, once your audio track is armed, you can use the track’s  
meters to gauge your recording levels. Note that the levels coming into the track are affected by a few 
different controls. If you are using GearBox, then the output level is affected by the Tone volume as well 
as the main Monitor volume. Also, the main Output or Master Volume knob on your Line 6 hardware 
unit affects the signal level going out the Analog Outs. Finally, the Mbox unit includes level knobs 
for Inputs 1 & 2 to adjust the incoming signal level. The best practice is to set all of these controls to 
roughly half way to start, and then adjust each of them slightly to acheive the optimum level. You want 
to avoid setting any one control very high or very low to avoid excess noise or degrading the signal 
quality. 
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Be sure the input switches are set so that the green 
Mic light is illumintated for both Inputs 1 & 2 (since 
we’re plugging into these Mic/Line inputs) 

Use the Input 1 & 2 knobs to adjust 
the recording levels

Keep both the Mono and 48V 
(phantom power) switches off 

Start Recording...

Click the transport Record button to place Pro 
Tools LE into record mode, then press the Play 
button to start recording! 
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Recording from Your Line 6 Hardware’s S/PDIF Outputs

TonePort UX2, UX8, POD X3 and PODxt Live units all include S/PDIF outputs, therefore you can 
optionally connect these outputs to your Digidesign hardware to record digitally into Pro Tools or Pro 
Tools LE! In this setup example, we’ll show how to connect a TonePort UX2 to a Digidesign Mbox 2 
unit, and we’ll call out where different steps might be necessary for the other Line 6 devices. 

For more information regarding using your Line 6 device’s S/PDIF connections, please also see the 
earlier section titled S/PDIF Digital Output from Line 6 Hardware to an External Device. The Pilot’s 
Handbook that came with your Line 6 device includes more useful information as well. 

Connect Your Hardware...

Using a 75-Ohm, coaxial S/PDIF cable, plug 
one end into the S/PDIF Digital Out of 
your Line 6 device

Plug the other end of the S/PDIF 
cable into the Mbox S/PDIF In 

From the Mbox Mon Out jacks, connect 
to the Left and Right inputs for your 
powered speakers or monitoring system

If you want to use headphones for 
monitoring, plug them in to the 
Mbox 2 Headphone Out 
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You will still use the Mbox Mon Out jacks (or Headphone Output) to hear playback of all Pro Tools LE 
audio. The Line 6 Hardware/GearBox audio will be mixed with the Pro Tools LE audio if you use the 
Pro Tools software monitoring function. See the later section regarding monitoring for more on this.

TonePort UX2, UX8 & KB37 Configuration
When connecting two hardware devices digitally, it is necessary that both units are set to operate at 
the same sample rate. For TonePort devices, this is configured in the Line 6 Audio-MIDI Settings 
dialog. Note that you will need to have your TonePort connected to your computer’s USB port, but 
you must not have the GearBox application running - this is necessary to change sample rate settings. 
To get to this dialog, go to the Windows Control Panel and launch the Line 6 Audio-MIDI Devices. 
In the dialog, go to the Driver tab:

Choose your connected 
Line 6 Device...

Then set the preferred  
sample rate for the 
Format. Mbox 2 supports 
44100 or 48000 Hz 
- we’ll use 44100 Hz for 
this example 

Choose 24 bit

Check the box so that the 
settings are locked 

Click OK when done
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POD X3 S/PDIF Configuration

Connect the S/PDIF Out on the rear panel of your 
POD X3 device to the S/PDIF Input on the Mbox

POD X3                                                                                             POD X3 Live

The S/PDIF Out sends out 24-bit digital versions of the Left & Right Outputs. Press the OUTPUTS 
button to acces additional S/PDIF options:

For S/PDIF, you likely want 
the MATCH STUDIO/
DIRECT option* 

For the S/P SR options, set 
the sample rate to the same 
as your Pro Tools Session 
(44.1 kHz is a good option) 

Use the S/PLVL if you need 
to slightly raise or lower 
the outgoing S/PDIF signal 
level for optimum recording 
levels

*This S/PDIF setting defines what type of audio is sent out the S/PDIF Out. These options are:

Match Studio/Direct – S/PDIF outputs the Tone and Pan settings as shown.

Studio/Direct Tone 1 – S/PDIF outputs Tone 1 only, panned center.

Studio/Direct Tone 2 – S/PDIF outputs Tone 2 only, panned center.

Dry Inputs – S/PDIF Left outpus the unprocessed input(s) to Tone 1, and S/PDIF right outputs 
the unprocessed input(s) to Tone 2.

•

•

•

•
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PODxt Pro - Digital Output Configuration

Connect the S/PDIF Out on the 
rear panel of your device to the 
S/PDIF Input on the Mbox

Press the Tune/System button and turn the Select knob clockwise until the display reads, What are 
you connecting to?

Set the DIGOUT option to 
SPDIF

Set the DEST option to 
STUDIO DIRECT 

Press the I/O & Dig Select button once to access the Digital Out page:

For the FORMAT options, set 
the sample rate to the same as 
your Pro Tools Session (44.1 
kHz is a good option) and 24 
BIT

Set the MODE to NORMAL for  
your fully processed tone to be sent 
out the S/PDIF connection (or 
to DRYGTR for an unprocessed 
signal) 

Use the GAIN if you need 
to slightly raise or lower 
the S/PDIF signal level for 
optimum recording levels

Configure Mbox 2/Pro Tools LE for Digital Recording

Now, launch the Pro Tools LE application and set it up to receive the S/PDIF Digital Input as 
follows:

From the Pro Tools LE Setup menu, 
select Hardware...
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Choose S/PDIF as the 
Clock Source so that 
the Mbox 2 follows the 
digital clock of your Line 6 
hardware

The Sample Rate option 
here is determined by the 
Session setting (next step)

Click OK when done

You will now see the S/PDIF light solidly 
illuminated on the front of the Mbox 2, 
indicating it is in S/PDIF digital input mode

Note that when receiving S/PDIF input, the Input 1 & 2 level knobs on the front of the Mbox 2 do not 
adjust the digital signal level. To adjust the recording level, use the GearBox software’s Tone volume and 
output level controls, or your PODxt or POD X3 S/PDIF Gain control.

Creating a New Pro Tools LE Session
Once you have your Line 6 hardware and GearBox configured (if using GearBox), then the next step 
is to launch Pro Tools LE and set up a Session for recording...

To start a new Session in Pro Tools LE, 
choose New Session from the File menu
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Choose a directory where 
to save your new Session 
and type in a name for it

File Type - WAV is a 
good choice here for 
Windows

For I/O Settings, Stereo 
Mix is best

Choose the Sample 
Rate* and Bit Depth 
44.1 kHz and 24 Bit 
are good choices unless 
you have specific needs 
for your project

*Note: If you prefer to use the 48 kHz Sample Rate, then you can choose these here in the Pro Tools 
dialog, but you will need to also go back to the Mac Audio-MIDI Setup dialog (or to your POD X3 or 
PODxt S/PDIF settings) and set the sample rate value for your Line 6 hardware to match. Matching sample 
rates are required on both hardware units with a digital connection.

Create and Configure a New Audio Track
Next you’ll need to create at least one new audio track in the session to record into. You can of course 
also create more audio tracks if you want to import existing audio files into this session...

In the Track menu, select New...

Choose how many
Tracks to create 

Choose Mono or Stereo* for 
your audio track format

Choose Audio Track for 
the Track type

Choose Samples 

...Then click Create 
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*You’ll need to decide before creating your recording track here if you want to record the output from 
your Line 6 hardware/GearBox as Mono or Stereo.  Mono will of course only record one of your Line 
6 device’s (Left or Right) outputs, and you’ll choose which once the track is created. If you have stereo 
effects active on your GearBox or POD tone, then you’ll probably want to choose Stereo to record 
both channels into a stereo track. 

On the new audio track, click on the Input Selector and 
choose the Mbox Interface input source. Since we cre-
ated a Stereo track here, we’ll select the S/PDIF In L-R 
(Stereo)

At the top left of the Edit Window, click the 
View selector and enable the I/O View

Or… if you create a mono audio track, you’ll 
have the option for the track input to choose 
either S/PDIF L (Mono) to capture the LEFT 
signal, or S/PDIF R (Mono) to capture the 
RIGHT signal

Click the R button for to Arm the 
track for recording 

Once armed, the track’s meters 
will measure the Line 6 device/
GearBox S/PDIF signal level 

Keep the track’s Mute button 
set to un-muted to monitor your 
TonePort/GearBox signal*

*When receiving a S/PDIF input, the Mbox 2 will only allow the signal to be monitored through the Pro 
Tools LE software. With the audio track armed and not muted, the track’s volume control will adjust 
the monitor signal coming from your Hardware/Gearbox, allowing you to balance your listening levels 
independently of your recording level. The Pro Tools LE software monitoring is also subject to latency, 
which is affected by your Pro Tools LE Hardware Buffer settings (see your Mbox documentation for more 
information regarding latency and monitoring).

Note to Digi 002 users… when using the Digi 002 hardware with Pro Tools LE, an additional Low 
Latency Monitoring option is available in the Pro Tools LE Operations menu. It is best to activate this 
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option to hear your input monitoring signal with the lowest latency when recording (see your Digi 
002/Pro Tools LE documentation for more about this feature).

Adjusting the Pro Tools LE Hardware Buffers

Go to the Pro Tools LE Setup menu 
and choose Playback Engine... 

The lower the H/W Buffer Size value that is selected, the lower the 
latency. However, lower values can also result in less stability for session 
playback and recording. 256 Samples is a good starting value to try.

TIP: Alternative Mbox monitoring option… If monitoring your Line 6 Hardware recording signal through 
the Pro Tools LE software results in excessive latency, you can alternatively connect you device’s Analog 
Outs to an external Mixing Console and manually mix the device signal with the output of your Mbox. This 
allows you to hear the Line 6 device signal with no added latency from Pro Tools LE. In this configuration, 
you should Mute your Pro Tools LE track while recording to silence its software monitoring signal.

Start Recording…

Click the transport Record 
button to place Pro Tools 
LE into record mode, then 
press the Play button to 
start recording! 
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GearBox RTAS Plug-In

The GearBox Plug-In is really a great tool for Pro Tools and Pro Tools LE users! Like any RTAS Plug-
In, it can be added on any track insert, allowing you to non-destructively apply entire GearBox Tones 
on any of your Pro Tools sessions. The GearBox Plug-In is available as an Add-On purchase to your 
Line 6 hardware (or, already comes included if you own a TonePort D.I. or UX8), and works with Mac 
or Windows. You can grab it now without even getting out of your chair! Just run Line 6 Monkey with 
your Line 6 USB device connected and go to the Optional Add-Ons tab. Or, you can read all about 
it here:

Line 6 GearBox Plug-In

We’ve included a complete setup section on using the RTAS GearBox Plug-In with Pro Tools LE 7 
within the GearBox Plug-In chapter. 

http://www.line6.com/gearbox_plugin/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=AddOns+GearBoxPlugIn+DropDown
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iMage line softWare fl studio® 7 setup 
For this document, we’ll show how to configure Image Line Software FL Studio® version 7 to work 
with Line 6 TonePort, GuitarPort, POD X3 or PODxt as the USB audio device.  

 Note that the features of Line 6 hardware models differ slightly, so we’ll call out where specific instructions 
apply per device type. If you are using a POD X3 device, it is not yet supported as of GearBox version 3.5 
- please check the Line 6 GearBox Online Help site for the latest news and developments.

Configure Your Windows® PC to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Windows Control Panel and select the 
Line 6 Audio-MIDI Devices to access the Audio Driver settings. 

Go to the Driver tab

Set the ASIO Buffer Size to 
512 as a good starting point 
- or, you can try a lower value 
if your PC is snappy enough.

Set the Bit Depth to 24 bit

Please reference the Windows Driver Settings section of the Audio Driver and GearBox Settings 
chapter for details on Driver settings for your specific Line 6 hardware. 

Configure FL Studio 7 to Use the Line 6 ASIO Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps...

Launch the FL Studio Audio Settings dialog:

Go to the Options menu and 
choose Audio settings

http://line6.com/support/knowledgebase/toneporthelp/
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Choose ASIO driver that includes the 
name of your specific Line 6 device

Set a Sample Rate – 44,100 is a good 
choice here, or you can use 48,000, 
88,200 or 96,000 Hz if your Project 
requires a higher sample rate

Since we’re using the ASIO driver, any 
Buffer Size adjustment is is made in the 
Line 6 Audio-MIDI Devices dialog 
- click the Hardware Setup button to 
launch it*

Close the dialog when done

*For more about ASIO Buffer settings, please reference the Windows Driver Settings section of the 
Audio Driver and GearBox Settings chapter.

FL Studio Mixer Options...

Most settings for recording are made in the Mixer.

Select the Mixer from 
the View menu In the Mixer panel, click the Options 

button and make sure 32Bit float recording 
is  enabled
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In FL Studio, you can record into any “Insert”, and you can choose your Input independently for each 
Insert...

First, select an Insert to record into, we’ll use Insert 1
Choose the input for the selected Insert 
here. You’ll see all available Sends from 
your Line 6 device. You can choose to 
record from a Stereo or Mono Send*

Set the Out for your selected Insert here. 
You likely want this Insert (as well as the 
Master channel and all other Inserts you 
use for this project) set to Output 1 - 
Output 2

*About Inputs and Outputs...

Note that you’ll see a different number of Sends and Outputs listed in the In and Out menus depending 
on the specific Line 6 device you are using. 

Sends

TonePort & GuitarPort device (except TonePort UX8): You will see 2 Stereo and 4 Mono Sends, 
as pictured above.

TonePort UX8: You’ll see 6 Stereo and 12 Mono Sends.

 TonePort UX8’s driver offers multiple Inputs jacks and Sends with many flexible options for routing and 
monitoring GearBox Tones. Please reference the Windows Driver Settings section of the Audio Driver 
and GearBox Settings chapter for more details

POD X3 devices: You’ll see 4 Stereo and 8 Mono Sends.

 
POD X3 offers several onboard options for the type of signal that is assigned to each Send. Look in the 
Line 6 Audio-MIDI Settings dialog’s Inputs screen to see the current POD X3 Send descriptions.  For 
more info about POD X3 Sends,  please reference the Windows Driver Settings section of the Audio 
Driver and GearBox Settings chapter, and your POD X3 Pilot’s Handbook.

PODxt devices: You’ll see 1 Stereo and 2 Mono Sends.
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Outputs:

For all Line 6 devices (except TonePort UX8), the ASIO driver offers only Output 1/2, therefore the 
dialog will show its 1 stereo Output 1 - Output 2.

TonePort UX8: You’ll see 4 stereo outputs. For most FL Studio projects, you likely only need to 
use the Output 1 - Output 2 for Inserts and all other modules’ outputs so that all playback gets 
routed to one common destination. UX8 does offer some very flexible monitoring and signal routing 
options using its additional outputs - please see the Windows Driver Settings section, as well as your 
TonePort UX8 Pilot’s Handbook for more information.

Set Your Recording Level & Monitoring Options...

With Insert 1 still selected, now you 
can start strumming your instrument to 
check your recording level - you’ll see 
the input level measured on the Insert 
meters

Click to turn off the little light here to 
Mute the Insert during recording. Toggle 
it back on for playback

Note that the Insert Volume slider and 
Pan knob actually affect the recorded 
signal. Best to keep the Volume close to 
100% and then use your GearBox/POD 
level controls to adjust your record level 
(see next step)

While Insert 1 is selected, click 
to disable the Send from Insert 1 
control (so that the knob gets hidden, 
as shown here). This eliminates the 
Insert 1 input signal from being routed 
through the software*

*When recording using GearBox, it is recommended to use its ToneDirect Monitoring™ feature, 
where your input monitoring signal is passed directly back out of your Line 6 hardware’s output. This 
allows you to hear the GearBox tone you have selected for your Mic or Instrument with the lowest 
possible latency. Likewise with POD X3 and PODxt, these devices offer a super low latency USB audio 
monitoring. Therefore, we will disable FL Studio’s Send from Insert option so that the input monitor 
signal is not additionally fed through the software, which would result in two monitor signals being 
heard, often causing an “echo” or potential feedback loop.

If you are using GearBox with your Line 6 
hardware, you can adjust your recording level in 
using the assigned Send’s Record knob within the 
GearBox window. Note that your Amp and Tone 
Volume knobs in GearBox and on POD devices 
will also affect the recording level into Live

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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Get Armed & Ready...

Click the little Disk 
button at the bottom 
of Insert 1 to “Arm” 
it for recording.  This 
will launch a dialog 
where you must name 
and Save a WAV file 
to record into 

Click Save when 
done and you should 
now see the Disk 
button lit, indicating 
it is Armed.

Note you do not 
want any other 
Inserts Armed, or 
they will be recorded 
into as well!

Start Recording!

Use the Tempo button to edit the project’s tempo if needed. 
Then press the transport Recording Mode button to “ON”

Now press the Play button and start riffing!
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propellerhead reason® 4 setup
Propellerhead Software’s Reason® is an amazing virtual studio filled with synthesizers, drums and 
effects, all combined with a MIDI sequencer for easy pattern-based music creation. Reason does not 
offer a feature for recording audio; therefore, GearBox and Line 6 USB audio devices cannot be used 
for input directly into Reason. However, you do of course need a sound card device for playback, and 
your TonePort, GuitarPort, POD X3 or PODxt is a perfect high quality audio interface for this task! 

When using your Line 6 device, you can also simultaneously plug in your instruments and jam along 
with the playback of your Reason project. Or, utilize Reason’s ReWire® technology to combine a 
Reason project with that of another ReWire-capable audio software host, and use your Line 6 device 
in this setup for playback and recording with the host software!  For this document, we’ll be showing 
how to set up a Line 6 USB audio device with Propellerhead Reason ver. 4.0 - setup is similar with 
other Reason versions. 

 Note that the features of Line 6 hardware models differ slightly, so we’ll call out where specific instructions 
apply per device type. If you are using a POD X3 device, it is not yet supported as of GearBox version 3.5 
- please check the Line 6 GearBox Online Help site for the latest news and developments.

Configure Your Windows® PC to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Windows Control Panel and select the 
Line 6 Audio-MIDI Devices to access the Audio Driver settings. Please reference the Windows Driver 
Settings section of the Audio Driver and GearBox Settings chapter for details on Driver settings for 
your specific Line 6 hardware. 

Configuring Reason to Use the Line 6 ASIO Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps...

Launch the Reason’s Preferences dialog:

Select Preferences from the Reason menu

http://line6.com/support/knowledgebase/toneporthelp/
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Select the Audio page

For Audio Output, choose the 
“ASIO” driver for your Line 6 device

Choose a Sample Rate – 44100 is a 
good choice for most projects, or you 
can choose 4800, 88200, or 96000 
if your project requires one of these 
specific sample rates

Since we’re using the ASIO driver, 
the Buffer Size is adjusted in the Line 
6 Audio-MIDI Devices dialog - click 
the Control Panel button to launch 
it*

Close the Preferences dialog when 
done 

Now just hit the Play button in Reason’s transport and to hear the 
Reason playback through your Line 6 hardware!

*For more about ASIO Buffer settings, please reference the Windows Driver Settings section of the 
Audio Driver and GearBox Settings chapter.

To Jam Along with Reason…

You can also of course still use GearBox or configure your POD X3 for your Mic and Instrument tones 
while Reason is playing back if you want to sing or jam along. Just plug in your Mic or Instrument and 
use GearBox or your POD just as you normally do. Note that you can adjust the level of your Mic or 
Instrument independently of the level of the Reason playback.

If you are using GearBox, you can adjust the Monitor Volume and Out to Hardware controls 
within GearBox to balance out your Mic/Instrument volume versus the Reason playback:

The Monitor Volume, Pan and Mute controls act 
only upon your Mic/Instrument tone signal

The Out to Hardware Volume and Mute controls act on the combined 
Mic/Instrument + Reason output sent to your speakers or headphones
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Use the Master slider in the Reason Mixer to control 
Reason’s playback volume

If you are using POD X3, then you can adjust Tone Volume and Master Volume on the POD X3 
unit to balance out your Mic/Instrument volume versus the Reason playback:

The Tone Volume knob affects only your Mic/
Instrument Tone  level

The Master Volume knob controls the combined 
Mic/Instrument + Reason output sent to your speakers 
or headphones

With this configuration, both the Reason project playback and your Mic/Instrument GearBox/POD 
tones are heard through your speakers, and sent to all your device’s outputs. This also allows you to 
connect the Line 6 hardware’s outputs to an external device, such as a tape recorder, mixer, P.A. 
system, etc., to record or amplify this stereo output signal!

Using your Line 6 Hardware with Reason 3 in a ReWire Setup

The Propellerhead ReWire® technology allows the Reason modules’ outputs to be directly routed 
into any ReWire “Host” application. Using ReWire, the Host application can send MIDI tracks to 
Reason’s synth. modules, and Reason then sends audio playback directly into the ReWire Host, which 
is mixed with the audio of the Host application. When Reason is configured as a ReWire “Slave” in 
this manner, it is controlled by the Host application and does not utilize a sound card connection itself. 
Therefore, if you want to use your Line 6 hardware as your sound card device in a ReWire setup like 
this, it is necessary for you to choose your device as the assigned audio device within the ReWire Host 
application. To read more about the ReWire technology and the latest about ReWire Host support, 
please visit the Propellerheads web site. 

Using Reason with Ableton Live as a ReWire Host

The Ableton Live audio software is capable of functioning as a ReWire Host application. The following 
steps show you how to set TonePort as the audio device for the Ableton Live 7 software, and then 
configure Live to connect with Reason 4 as a ReWire Slave device. This enables you to do audio 
recording and playback with Ableton Live, allowing Reason’s output(s) to be automatically played 
in sync and channeled through Live’s audio tracks via ReWire. The setup process is similar in other 
ReWire Host applications as well (Steinberg Cubase®, Cakewalk SONAR®, etc.) and you can certainly 

http://www.propellerheads.se/
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use your Line 6 hardware with these other ReWire Host applications with Reason as well!

 Some Line 6 TonePort packages come with a special Ableton Live Lite, Line 6 version software included. 
This Live version also supports Propellerheads ReWire technology! Configuring the Live Lite Line 6 
version is much the same as the following steps for the Ableton Live 7 version.

You first want to be sure to exit Reason if it is currently running. The ReWire Host application must 
always be launched first. Launch Ableton Live and make the following settings to set your Line 6 
hardware as the Live audio device…

Launch the Ableton Live Preferences dialog:

Go to the Live Options 
menu and choose 
Preferences

Just as with most Multitrack recording software, in Live 
you also need to configure the individual inputs and 
outputs once a Multi-in/out device is selected. Click on 
the Input Config button to access the Inputs.

Go to the Audio tab

Choose ASIO as the driver type…

Then choose your Line 6 device for the 
Audio Device. In this example, we’ll 
choose our connected TonePort UX2

Since we’re using the ASIO driver, the 
Buffer Size is actually adjusted in the 
Line 6 Audio-MIDI Settings dialog 
- click the Hardware Setup button to 
launch it*

Set a Sample Rate – 44, 100 is a good 
choice here, or you can use 48,000, 
88,200 or 96,000 Hz if your Project 
requires a higher sample rate

*For more about ASIO Buffer settings, please reference the Windows Driver Settings section of the 
Audio Driver and GearBox Settings chapter.
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Activate Inputs:

Here you can “activate” all the inputs from your 
Line 6 hardware that you want to be accessible 
for any audio track as a track input for recording

Click OK when done

You’ll want at least the 1 (mono) & 2 (mono) and the 1/2 (stereo) inputs activated. Each additional 
activated input utilizes more CPU, so only activate the ones you need!

Note that you’ll see a different number of inputs listed in the Input Config dialog depending on 
the specific Line 6 device you are using. Typically these enumerated inputs correspond to the Line 6 
device’s Sends of the same number (i.e. - Live’s input “3/4 (stereo)” is the TonePort UX2/GearBox 
Send 3-4).  

Activate Outputs:

To access the outputs, click the Output Config button back in the Live Preferences > Audio tab. This 
will show you all outputs available for your selected Line 6 Output Device. 

For all Line 6 devices (except TonePort UX8), the ASIO driver offers only Output 1/2, therefore the 
dialog will show its two mono and 1 stereo output options, and they will automatically be selected. 

TonePort UX8: You’ll see 8 mono and 4 stereo outputs. For most Live projects, you likely only need 
to enable the Output 1/2 mono and stereo options and assign all track playback to one common 
output. UX8 does offer some very flexible monitoring and signal routing options using its additional 
outputs - please see the Windows Driver Settings section, as well as your TonePort UX8 Pilot’s 
Handbook for more information.

Note - The Ableton Live Lite 5, Line 6 version has a restriction that allows only one stereo output to be 
used at a time. To be able to choose two or more different output devices in a Live Set, you must switch 
into Demo mode, or upgrade to a full version of Ableton Live

http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
http://www.line6.com/support/manuals/index.html?utm_source=Line6Index&amp;utm_medium=Navigation&amp;utm_campaign=ProductManuals+DropDown
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Now that Ableton Live is configured to use your Line 6 device, launch Reason. Reason will automatically 
set itself to ReWire Slave Mode. You can check this mode in the Reason Preferences: 

Select the Audio settings

When Reason is in ReWire mode, the Audio 
Output will be non-selectable and this message 
appears 

Now in Ableton Live, you can simply access the Output menu of any MIDI track to route its MIDI to 
any of the Reason synth modules.

In any of Live’s MIDI tracks, choose 
Reason as the MIDI To output...

Then click on the Output Channel 
selector to choose any Reason module
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To receive the audio output from Reason, set the Input of any of Live’s audio tracks to receive the 
audio from any of Reason’s outputs.

In one of Live’s Audio tracks, choose 
Reason as the Audio From input...

Then click on the Input Channel 
selector to choose any Reason output

(Note that the 1/2 Mix L, Mix R 
channel receives the full Reason project 
audio mix)

Now just hit the Play button in either Live or Reason, 
and both projects will play in sync, with all the audio 
being routed into Ableton Live and played through 
your Line 6 hardware!

You can utilize your Line 6 device/GearBox to also plug in a Mic or Instrument, dial in your tone, and 
record audio tracks right into the Ableton Live Set. This ReWire configuration is especially slick since 
the Reason audio can be treated as part of your Live Set - you can mix, add effects plug-ins (such as the 
GearBox Plug-In) on the incoming Reason audio track, and all will be incorporated into your audio 
mix-down when you do an Export from Live! It is important to note, however, that running all these 
programs at one time can require some hefty usage of your computers processor, RAM and disk access, 
especially as you add more tracks, Reason modules and real-time effects. Your actual performance will 
depend on the specifications of your computer.
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sonoMa Wire Works riffWorks® 2, line 
6 edition setup

For this document, we’ll show how to configure Sonoma Wire Works, RiffWorks® version 2.1 to work 
with Line 6 TonePort, GuitarPort, or PODxt. The steps are very similar for the setup of other earlier 
RiffWorks versions as well. The RiffWorks, Line 6 Edition is available as an Add-On that you can 
purchase from the Line 6 Online Store - just a click away! For RiffWorks full retail version and info, 
please visit the Sonoma Wire Works site.

 
Note that Line 6 TonePort UX8 and POD X3 family devices do not support the RiffWorks Line 6 Edition 
software. Please check the Line 6 GearBox Online Help site for the latest news and developments.

Configuring Your Windows® PC to Use Your Line 6 Hardware

If you have not already done so, the first step is to go to the Windows Control Panel and select the 
Line 6 Audio-MIDI Devices to access the Audio Driver settings. 

Go to the Driver tab

Set the ASIO Buffer Size to 
512 as a good starting point 
- or, you can try a lower value 
if your PC is snappy enough.

Set the Bit Depth to 24 bit

Please reference the Windows Driver Settings section of the Audio Driver and GearBox Settings 
chapter for details on Driver settings for your specific Line 6 hardware. 

Configuring RiffWorks to Use the Line 6 ASIO Driver

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port, and then 
proceed with the following steps...

Launch the RiffWorks Audio Setup Dialog:

In the bottom right area of the  RiffWorks 
main screen, select the Audio Setup button

http://www.line6.com/store/storefront.html?categoryID=1
http://www.sonomawireworks.com/
http://line6.com/support/knowledgebase/toneporthelp/
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Select your Line 6 device as the ASIO 
Device, if not automatically selected for you 
already

Set the Output Channel to Output 
1+Output 2 (the stereo Output 1-2 of your 
Line 6 hardware)

The ASIO Device Latency fields provide 
info to you on the latency  amounts, which 
are directly affected by your ASIO Buffer 
Size. You can adjust the ASIO Buffer Size 
in the Line 6 Audio-MIDI Devices dialog 
- press this button to launch it*

Press OK when settings are complete

*For more about ASIO Buffer settings, please reference the Windows Driver Settings section of the 
Audio Driver and GearBox Settings chapter.

Inputs Options for Recording

You can choose to record from any of your Line 6 Devices mono or stereo Sends into RiffWorks. A 
mono Send will record a mono audio file, and a stereo Send will record a stereo file. These selections 
are made in the Input section of the RiffWorks main screen, at the bottom left. First toggle the “Stereo” 
button to switch between mono/stereo, and then click the menu beneath to select from the desired 
Line 6 device Send.

Click the Stereo button - when the light is on, this indicates 
Stereo input mode, when off, the input mode is Mono

You’ll then be offered Stereo or Mono Send options in the menu 

Hardware Monitoring Options...

When recording using GearBox, it is recommended to use its ToneDirect Monitoring™ feature, where 
your input monitoring signal is passed directly back out of your Line 6 hardware’s output. This allows 
you to hear the GearBox tone you have selected for your Mic or Instrument with the lowest possible 
latency. In order to fully utilize ToneDirect Monitoring, you must turn on the RiffWorks Hardware 
Monitoring as shown below so that the input signal is not fed through the software. Keep in mind 
that you won’t hear any of RiffWorks’ plug-in effects if you monitor the input thru your Line 6 device. 
Please refer to your RiffWorks documentation for more info on its internal effects.
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Click the Hardware Monitor button to 
“On” (the light is illuminated when on)

You see the following alert after enabling the Hardware Monitoring 
- read it’s message and click OK to accept the setting

Prepare Your RiffWorks Session...

Open a new RiffWorks Session, and follow these steps...

Enter a name for your riff here (Intro, 
Verse, Chorus, etc…)

Choose the Tempo

Choose the Length (in bars) of your riff

Choose the Time Signature of your riff

Choose whether your want the Lead In 
count to be the metronome, a drummer, or 
nothing at all

Before you click that record button, it’s a good idea to check your recording levels.

Go ahead and strum a few chords and you’ll see the meters 
measure your input recording level coming into the selected 
Inputs here in the RifWorks Input section at the bottom left 
of the main window

If you are using GearBox with your Line 6 
hardware, you can adjust your recording level in 
using the assigned Send’s Record knob within the 
GearBox window. Note that your Amp and Tone 
Volume knobs in GearBox and on POD devices 
will also affect the recording level into RiffWorks
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Start Recording Your Riffs

Once your record level is set, click on the RiffWorks transport Record button 
and lay down your first Riff!

The Riff you just recorded will appear in the Riff recorder window as “Take 001”. You 
can record several takes of the same riff, which will appear underneath this one

When ready to record another section of 
your song, click Create in the Riffs panel 

The newly created Riff will appear as riff2 in the Riff 
window. You can now record this Riff as described above 

Once you’ve laid down all your Riffs, it’s time to piece them all together in the Song panel…

Drag each Riff into the Song panel above in any order to build a song

And you’ve got a new song - it should look something like this...

RiffWorks 2, Line 6 Edition lets you import, export and manipulate your Riffs all kinds of ways. For 
more information, please refer to your RiffWorks Help documentation.
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steinberg cubase®/cubase® studio 4 
setup

For this document, we’ll show how to configure Steinberg Cubase® 4.1 to work with Line 6 TonePort, 
GuitarPort, POD X3 or PODxt as the USB audio device on a Windows® XP® (32-bit) system.  The 
steps are very similar for the setup of Steinberg Cubase® Studio 4 & Nuendo® 4, as well as previous 
Cubase® SE/SX/SL 3 and Nuendo® 3 versions. (Steinberg’s Cubase® & Nuendo® 64-bit versions are 
not currently supported by Line 6 audio device drivers or GearBox).

 Note that the features of Line 6 hardware models differ slightly, so we’ll call out where specific instructions 
apply per device type. If you are using a POD X3 device, it is not yet supported as of GearBox version 3.5 
- please check the Line 6 GearBox Online Help site for the latest news and developments.

Configure Your Windows® PC to Use Your Line 6 Hardware

Be sure to connect the USB cable from your Line 6 device into your computer’s USB port. If you have 
not already done so, the first step is to go to the Windows® Control Panel and select Line 6 Audio-
MIDI Devices to configure the ASIO driver settings for your Line 6 device. 

Go to the Driver tab

Set the ASIO Buffer Size to 
512 as a good starting point 
- or, you can try a lower value 
if your PC is snappy enough.

Set the Bit Depth to 24 bit

For more information, please reference the Windows Driver Settings section of the Audio Driver and 
GearBox Settings chapter for details on Driver settings for your specific Line 6 hardware. 

Configuring Cubase to Use the Line 6 ASIO Driver

Launch Cubase and Open the Device Setup Dialog:

Go to the Cubase Devices menu 
and choose Device Setup

http://line6.com/support/knowledgebase/toneporthelp/
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First, we need to switch to the ASIO driver mode:

Click on VST Audio System 

Select the ASIO  
driver for your Line 6 
device 

Note you do NOT 
want the “ASIO 
Multimedia” driver, 
but the one with 
“ASIO” + the name of 
your device!*

Select Switch if you are 
prompted to “switch the ASIO 
driver…”

Then click OK to exit the 
Cubase Device Setup dialog

*It is possible to use the “ASIO Multimedia” driver mode, but using the Line 6 ASIO driver option is 
recommended since it offers the best performance and multiple input/output channels. For more about 
ASIO Buffer settings, please reference the Windows Driver Settings section of the Audio Driver and 
GearBox Settings chapter.

Establish Your Inputs and Outputs:
Next we need to configure the Inputs and Outputs from the Line 6 hardware so they can be accessed 
within your Cubase Projects. This can get a bit fiddly in Cubase, but you only need to do this once for 
your audio device, so hang in there!

Return the Cubase Devices menu 
and select VST Connections
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Go to the Inputs tab...

Initially, you’ll see that one Stereo In “Bus” has already been created for you. You should see your Line 
6 device listed, and its Send 1 and 2 audio channels each assigned as the Left and Right channels for 
this initial Bus. TonePort and POD X3 devices offer more than just the one stereo Send 1-2, however, 
so for these devices you’ll want to create an additional stereo Bus for each Send. Also, you’ll want to 
create mono Buses for all the individual Send audio channels to allow you to record from any one 
of them as a mono input to a Cubase audio track. In our example we’re using a TonePort UX2, and 
just like TonePort GX, D.I., UX1, KB37, and GuitarPort devices, there is also a Send 3-4 available. 
TonePort UX8 offers 6 stereo Sends, and POD X3* offers 4 stereo Sends. 

 
*POD X3 offers several onboard options for the type of signal that is assigned to each Send. Look in the 
Line 6 Audio-MIDI Settings dialog’s Inputs screen to see the current POD X3 Send descriptions.  For 
more info about POD X3 Sends,  please reference the Windows Driver Settings section of the Audio 
Driver and GearBox Settings chapter, and your POD X3 Pilot’s Handbook.

You can follow these steps to add additional buses for all your device’s Sends...

Add Buses

Press the Add Bus button, create 1 Stereo Bus, then repeat and add 4 Mono 
Buses using the Add Input Bus dialog...  

Next, each Bus channel needs to be correctly assigned to the desired hardware Send. The Stereo In 2 
Bus likely already became correctly assigned to the Line 6 device’s next stereo Send (Send 3-4 for our 
TonePort). But the Mono In Buses all defaulted to “Send 1”, which is not what we want. Click directly 
on the Device Port field for each of the Mono Buses and select a different Send channel for each. For 
our TonePort UX8, we’ll assign one each to Send 1, 2, 3, & 4.
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Click on the Device Port 
to choose the desired 
Line 6 device Send 
channel assignment - do 
this for each Mono Bus

The result should now look like this, 
with each Stereo In and Mono In 
Bus assigned to its own specific Line 6 
hardware Send.  

(Make a mistake? No worries, you can 
right click on any Bus Name and “Re-
move” it and add another if needed).

Now to the Outputs tab... the procedure is the same here. You should see a Stereo Out Bus already 
created here for you and correctly assigned to your Line 6 device’s main Output 1 & 2 for its Left and 
Right channels. 

This one Bus is fine as is for most Cubase Projects, since you’ll likely just assign all audio tracks to this 
one, common stereo output. But you can optionally create Mono Buses for each of these Outputs if you 
need them. Or, if you have a TonePort UX8, your device includes 8 outputs which means you can do 
the Add Bus thing here and create Stereo and Mono Buses utilizing all the additional Outputs if you 
like - even for a 5.1 Surround system if needed! 

 TonePort UX8’s driver offers multiple Inputs and Sends with many flexible options for routing and 
monitoring GearBox Tones. Please reference the Windows Driver Settings section of the Audio Driver 
and GearBox Settings chapter for more details
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Create a Preset...
Finally, it’s a good idea to now save all these settings as a Preset. You can even create several different 
Bus scenarios for your Line 6 hardware and save each as a different Preset to recall them easily any 
time!

Click the little Add button 

Then type in a name for your Preset 
and click OK to finish it up

You can now exit the VST Connec-
tions dialog

 

TIP! Be sure to open the VST Connections window and select this Preset before you open or create a 
Cubase Project so that it will use these settings! It’s also pretty handy to create a Project Template with a 
Cubase Project so that you don’t need to go through the repetitive task of creating a bunch of tracks and 
assigning them to the same Ins & Outs every time you start a new Project. See the Cubase documentation 
regarding creating a Project Template.

Open or Create a New Cubase Project...
Go to File > New Project to start a new Cubase Project. Once your Project is open, look at the bottom 
left of the Cubase screen to check its Sample Rate & Bit Depth. If these are not what you want, then 
you can go to the Project > Project Setup dialog. (Note that it is best to set the Sample Rate and Bit 
Depth first in the Line 6 Audio-MIDI Devices, as shown in the first step of this chapter - you did 
follow that step, right?)

Look at the Cubase Project’s Sample Rate 
& Bit Depth at the bottom left of the main 
Cubase window 

44,100 Hz is a good choice for your 
Sample Rate, or you can choose 48,000, 
88,200 or 96,000 Hz if your project 
specifically requires one of these higher 
rates.

Choose 32 Bit as your Record Format -it is 
best if you match this 32 Bit format as the 
Bit Depth setting for your device in the 
Line 6 Audio-MIDI Devices dialog (see 
the Windows Driver Settings section)
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Configuring an Audio Track for Recording 

Now that your Line 6 hardware and Cubase Buses are set up, you are ready to start working in your 
Cubase Project!  

Add a New Audio Track...

This launches the Add Audio Track dialog, 
where you can choose the type of track, and 
how many to add. We’ll add one Stereo track 
for our example

In the Cubase Project menu, select to 
add an Audio track...

Select Your Audio Track’s Input and Output

You’ll see all the Input Buses here that you 
created in the VST Connections - Input dialog. 
You can choose either a stereo or mono input*

Click on the Audio track’s Input 
Routing selector to choose the recording 
input

The Audio tracks’ Output Routing 
should default to your Line 6 device’s 
Output 1
(Or, if you created additional Output 
Buses in the VST Connections dialog, 
you can choose the preferred one here)

*Note that for a stereo audio track, choosing a Stereo Input Bus will record a stereo file. Choosing a 
Mono Input Bus will record a mono file. If you create a mono audio track, then you can only choose 
a Mono Input Bus (or only one channel of your Stereo Bus) as the track input, and this will record a 
mono file. 

Set Input Monitoring Options...
When recording using GearBox, it is recommended to use its ToneDirect Monitoring™ feature, 
where your input monitoring signal is passed directly back out of your Line 6 hardware’s output. This 
allows you to hear the GearBox tone you have selected for your Mic or Instrument with the lowest 
possible latency. Likewise with POD X3 and PODxt, these devices offer a super low latency USB audio 
monitoring. Therefore, we will disable the Cubase “Monitor” option on our Audio track so that the 
input monitor signal is not additionally fed through the software*.
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Keep the audio track’s Monitor button set to OFF
(You can access this and most other track controls on both the Track Header 
or to the left in the “Inspector”)

 * Optionally, if you are using the GearBox Plug-In, you can load the Plug-In on your  audio track and turn 
the Cubase Monitor button ”ON” to monitor your input signal through the software, and thus through 
the GearBox Plug-in processing. Please see the Cubase Help documentation for Global and Track Input 
Monitoring options. See the Using the GearBox Plug-In chapter for a detailed guide on configuring the 
Gearbox Plug-In!

Arm Your Track & Set Your Levels...

Click the Record Enable button “ON” 
to arm the audio track for recording*

*Note that the track meters in Cubase will not measure the input signal unless the Input Monitoring 
feature is on (which of course we just turned OFF in the last step). You can display the Cubase Mixer and 
the level meters there are active for inputs with the Monitor function on or off. 



Steinberg Cubase 4 Setup - Windows

5•64

If desired, launch the Mixer and you can view the 
meters for the respective Audio track to gauge your 
input levels before you start recording

If you are using GearBox with your Line 6 
hardware, you can adjust your recording level in 
using the assigned Send’s Record knob within the 
GearBox window. Note that your Amp and Tone 
Volume knobs in GearBox and on POD devices 
will also affect the recording level into Cubase

Start Recording!

Once your record level is set, click on the transport Record button and start riffing!
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